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Architecture Overview

Introduction

This architecture overview introduces the basic architecture of the TMS320C28x (C28x) series of
Digital Signal Processors from Texas Instruments. The C28x series adds a new level of general
purpose processing ability unseen in any previous DSP chips. The C28x is ideal for applications
combining DSP, standard microcontroller processing, efficient C code execution, or operating
system tasks.

Learning Objectives

When this module is complete, you should have a basic understanding of the C28x architecture
and how all of its components work together to create a high-end, uniprocessor control system.

Learning Objectives

¢ lIdentify the three main components
of the C28x

¢ List the key features of the C28x
CPU

¢ lIdentify the memory capabilities of
the C28x

¢ l|dentify the peripherals available on
the C28x
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What is the TMS320C28x?

What is the TMS320C28x?

The TMS320C28x is a 32-bit fixed point DSP that specializes in high performance control
applications such as, robotics, industrial automation, mass storage devices, lighting, optical
networking, power supplies, and other control applications needing a single processor to solve a
high performance application.

C28x Block Diagram

Program Bus i 1
Event !
i Man\éger A
1 ]

r ]

Boot ! Event 1

Manager B
Sectored RIAN ROM I ! :

Elﬁz i
A(8-0) (7 i :

1
D(15-0) Elgé 1 l
32-bit R-M-W

Auxiliary Atomic
Registers ALU

Realtime Register Bus
JTAG CPU

i Data Bus

32x32 bit
Multiplier

The C28x architecture can be divided into 3 functional blocks:
e CPU and busing
e Memory

e Peripherals
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C28x CPU

C28x CPU

The C28x is a highly integrated, high performance solution for demanding control applications.
The C28x is a cross between a general microcontroller and a digital signal processor, balancing
the code density of a RISC chip and the execution speed of a DSP with the architecture,
firmware, and development tools of a microcontroller.

The DSP features include a modified Harvard architecture and circular addressing. The RISC
features are single-cycle instruction execution, register-to-register operations, and modified
Harvard architecture. The microcontroller features include ease of use through an intuitive
instruction set, byte packing and unpacking, and bit manipulation.

C28x CPU

& MCU/DSP balancing code density
& execution time.

& Supports 32-bit instructions
Program Bus for improved execution time;

& Supports 16-bit instructions
for improved code efficiency

] PIE & 32-bit fixed-point DSP
32-bit - JIR-M-WHil{ Interrupt & 32 x 32 bit fixed-point MAC
32x32 bit
- X | Atomic Manager

*

Dual 16 x 16 single-cycle fixed-
point MAC (DMAC)

32-/64-bit saturation
64/32 and 32/32 modulus division

Fast interrupt service time

Timers

Realtime

JTAG i
i

Register Bus
I CPU

* 6 o o

Single cycle read-modify-write
instructions

Data Bus

*

Unique real-time debugging
capabilities

& Upward code compatibility

The C28x design supports an efficient C engine with hardware that allows the C compiler to
generate compact code. Multiple busses and an internal register bus allow an efficient and
flexible way to operate on the data. The architecture is also supported by powerful addressing
modes, which allow the compiler as well as the assembly programmer to generate compact code
that is almost one to one corresponded to the C code.

The C28x is as efficient in DSP math tasks as it is in system control tasks that typically are
handled by microcontroller devices. This efficiency removes the need for a second processor in
many systems.

The C28x is one of several members of the fixed-point generations of digital signal processors
(DSPs) in the TMS320 family. The C28x is source-code and object-code compatible with the
C27x. In addition, the C28x is source code compatible with the 24x/240x DSP and previously
written code can be reassembled to run on a C28x device. This allows for migration of existing
code onto the C28x.
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C28x CPU

Multiplier, ALU, and Shifters

Program Bus
Data Bus

C28x Multiplier and ALU / Shifters

32

{

16

Shift RIL (0-16) | |

XT (32) or T/TL '-T 16/32

MULTIPLIER
32 x 32 or
Dual 16 x 16

—

32

P (32) or PH/PL

32 |

432 |

8/16

32

Shift R/L (0-16) |

B

N Aue

32

ACC (32)

AH (16)

AL (18)

AH.MSB |AH.LSB

AL.MSB | AL.LSB

32

| shift RIL (0-16) k

32

Data Bus

The 32 x 32-bit MAC capabilities of the C28x and its 64-bit processing capabilities, enable the
C28x to efficiently handle higher numerical resolution problems that would otherwise demand a
more expensive floating-point processor solution. Along with this is the capability to perform
two 16 x 16-bit multiply accumulate instructions simultaneously or Dual MACs (DMAC).

Data Bus

C28x XARn, DP and Memory

A

Program Bus

XARO

DP (16)

XAR1

6 LSB
from IR

XAR2

XAR3

32 22

XAR4

XARS5

XAR6

XAR7

MUX

XARN — 32-bits

ARN — 16-bits

Data Memory
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C28x CPU

TMS320C28x Internal Bussing

As with many DSP type devices, multiple busses are used to move data between the memories
and peripherals and the CPU. The C28x memory bus architecture contains:

e A program read bus (22 bit address line and 32 bit data line)
e A data read bus (32 bit address line and 32 bit data line)

e A data write bus (32 bit address line and 32 bit data line)

C28x Internal Bus Structure
Program Program Address Bus (22) :
L_prc |
Program-read Data Bus (32) Program
Decoder I 7 (4M* 16)
| Data-read Address Bus (32)
t | T
| Data-read Data Bus (32) Data
1 I (4G * 16)
Registers Execution Debug
AR|AUE MPY32x32 SRl Memory
ALU R-M-W Emulation
DP |@X XT Atomic & JTAG
XARO 8 ALU Test |lemmmmp| Standard
XA??? ACC Engine Peripherals
| Register Bus / Result Bus | External
1 ! Interfaces
| . Data/Program-write Data Bus (32) .
| Data-write Address Bus (32)

The 32-bit-wide data busses enable single cycle 32-bit operations. This multiple bus architecture,
known as a Harvard Bus Architecture enables the C28x to fetch an instruction, read a data value
and write a data value in a single cycle. All peripherals and memories are attached to the memory
bus and will prioritize memory accesses.
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C28x CPU

Special Instructions
C28x Atomic Read/Modify/Write

& Atomic Instructions Benefits:

\4

LOAD Simpler programming
READ

Smaller, faster code

A7

[ Registers ALU / MPY ] | Mem

> Uninterruptible (Atomic)
WRITE

STORE > > More efficient compiler

Standard Load/Store Atomic Read/Modify/Write

DINT

MOV AL, *XAR2
AND  AL,#1234h
MOV  *XARZ2,AL
EINT

6 words / 6 cycles

AND *XAR2,#1234h

2 words / 1 cycles

Atomics are small common instructions that are non-interuptable. The atomic ALU capability
supports instructions and code that manages tasks and processes. These instructions usually
execute several cycles faster than traditional coding.
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C28x CPU

Pipeline Advantage

C28x Pipeline

F1: Instruction Address

F2: Instruction Content

D1: Decode Instruction

D2: Resolve Operand Addr
R1: Operand Address

R2: Get Operand

X: CPU doing “real” work
W: store content to memory

A|FiiF DD, RIR, | X|W 8-stage pipeline

B FiiF | DiiDy| RiER, | X | W

c FiiF|DiiDy| Ry Ry | X | W

D ______ FiiF2|DiiDo| RiRy | X W E & G Access
E__ FiiFo | D[ Dy| Rii Ry | X| W]~7%" same address
L 1 F2 | D Da] R R, | X Wl

G F,1F,|Di Dl Ryl R, | X|W

H F[F DD [RiR,| X]w

Protected Pipeline

> Order of results are as written in
source code

> Programmer need not worry about
the pipeline

The C28x uses a special 8-stage protected pipeline to maximize the throughput. This protected
pipeline prevents a write to and a read from the same location from occurring out of order.

This pipelining also enables the C28x to execute at high speeds without resorting to expensive
high-speed memories. Special branch-look-ahead hardware minimizes the latency for conditional
discontinuities. Special store conditional operations further improve performance.
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Memory

Memory

The memory space on the C28x is divided into program and data space. There are several
different types of memory available that can be used as both program or data space. They include
the flash memory, single access RAM (SARAM), expanded SARAM, and Boot ROM which is
factory programmed with boot software routines or standard tables used in math related
algorithms.

Memory Map

The C28x CPU contains no memory, but can access memory both on and off the chip. The C28x
uses 32-bit data addresses and 22-bit program addresses. This allows for a total address reach of
4G words (1 word = 16 bits) in data space and 4M words in program space. Memory blocks on
all C28x designs are uniformly mapped to both program and data space.

This memory map shows the different blocks of memory available to the program and data space.

Data | Program Data | Program
0x00 0000| MO SARAM (1K)
0x00 0400| 1 SARAM (1K)
0x00 0800 BE 0 (2K) [ Teserved eserved
0x00 0D00| pE yector
256 reserved
ENPIE=1 5
0x00 1000 reserved A e D) 8)(88 4888
0x00 6000| PF 2 (4K) [ reserved XINT Zone 1 (8K) | Ox
0x00 7000| PF 1 (4K) | reserved
0x00 8000 LO SARAM (4K) reserved
0x00 9000| | 1 SARAM (4K
: Gl XINT Zone 2 (0.5M) | 0x08 0000
x00 AOOO reserved 0x10 0000
0x3D 7800 OTP (1K) XINT Zone 6 (0.5M) | OX
0x3D 7C00 reserved 0x18 0000
0x3D 8000| FLASH (128K)
L e reserved
| 128-Bit Password |
Ox3F 8000 HO SARAM (8K)
0x3F A000 reserved
0x3F F000| Boot ROM (4K) XINT Zone 7 (16K) | 0x3F C000
MP/MC=(S MP/MC=1 ESE
0x3F FFCO| BROM vector EBZ) XINT Vector-RAM (32) .
MP/MC=0 ENPIE=0 MP/MC=1 ENPIE=0 OTP, FLASH
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Memory

Code Security Module (CSM)

0x00 8000| | O SARAM (4K)
0x00 9000} | 1 SARAM (4K)
0x00 A000 reserved
0x3D 7800 OTP (1K)
0x3D 7C00 reserved
0x3D8000) FLASH (128K)
=
& 128-bit user defined password is stored in Flash
& 128-bits = 2128 = 3.4 x 103 possible passwords
¢ Totry 1 password every 2 cgcles at 150 MHz, it
would take at least 1.4 x 1023 years to try all
possible combinations!
Peripherals

Code Security Module

¢ Prevents reverse engineering and
protects valuable intellectual property

The C28x comes with many built in peripherals optimized to support control applications. These

peripherals vary depending on which C28x device you choose.

Event Manager

Analog-to-Digital Converter

Watchdog Timer
SPI

SCI

CAN

McBSP

GPIO
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Fast Interrupt Response

Fast Interrupt Response

The fast interrupt response, with automatic context save of critical registers, resulting in a device
that is capable of servicing many asynchronous events with minimal latency. C28x implements a
zero cycle penalty to do 14 registers context saved and restored during an interrupt. This feature
helps reduces the interrupt service routine overheads.

C28x Fast Interrupt Response Manager

> 96 dedicated PIE
vectors

> No software decision [
making required PIE module 28x CPU Interrupt logic

> Direct access to RAM in't::r:'l?;?ts
vectors

» Auto flags update

> Concurrent auto
context save

96

INT1 to
INT12 28x
o5~ IFR|| IER || INTM ™ CPU
12 interrupts
PIE
Register
Map

Auto Context Save
T STO
AH AL

PH PL
AR1 (L) | ARO (L)
DP ST1
DBSTAT| IER
PC(msw)| PC(lsw)

Peripheral Interrupts 12x8
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C28 Mode

C28 Mode

The C28x is one of several members of the fixed-point generations of digital signal processors
(DSPs) in the TMS320 family. The C28x is source-code and object-code compatible with the

C27x. In addition, the C28x is source code compatable with the 24x/240x DSP and previously
written code can be reassembled to run on a C28x device. This allows for migration of existing

code onto the C28x.

C28x | C24x Modes

Mode Type Mode Bits Compiler
OBJMODE AMODE Option
C24x Mode 1 1 -v28 -m20
C28x Mode 1 0 -v28 (workshop)
Test Mode (default) 0 0 -v27
Reserved 0 1

» C28x mode:

» C24x source-compatible mode:
> Allows you to run C24x source code which has been reassembled
using the C28x code generation tools (need new vectors)

> Can take advantage of all the C28x native features
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Reset

Reset

Reset — Bootloader

Reset
OBJMODE=0 AMODE=0
ENPIE=0 VMAP=1

XMPNMC=0 Bootloader sets
(microcomputer mode) OBJMODE =1
AMODE =0
Reset vector fetched -
from boot ROM Boot determined by
state of GPIO pins
0x3F FFCO

Execution

Entry Point

Note: HO SARAM

Details of the various boot options will be
discussed in the Reset and Interrupts module
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Summary

Summary

Summary

High performance 32-bit DSP

32 x 32 bit or dual 16 x 16 bit MAC
Atomic read-modify-write instructions
8-stage fully protected pipeline
Fast interrupt response manager
128Kw on-chip flash memory
Code security module (CSM)

Two event managers

12-bit ADC module

56 shared GPIO pins

Watchdog timer

Communications peripherals

L K IR IR IR B 2R R 2R 2N 2N R 2
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Programming Development Environment

Introduction

This module will explain how to use Code Composer Studio (CCS) integrated development
environment (IDE) tools to develop a program. Creating projects and setting building options
will be covered. Use and the purpose of the linker command file will be described. Additionally,
the DSP/BIOS Configuration Tool will be used to handle system memory and system setup.

Learning Objectives

Learning Objectives

¢ Use Code Composer Studio to:
+ Create a Project
+ Set Build Options

¢ Create a user linker command file which:

+ Describes a system'’s available memory

+ Indicates where sections will be placed
in memory

¢ Use DSP/BIOS Configuration Tool to:
+ Handle system memory and system setup
+ Create a .cdb and .cmd file
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Code Composer Studio

Code Composer Studio

Software Development and COFF Concepts

In an effort to standardize the software development process, T1 uses the Common Object File
Format (COFF). COFF has several features which make it a powerful software development
system. It is most useful when the development task is split between several programmers.

Each file of code, called a module, may be written independently, including the specification of
all resources necessary for the proper operation of the module. Modules can be written using
Code Composer Studio (CCS) or any text editor capable of providing a simple ASCII file output.
The expected extension of a source file is . ASM for assembly and . C for C programs.

Code Composer Studio

Build
DSP/BIOS
Config DE’; ;Br_lé)ss
Tool : :

—ezdsp™

— EVM

Probe Out -
Graphs Third
Profiling Party

¢ Code Composer Studio includes:
+ Integrated Edit/Debug GUI
+ Code Generation Tools
- DSP/BIOS

Code Composer Studio includes a built-in editor, compiler, assembler, linker, and an automatic
build process. Additionally, tools to connect file input and output, as well as built-in graph
displays for output are available. Other features can be added using the plug-ins capability

Numerous modules are joined to form a complete program by using the linker. The linker
efficiently allocates the resources available on the device to each module in the system. The
linker uses a command (. CMD) file to identify the memory resources and placement of where the
various sections within each module are to go. Outputs of the linking process includes the linked
object file (.OUT), which runs on the DSP, and can include a . MAP file which identifies where
each linked section is located.

The high level of modularity and portability resulting from this system simplifies the processes of
verification, debug and maintenance. The process of COFF development is presented in greater
detail in the following paragraphs.
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Code Composer Studio

The concept of COFF tools is to allow modular development of software independent of
hardware concerns. An individual assembly language file is written to perform a single task and
may be linked with several other tasks to achieve a more complex total system.

Writing code in modular form permits code to be developed by several people working in parallel
so the development cycle is shortened. Debugging and upgrading code is faster, since
components of the system, rather than the entire system, is being operated upon. Also, new
systems may be developed more rapidly if previously developed modules can be used in them.

Code developed independently of hardware concerns increases the benefits of modularity by
allowing the programmer to focus on the code and not waste time managing memory and moving
code as other code components grow or shrink. A linker is invoked to allocate systems hardware
to the modules desired to build a system. Changes in any or all modules, when re-linked, create a
new hardware allocation, avoiding the possibility of memory resource conflicts.

% /sdgo28x_wrtdx/CPU_1 - 28xx - Code Composer Studio

File Edit Yiew Project Debug Profiler GEL Option Tools DSP/BIOS Window Help

BEH| S BB o o R AL e =
Iexarnp\epit ﬂIDEhug jl @ I~ | CWRE. 1 | % % |

Zi 2EEEE

?"} g Files

B S . edi i

||| 3 & evemote.t ebun ¢ Integrates: edit, code generation,
i!’} D Dependent Projects

o E1_3 DSPYEIOS Config and debug

‘= example.cdb
e B Generated Files
B g ¢ Single-click access using buttons
{*} Examplecrg_c.c
-] Include
- ?a’f{f;mimllﬁb ¢ Powerful graphing/profiling tools
g: Ea Source
Adc.c . .

— CodestartBranch.asm ¢ Automated tasks using GEL scripts
Defaultlsr.c

B O .

. ¢ theriapelc ¢ Built-in access to BIOS functions
m.aln.c
== P, & Support Tl or 3 party plug-ins

SysChrl.c
F2812y.cmd
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Code Composer Studio

Projects

Code Composer works with a project paradigm. Essentially, within CCS you create a project for
each executable program you wish to create. Projects store all the information required to build
the executable. For example, it lists things like: the source files, the header files, the target
system’s memory-map, and program build options.

The CCS Project
¥# /sdgoz8x_wrtdx,/CPU_1 - 26xx - Code Con
File Edit View Project Debug Profiler GEL
a3 | Ex v K cu . . . . .
LA e s Project (.pjt) files contain:
Iexamp\e pit jl Debug
Bler | O BEREREL .
ol | | ¢ Source files (by reference)
) Files
o Eg L fs + Source (C, assembly)
- rojects
‘{2: = 5 sxamvlest (oebus) + Libraries
) | ependent Projects
w =8 By 10% corf + DSP/BIOS configuration
e Eﬁ .(-:';/e;erated F;Ifas - 1 1
B B e s20 Linker command files
2] examplecfg_r.c . .
2 o ¢ Project settings:
=2 Libraties . . H
o D ™) B eoae00_mids + Build Options (compiler and
= =] ﬁ Snu:;:;c.c assembl er)
CodkatsnEyndh e + Build configurations
ET;;aIVarlablaDer‘c * DSP/B IOS
+ Linker

The project information is stored in a .PJT file, which is created and maintained by CCS. To
create a new project, you need to select the Project:New... menu item.

Along with the main Project menu, you can also manage open projects using the right-click
popup menu. Either of these menus allows you to Add Files... to a project. Of course, you can
also drag-n-drop files onto the project from Windows Explorer.
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Code Composer Studio

Build Options

Project options direct the code generation tools (i.e. compiler, assembler, linker) to create code
according to your system’s needs. When you create a new project, CCS creates two sets of build
options — called Configurations: one called Debug, the other Release (you might think of as

Optimize).

To make it easier to choose build options, CCS provides a graphical user interface (GUI) for the
various compiler options. Here’s a sample of the Debug configuration options.

tdx/CPU_1 - 28nx - Code Comy]

Build Options GUI - Compiler

Project Debug  Profiler GEL ¢
New. .. Build Options for example.pjt 2l
Jpen. .. . = 7
Compiler
#dd Files to Praject. . General P I Linker I Lirk Qrder I
SR -g -k -q -z¢ -al -3z -fr"ChevampleiDebug” 4" Minclude” -d"_DEBUG" ﬂ
Close -d"LARGE_MODEL" -ml -+28
Use External Makefile. .. LI
Expart ko Makefile. .. Categary S
Source Control 3 Target Wersion C28u [v28] *
Advanced -
Compile Fle Feedback Generate Debug Info: | Full Symbalic Debug [-g) -
Files ; ﬁ
Build . Asserbly Opt Level Mone -
Rebuild Al Parser Program Level Opt.: INane d
Stop Build Preprocessar
Build Clean Diagnostics

Configurations. ..

GUI has 8 pages of categories for code

File Specific Gptians. .. <*
Project Dependencies. . generatlon tOO|S
Shaw Praject D denci -
Deain & Controls many aspects of the build process,

Show File Dependencies
Scan All File Dependencies
Reecent Project Files

such as:

« Optimization level

« Target device
Compiler/assembly/link options

»

-

There is a one-to-one relationship between the items in the text box and the GUI check and drop-
down box selections. Once you have mastered the various options, you can probably find

yourself just typing in the options.
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Build Options GUI - Linker

Build Options for example.pjt 2=l

Gemerall Compiler  Linker IL\nk Elrderl

-g -z -m". \Debughexample. map'’ -0". \Debughexample, ot -« ;I
-I"its2B00_ml "
-l & GUI has 2 categories
Categony: ~ Basic H H
¥ Suppress Banner [-q) fo r I I n kl n g
pdvanced [¥ Eshaustively Read Libranies [+] Y 4 H H
& Specifies various link
Output Module: I LI 0 tl 0 n S
Output Filename (-a] |.\Debug\examp\e.oul p
I ap Filename [-m) |.\Debug\examp\e.map “ n H
Autoinit Model: Run-time Autoinitialization -] = ‘ .\Debbl:lrg\ld I n dl I C atles
Heap Size [-heap)] I 0 n Su O " er eve_
Stack Size [-stack): I beIOW prOjeCt (-pjt)
FillValus (4] I location
Code Entry Paint [-2): |
Library Search Path [-i]:l
Include Libraries [-): IrlsZSDU_mI.Iib

There are many linker options but these four handle all of the basic needs.

e -0 <filename> specifies the output (executable) filename.

o -m <Filename> creates a map file. This file reports the linker’s results.
e —c tells the compiler to autoinitialize your global and static variables.

o —x tells the compiler to exhaustively read the libraries. Without this option libraries are
searched only once, and therefore backwards references may not be resolved.
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Default Build Configurations

¥ /sdgo28x_wrtdx/CPU_1 - 28xx - Code Composer Studiol

Flle Edit ‘iew Project Debug Profiler GEL Option Tools * For new prOJeC’tS’ CCS aUtomatlca“y

I e e creates two build configurations:
e « Debug (unoptimized)
+ Release (optimized)

I example. pit jl Debug

@ | 6" | ] B2 [ERekase
¢ Usethedrop-down menu to quickly
" Files I tth b Id f t
P [ GEL Files selec e pulla conriguration
[EHZ3 Projects
{'il E--@ example.pjt {Debu

Project Configurations S x| ¢ Add/Remove your own custom
L : build configurations using
onfigurations of example. pit Done Proect Conf| urat|0ns
E aﬁample o Add.. | J . g .
¢ Edit aconfiguration:
Remove |
T 1. Set it active
Set Active
Hob | 2. Modify build options
3. Save project

To help make sense of the many compiler options, Tl provides two default sets of options
(configurations) in each new project you create. The Release (optimized) configuration invokes
the optimizer with —03 and disables source-level, symbolic debugging by omitting —g (which
disables some optimizations to enable debug).
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Creating a Linker Command File

Sections

Looking at a C program, you'll notice it contains both code and different kinds of data (global,

local, etc.).

Global Vars (.ebss) Init‘vals (.cinit)

Lint  y/=i7;)

{

J,Iong Z;
o Z = X + y;"

Local vars (.stack)  Code (.text)

Sections

void main(void) .

Every C program
consists of different

parts called sections

All default sections

names begin with “.

The compiler has
default sections
names for initialized
and uninitialized
sections

In the TI code-generation tools (as with any toolset based on the COFF — Common Obiject File

Format), these various parts of a program are called Sections. Breaking the program code and

data into various sections provides flexibility since it allows you to place code sections in ROM
and variables in RAM. The preceding diagram illustrated five sections:

e Global Variables

o Initial Values for global variables
o Local Variables (i.e. the stack)

e Code (the actual instructions)
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Creating a Linker Command File

Following is a list of the sections that are created by the compiler. Along with their description,
we provide the Section Name defined by the compiler.

Compiler Section Names

Initialized Sections

Name Description Link Location
text code program

.cinit initialized global and static variables | program

.econst constant data (e.g. constint k =3;) | data

.switch tables for switch statements data (prog w/ -mt)
.pinit tables for global constructors (C++) | program

Uninitialized Sections

Name Description Link Location
.ebss global & static variables data
.stack stack space low 64K data
.esysmem | memory for far malloc functions data

Sections of a C program must be located in different memories in your target system. This is the
big advantage of creating the separate sections for code, constants, and variables. In this way,
they can all be linked (located) into their proper memory locations in your target embedded
system. Generally, they’re located as follows:

Program Code (.text)

Program code consists of the sequence of instructions used to manipulate data, initialize system
settings, etc. Program code must be defined upon system reset (power turn-on). Due to this basic
system constraint it is usually necessary to place program code into non-volatile memory, such as
FLASH or EPROM.

Constants (.cinit —initialized data)

Initialized data are those data memory locations defined at reset.It contains constants or initial
values for variables. Similar to program code, constant data is expected to be valid upon reset of
the system. It is often found in FLASH or EPROM (non-volatile memory).

Variables (.ebss — uninitialized data)

Uninitialized data memory locations can be changed and manipulated by the program code during
runtime execution. Unlike program code or constants, uninitialized data or variables must reside
in volatile memory, such as RAM. These memories can be modified and updated, supporting the
way variables are used in math formulas, high-level languages, etc. Each variable must be
declared with a directive to reserve memory to contain its value. By their nature, no value is
assigned, instead they are loaded at runtime by the program
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Placing Sections in Memory

Memory Secti
ections
0x00 0000 MOSARAM
(0x400)  f TTm==-ao s
0x00 0400 MlSARAM -
(0x400) TP
7 .stack
0x3D 8000 FLASH = f—-------""1 .cinit
(0x20000) -
T~ text

Linking code is a three step process:
1. Defining the various regions of memory (on-chip SARAM vs. FLASH vs. External Memory).
2. Describing what sections go into which memory regions

3. Running the linker with “build” or “rebuild”
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Linker Command Files (.cmd)

The linker concatenates each section from all input files, allocating memory to each section based
on its length and location as specified by the MEMORY and SECTIONS commands in the linker
command file.

Linking

e Memory description

e How to place s/w into h/w

Link.cmd

.0bj —| Linker [— .out

.map

Memory-Map Description

The MEMORY section describes the memory configuration of the target system to the linker.
The format is: Name: origin = 0x????, length = 0x????
For example, if you placed a 128K FLASH starting at memory location 0x3D8000, it would read:

MEMORY

FLASH: origin = 0x3D8000 , length = 0x020000
}

Each memory segment is defined using the above format. If you added MOSARAM and
M1SARAM, it would look like:

MEMORY
MOSARAM: origin = 0x000000 , length = 0x0400
M1SARAM: origin = 0x000400 , length = 0x0400
}
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Remember that the DSP has two memory maps: Program, and Data. Therefore, the MEMORY
description must describe each of these separately. The loader uses the following syntax to
delineate each of these:

Linker Page TI Definition

Page 0 Program

Page 1 Data

Linker Command File

MEMORY
PAGE O: /* Program Space */
FLASH: org = 0x3D8000, Ilen = 0x20000
PAGE 1: /* Data Space */
MOSARAM: org = 0x000000, 1len = 0x400
M1SARAM: org = 0x000400, 1len = 0x400

}
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Section Placement

The SECTIONS section will specify how you want the sections to be distributed through
memory. The following code is used to link the sections into the memory specified in the
previous example:

SECTIONS

{
.text:> FLASH PAGE O
.ebss:> MOSARAM PAGE 1
.cinit:> FLASH PAGE O
.stack:> M1SARAM PAGE 1

}

The linker will gather all the code sections from all the files being linked together. Similarly, it
will combine all ‘like’ sections.

Beginning with the first section listed, the linker will place it into the specified memory segment.

Linker Command File

MEMORY
PAGE O: /* Program Space */
FLASH: org = 0x3D8000, Ilen = 0x20000
PAGE 1: /* Data Space */
MOSARAM: org = 0x000000, 1len = 0x400
M1SARAM: org = 0x000400, 1len = 0x400
}
SECTIONS
{
.text:> FLASH PAGE O
.ebss:> MOSARAM PAGE 1
.cinit:> FLASH PAGE O
.stack:> M1SARAM PAGE 1
}
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Exercise 2a

Looking at the following block diagram, and create a linker command file.

Exercise 2a

0x00 0000

0x00 8000

0x3D 8000

osARAMI 0X00 0400
(0x400)

LoSARAM| 9X009000 | 1 5aRAM
(0x1000) (0x1000)
FLASH | OxSF 8000),,,5ARAM

(0x20000 (0x2000)

M1SARAM
(0x400)

F2812

Create the linker command file for the given memory
map by filling in the blanks on the following slide

Fill in the blanks:

Exercise 2a - Command File

Memory
{
PAGE__ :
}
SECTIONS
{
.text:
.ebss:
.cinit:
.stack:
3

vV V. V V

/* Program Space */

org = , len =
/* Data Space */

org = , len =

org = , len =

org = , len =

org = , len =

org = , len =
FLASH PAGE O
M1SARAM PAGE 1
FLASH PAGE 0O
MOSARAM PAGE 1

111
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Summary: Linker Command File

The linker command file (.cmd) contains the inputs — commands — for the linker. This
information is summarized below:

Linker Command File Summary

¢ Memory Map Description
+ Name
+ Location
+ Size

¢ Sections Description

+ Directs software sections into named
memory regions

+ Allows per-file discrimination
+ Allows separate load/run locations
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Lab 2a: Linker Command File
» Objective

Create a linker command file and link the C program file (LAB2.C) into the system described
below.

Lab 2a: Linker Command File

MOSARAM[ 0x00 0000 || 0SARAM @1 0x00 8000
Memory (0x400) I (0x1000) l
on-chip TIOXOO 0400 TI 0x00 9000
memory (0x400) (0x1000)

HOSARAM [§ 0x3F 8000
F2812 (0x2000) I

System Description:
* TMS320F2812
« All internal RAM blocks allocated

Placement of Sections:

« text into RAM Block HOSARAM on PAGE 0 (code space)
« .cinit into RAM Block HOSARAM on PAGE 0 (code space)
« .ebss into RAM Block M1SARAM on PAGE 1 (data space)
« .stack into RAM Block MOSARAM on PAGE 1 (data space)

System Description
o TMS320F2812

e All internal RAM blocks allocated

Placement of Sections:
e .text into RAM Block HOSARAM on PAGE 0 (code space)

e _cinitinto RAM Block HOSARAM on PAGE 0 (code space)
e .ebss into RAM Block M1SARAM on PAGE 1 (data space)
e stack into RAM Block MOSARAM on PAGE 1 (data space)

» Procedure

Create a New Project

1. Double click on the Code Composer Studio icon on the desktop. Maximize Code
Composer Studio to fill your screen. The menu bar (at the top) lists File ... Help. Note
the horizontal tool bar below the menu bar and the vertical tool bar on the left-hand side.
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The window on the left is the project window and the large right hand window is your
workspace.

A project is all the files you will need to develop an executable output file (. out) which
can be run on the DSP hardware. Let’s create a new project for this lab. On the menu bar
click:

Project > New

type Lab2 in the project name field and make sure the save in location is:
C:\C28x\LABS\LAB2. This will create a .pjt file which will invoke all the necessary
tools (compiler, assembler, linker) to build your project. It will also create a debug
folder that will hold immediate output files.

Add the C file to the new project. Click:

Project &> Add Files to Project..

and make sure you’re looking in C:\C28x\LABS\LAB2. Change the “files of type” to
view C source files (*. c) and select Lab2 . c and click OPEN. This will add the file
Lab2 . c to your newly created project.

Add Lab2a.cmd to the project using the same procedure. This file will be edited
during the lab exercise.

Next, add the compiler run-time support library to the project
(C=\ti\c2000\cgtools\1ib\rts2800_ml._lib).

In the project window on the left click the plus sign (+) to the left of Project. Now,
click on the plus sign nextto Lab2.pjt. Notice that the Lab2a.cmd file is listed.
Click on Source to see the current source file list (i.e. Lab2.c).

Project Build Options

7. There are numerous build options in the project. The default option settings are sufficient

for getting started. We will inspect a couple of the default linker options at this time.
Click: Project - Build Options..

Select the Linker tab. Notice that .out and .map files are being created. The .out file is
the executable code that will be loaded into the DSP. The .map file will contain a linker
report showing memory useage and section addresses in memory.

9. Set the Stack Size to 0x200. Select OK and then close the Build Options window.

Edit the Linker Command File - Lab2a.cmd

10. To open and edit Lab2a . cmd, double click on the filename in the project window.

11. Edit the Memory{} declaration by describing the system memory shown on the “Lab2a:

Linker Command File” slide.
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Lab 2a: Linker Command File

12. In the Sections{} area, notice that a section called .reset has already been allocated.
The .reset section is part of the rts2800_ml.lib, and is not needed. By putting the TYPE =
DSECT modifier after its allocation, the linker will ignor this section and not allocate it.

13. Place the sections defined on the slide into the appropriate memories via the
Sections{} area. Save your work.

Build and Load the Project

14. The top four buttons on the horizontal toolbar control code generation. Hover your
mouse over each button as you read the following descriptions:

Button Name Description
1 Compile File Compile, assemble the current open file
2 Incremental Build Compile, assemble only changed files, then link
3 Rebuild All Compile, assemble all files, then link
4 Stop Build Stop code generation

15. Code Composer Studio can automatically load the output file after a successful build. On
the menu bar click: Option - Customize.. and select the ““Program Load
Options™ tab, check “Load Program After Build”, then click OK.

16. Click the ““Bui 1d”” button and watch the tools run in the build window. Check for
errors (we have deliberately put an error in Lab2.c). When you get an error, scroll the
build window at the bottom of the Code Composer Studio screen until you see the error
message (in red), and simply double-click the error message. The editor will
automatically open the source file containing the error, and position the mouse cursor at
the correct code line.

17. Fix the error by adding a semicolon at the end of the "'z = x + y'' statement. For
future knowlege, realize that a single code error can sometimes generate multiple error
messages at build time. This was not the case here.

18. Rebuild the project (there should be no errors this time). The output file should
automatically load. The Program Counter should be pointingto _c_1nt0O0 in the
Disassembly Window.

19. Under Debug on the menu bar click “Go Main”’. This will run through the C-
environment initialization routine in the rts2800_ml . I'ib and stop at main() in
Lab2.c.

Debug Enviroment Windows

It is standard debug practice to watch local and global variables while debugging code. There
are various methods for doing this in Code Composer Studio. We will examine two of them
here: memory windows, and watch windows.

20. Open a memory window to view the global variable ““z”’.

Click: View > Memory on the menu bar.
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21.

22.

23.

Type ““&z’ into the address field. Note that you must use the ampersand (meaning
"address of") when using a symbol in a memory window address box. Also note that
Code Composer Studio is case sensitive.

Set the properties format to “Hex — T1 style.” This will give you more viewable data in
the window.

Click OK to close the window property selection screen. The memory window will now
open. You can change the contents of any address in the memory window by double-
clicking on its value. This is useful during debug.

Open the watch window to view the local variables x and .
Click: View > Watch Window on the menu bar.

Click the “Watch Locals” tab and notice that the local variables x and y are already
present. The watch window will always contain the local variables for the code function
currently being executed.

(Note that local variables actually live on the stack. You can also view local variables in
a memory window by setting the address to “SP” after the code function has been
entered).

We can also add global variables to the watch window if desired. Let's add the global
variable “z”’.

Click the “Watch 1" tab at the bottom of the watch window. In the empty box in the
"Name" column, type ““z””. Note that you do not use an ampersand here. The watch
window knows you are specifying a symbol.

Check that the watch window and memory window both report the same value for ““z”’.
Trying changing the value in one window, and notice that the value also changes in the
other window.

Single-stepping the Code

Single-step through main() by using the <F8> key (or you can use the Single
Step button on the vertical toolbar). Check to see if the program is working as
expected. What is the value for ““z”” when you get to the end of the program?

End of Exercise
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DSP/BIOS Configuration Tool

The DSP/BIOS Configuration Tool (often called Config Tool or GUI Tool or GUI) creates and
modifies a system file called the Configuration DataBase (.CDB). If we talk about using CDB
files, we’re also talking about using the Config Tool.

DSP/BIOS Configuration Tool il cab)

¥ example.cdb *
Estimated Data Size: 824 Est Min Stack Size [Malls]: 191

H-@F .
ﬁ I(\;"\I:I:a-l ;‘::n'gfj Section Manager ’ M E M h an d | es SySte m

I'Iﬂ BLF - Buffer pool Manager

Y5 - System Settings

B & HOOK - Module Hook Manager
I'_;‘I-EE Instrumentation

B LOG - Event Log Manager

: STS - Statistics Object Manager
heduling

£ CLE - Clack Manager

@ PRD - Perindic Function Manager
'"1, HWI - Hardware Inkerrupt Service Routine Manager
g SWI - Software Interrupt Manager
@ TSK - Task Manager

E!‘j IDL - Idle Function Manager
[—]6!3 Synchronization

ﬁ(' SEM - Semaphore Manager

@) B - Mailbox Manager

'i_,' QUE - Atomic Queue Manager

S g LCK - Resource Lock Manager
= @ InputfOutput

memory configuration
(builds .cmd file)

Configures BIOS
scheduling, RTA and
other BIOS functions

Automatically

handles: run-time
support libraries,
interrupt vectors,
system reset, etc.

@ RTD¥ - Real-Time Data Exchange Settings
[&-B4 HST - Host Channel Manager

; -'.ﬁ, PIF - Buffered Pipe Manager

--:3_: SI0 - Stream Input and Oukput Manager
4% Device Drivers

The GUI (graphical user interface) simplifies system design by:
e Automatically including the appropriate runtime support libraries
e Automatically handles interrupt vectors and system reset
e Handles system memory configuration (builds CMD file)
o When a CDB file is saved, the Config Tool generates 5 additional files:

Filename.cdb Configuration Database

Filenamecfg_c.c C code created by Config Tool
ASM code created by Config Tool

Linker commands

Filenamecfg.s28

Filenamecfg.cmd

Filenamecfg.h header file for *cfg_c.c

Filenamecfg.h28 header file for *cfg.s28

When you add a CDB file to your project, CCS automatically adds the C and assembly
(.S28) files to the project under the Generated Files folder. (You must manually add the
CMD file, yourself.)
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1. Creating a New Memory Region (Using MEM)

First, to create a specific memory area, open up the .CDB file, right-click on the Memory Section
Manager and select “Insert MEM”. Give this area a unique name and then specify its base and
length. Once created, you can place sections into it (shown in the next step).

Memory Section Manager

Estimated Data Size: 824 Est. Min. Stack Size (MALs]) 191
o st ¢ Mem manager allows
E|Q gn;ol\g?n;gx Section Manager y O u to C r eat e
g memory area and
® Losaran place sections
- [T — 3
BE==r ¢ To create a new
il BUF - memaory area.
:\;SO—I COmment; <add comments heres| RI g ht Cl IC k on M EM
g2 Instrume ase. i * .

7@ nsune | B — and select Insert
588 Synchror len 0=2000 memo ry
-1 InputfOu | | create a heap in this memary

« Fill in base, length,

heap size! Ox0200 s p ace

[ enter.auger defined heap identifier lzbel

heap identifier label |s2ament_hame
space Icnde 'I

0K I Cancel | Apply | Help
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2. Placing Sections — MEM Manager Properties

The configuration tool makes it easy to place sections. The predefined compiler sections that
were described earlier each have their own drop-down menu to select one of the memory regions
you defined (in step 1).

Memory Section Manager Properties

MEM - Memory Section Manager Properties : ﬂ

General | BIOS Data | BIOS Code Compiler Sections | Load Address |

|T_ Usser.cmd File For Mon-DSP/BIOS S:;:::AM ‘ TO place a SeCtlon

ion [ bext): A H .
- K into a memory area:
Switch Jump Tables [ awitch): HOSARAM et . A
C ariables Section [bez): LOSARAM A ¢ RI g h t -C | Ic k on M EM

and select

C Variables Section [ ebss) LOSARAM 5 Pro pertles
Data Initishization Section [ cinit): HOSARAM Bt . Sel eCt th e
C Function Initialization Table [pinit; | HOSARAM v ap p ro p rl ate tab (e g .
Constant Section [ econat] LOSARAM A CO m p | | er)
Constant Section [.const]: LOSARAM e - Select th e memo ry
Data Section [ datal: LOSARAM - for each section
D ata Section [.cio): LOSARAM hd

ag I Cancel Lpply Help
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3. Running the Linker
Creating the Linker Command File (via .CDB)

When you have finished creating memory regions and allocating sections into these memory
areas (i.e. when you save the .CDB file), the CCS configuration tool creates five files. One of the
files is BIOS’s cfg.cmd file — a linker command file.

Files Created by Config Tool

e Config tool generates five

Estimated Data Size: 824 Est Min. Stack Size [Mals): 191 different files

=g ?éjstglmb - ¢ Notice, one of them is the
o P03l JELInas linker command file

E@u MEM - Memary Section Manager
¢ CMDfileis generated from
your MEM settings

FLASH:  org = 0x3D8000, len = 0x20000 *cfg_c.c
HOSARAM: org = Ox3F8000, len = 0x2000 ~
3} cfg.s28
SECTIONS{ e “ *cfg.cmd
.text: > FLASH e
.bss: > MOSARAM 4 *cfg.h
o

Z *cfg.h28

This file contains two main parts, MEMORY and SECTIONS. (Though, if you open and
examine it, it’s not quite as nicely laid out as shown above.)
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Running the Linker

The linker’s main purpose is to link together various object files. It combines like-named input
sections from the various object files and places each new output section at specific locations in
memory. In the process, it resolves (provides actual addresses for) all of the symbols described in

your code.

Config Tool Linker Command File

“Build”
app.cdb D |
appcfgcmd > Linker
\—//_/
.obj files L"‘ ----- .
libraries II map
(.lib) myApp.out

¢ Do not modify appcfg.cmd — your changes will
be overwritten during “Build” (or “Rebuild”)

The linker can create two outputs, the executable (.out) file and a report which describes the
results of linking (.map).

Note: If the graphic above wasn’t clear enough, the linker gets run automatically when you
BUILD or REBUILD your project.
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Lab 2b: DSP/BIOS Configuration Tool
» Objective

Use Code Composer Studio and DSP/BIOS configuration tool to create a configuration database

files (*.CDB). The generated linker command file Labcfg.cmd will be then be used with Lab2.c

to verify its operation. The memory and sections of a “user” linker command file will be deleted,
however, the “user” linker command file will be needed and modified in future labs.

Lab 2b: Configuration Tool

MOSARAM[ 0x00 0000 || oSARAM @1 0x00 8000
Memory (0x400) I (0x1000) I
on-chip TIOXOO 0400 TI 0x00 9000
memory (0x400) (0x1000)

HOSARAM f§ 0x3F 8000
F2812 (0x2000) I

System Description:
* TMS320F2812
« All internal RAM blocks allocated

Placement of Sections:

« .text into RAM Block HOSARAM in code space (PAGE 0)
e .cinit into RAM Block HOSARAM in code space (PAGE 0)
« .ebss into RAM Block M1SARAM in data space (PAGE 1)
« .stack into RAM Block MOSARAM in data space (PAGE 1)

System Description
o TMS320F2812

e All internal RAM blocks allocated

Placement of Sections:
e .textinto RAM Block HOSARAM in code space (PAGE 0)

e .cinitinto RAM Block HOSARAM in code space (PAGE 0)
e .ebss into RAM Block M1SARAM in data space (PAGE 1)
e .stack into RAM Block MOSARAM in data space (PAGE 1)

> Procedure

Project Lab2.pjt

1. If Code Composer Studio is not running from the previous lab exercise, double click on
the CCS 2 (“C2000) icon on the desktop. Maximize CCS to fill your screen. Then select
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Lab2.pjt from the Project - Recent Project Files list. This will put you
at the proper starting point for this lab exercise.

2. If needed, verify that the project is open in CCS by left clicking the plus sign (+) to the
left of Project. Then, click on the plus sign next to Lab2.pjt ,as well as the other
plus signs to verify all the previous files have been included.

Remove “rts2800_ml.lib” and “Lab2a.cmd” from the Project

3. Highlight the rts2800_ml.11b in the project window and right click, then select
“Remove from Project”. The DSP/BIOS Config Tool supplies its own rts library.

4. Remove Lab2a.cmd using the same procedure. We will be using the DSP/BIOS
configuration tool to create a linker command file.

Using the DSP/BIOS Configuration Tool

5. The configuration database files (*.cdb), created by the Config Tool, controls a wide
range of CCS capabilities. In this lab exercise, the CDB file will be used to automatically
create and perform memory management. Create a new CDB file for this lab. On the
menu bar click:

File > New - DSP/BIOS Configuration..

A dialog box appears. The CDB files shown in the aforementioned dialog box are called
“seed” CDB files. CDB files are used to configure many objects specific to the
processor. Select the c28xx.cdb template and click OK.

6. Save the configuration file by selecting:

File > Save As..
and name it Lab.cdb in C:\C28x\LABS\LAB2. Close the configuration window.

7. Add the configuration file to the project. Click:
Project - Add Files to Project..

Make sure you’re looking in C:\C28x\LABS\LAB2. Change the “files of type” to
view All Files (*.*) and select Lab.cdb. Click OPEN to add the file to the project.

8. Add the generated linker command file, Labcfg . cmd, to the project using the same
procedure.

Create New Memory Sections Using the CDB File

9. Open the Lab.cdb file by left clicking on the plus sign (+) to the left of DSP/BI10S
ConfFig and double clicking on the Lab . cdb file. In the configuration window, left
click the plus sign next to System and the plus sign next to MEM.

10. By default, the Memory Section Manager has combined the memory space for
LOSARAM and L1SARAM into a single memory block called LOSARAM. It has also
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11.

12.

combined MOSARAM and M1SARAM into a single memory block called MOSARAM.
We want to split these memory sections as shown in the slide for this lab exercise.

Right click on MEM — Memory Section Manager andselect Insert MEM.
Rename the newly added memory section to LLSARAM. Create a second new memory
section, and rename it to M1SARAM.

Modify the length and base addresses of each of the memory sections LOSARAM,
L1SARAM, MOSARAM, and M1SARAM to correspond to the memory mapping shown
in the figure at the beginning of this lab. To modify the length and base address of a
memory section, right click on the memory in configuration tool, and select “Properties.”
While modifying the length and base address of each section, make sure the

“create a heap in memory” box is checked ONLY for LOSARAM. Uncheck
this box in the other three memory sections.

Rightclickon MEM — Memory Section Manager and select Properties.
Selectthe Compiler Sections tab and place the .text, .cinit, and .ebss sections
defined on the lab introduction slide into the appropriate memories via the pull-down
boxes. Similarly, place the .stack section into memory using the BIOS Data tab.
Click OK to save your work.

Set the Stack Size in the CDB File

13.

14.

15.

Recall in the previous lab exercise that the stack size was set using the CCS project Build
Options. When using the DSP/BIOS configuration tool, the stack size is instead specified
in the CDB file. First we need to remove the stack size setting from the project Build
Options.

Click: Project > Build Options.. and select the Linker tab. Delete the entry
for setting the Stack Size to 0x200. Select OK to close the Build Options window.

Right click on MEM — Memory Section Manager and select Properties.
Select the General tab. Notice that the Stack Size has been set to 0x200 by default, so
there is no need to modify this. Click OK to close the window.

Build and Load the Project

16.

17.

Click the ““Bui 1d” button and watch the tools run in the build window. The output file
should automatically load. The Program Counter should be pointing to _c_int00 in
the Disassembly Window.

Under Debug on the menu bar click “Go Main™. This will run through the DSP/BIOS
C-environment initialization routine and stop at main() in Lab2.c.

Run the Code

18.

We will verify the operation of the code using the same procedure used in Lab2a. Open
the watch window and add the global variable z.
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19. Next, single-step the routine through to the end. Check to see if the program is working
as expected. You should get the same value for ““z’” as in Lab2a.

End of Exercise
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Solutions

Exercise 2a - Solution

Memory

{
PAGE_O: /* Program Space */
FLASH: org = 0x3D8000, len = 0x20000
PAGE 1: /* Data Space */

MOSARAM: org = 0x000000, len = 0x400
M1SARAM: org = 0x000400, len = 0x400
LOSARAM: org = 0x008000, len = 0x1000
L1SARAM: org = 0x009000, len = 0x1000
HOSARAM: org = 0x3F8000, len = 0x2000

}
SECTIONS
{
-text: > FLASH PAGE O
-ebss: >  M1SARAM PAGE 1
.cinit: >  FLASH PAGE O
.stack: >  MOSARAM PAGE 1
}
Lab 2a: Solution - lab2.cmd
MEMORY
PAGE O: /* Program Space */
HOSARAM: org = Ox3F8000, [len = 0x2000
PAGE 1: /* Data Space */
MOSARAM: org = 0x000000, 1len = 0x400
M1SARAM: org = 0x000400, len = 0x400
LOSARAM: org = 0x008000, 1len = 0x1000
L1SARAM: org = 0x009000, len = 0x1000
}
SECTIONS
{
.text: > HOSARAM PAGE O
.ebss: > M1SARAM PAGE 1
.cinit: > HOSARAM PAGE O
.stack: > MOSARAM PAGE 1
.reset: > HOSARAM PAGE 0, TYPE = DSECT
}
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Peripherial Registers Header Files

Introduction

The purpose of the F281x C-code header files is to simplify the programming of the many
peripherals on the C28x device. Typically, to program a peripheral the programmer needs to
write the appropriate values to the different fields within a control register. In it’s simplest form,
the process consists of writing a hex value (or masking a bit field) to the correct address in
memory. But, since this can be a burdensome and repetitive task, the C-code header files were
created to make this a less complicated task.

The F281x C-code header files are part of a library consisting of C functions, macros, peripheral
structures, and variable definitions. Together, this set of files is known as the ‘header files.’
Eventually, the entire collection will be replaced with a CCS add-in called the Chip Support
Library (CSL). At that time, there will be a GUI interface used via CCS’s config tool.

Registers and the bit-fields are represented by structures. C functions and macros are used to
initialize or modify the structures (registers).

In this module, you will learn how to use the header files and C programs to facilitate
programming the peripherals.

Learning Objectives

Learning Objectives

¢ Understand the usage of the F281x
C-Code Header Files

¢ Be able to program peripheral
registers

¢ Understand how peripherals are
mapped with linker command file
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Traditional and Structure Approach to C Coding

Traditional and Structure Approach to C Coding

Traditional Approach to C Coding

#define ADCTRL1 (volatile unsigned int *)0x00007100
#define ADCTRL2 (volatile unsigned int *)0x00007101

void main(void)

{
*ADCTRL1 = 0x1234; //write entire register
*ADCTRL2 |= 0x4000; //reset sequencer #1
3
Advantages - Simple, fast and easy to type

- Variable names exactly match register names (easy
to remember)

Disadvantages - Requires individual masks to be generated to
manipulate individual bits

- Cannot easily display bit fields in Watch window
- Will generate less efficient code in many cases

Structure Approach to C Coding

void main(void)

{
AdcRegs.ADCTRL1.all = 0x1234; //write entire register
AdcRegs.ADCTRL2.bit.RST_SEQ1 = 1; //reset sequencer #1

}

Advantages - Easy to manipulate individual bits.

Watch window is amazing! (next slide)
Generates most efficient code (on C28x)

Disadvantages Can be difficult to remember the structure names

(Code Maestro to the rescuel)

More to type (again, Code Maestro to the rescue)
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Traditional and Structure Approach to C Coding

Is the Structure Approach Efficient?

The structure approach enables efficient compiler use of
DP addressing mode and C28x Atomic operations

C Source Code

Generated Assembly Code

// Stop CPU TimerO
CpuTimerORegs.TCR.bit.TSS = 1;

// Load new 32-bit period value
CpuTimerORegs.PRD.all = 0x00010000;

// Start CPU TimerO
CpuTimerORegs.TCR.bit.TSS = 0;

MOVW DP, #0030
OR @4, #0x0010

MOVL XAR4, #0x010000
MOVL @2, XAR4

AND @4, #0xffef

- Easy to read the code w/o comments
- Bit mask built-in to structure

5 Words, 5 cycles

(This example could not have been coded any more efficiently with hand assembly)

Compare with the #define Approach

The #define approach relies heavily on less-efficient
pointers for random memory access, and often does not
take advantage of C28x atomic operations

C Source Code

Generated Assembly Code

// Stop CPU TimerO
*TIMEROTCR |= 0x0010;

// Load new 32-bit period value
*TIMEROTPR32 = 0x00010000;

// Start CPU TimerO
*TIMEROTCR |= OXFFEF;

MOV AL, *(0:0x0c04)
ORB AL, #0x10
MOV *(0:0x0c04), AL

MOVL  XAR4, #3078
MOVL  XAR5., #65536
MOVL  *+XAR4[0], XAR5

MOV AL, *(0:0x0c04)
OR AL, #Oxffef
MOV *(0:0x0c04), AL

- Hard to read the code w/o comments
- User had to determine the bit mask

9 Words, 9 cycles
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Naming Conventions

Naming Conventions

The header files use a familiar set of naming conventions. They are consistent with the Code
Composer Studio configuration tool, and generated file naming conventions

Structure Naming Conventions

¢ The DSP281x header files define:
« All of the peripheral structures
+ All of the register names
+ All of the bit field names
« All of the register addresses

PeripheralName.RegisterName.all

/I Access full 16 or 32-bit register

PeripheralName.RegisterName.half.LSW
PeripheralName.RegisterName.half.MSW

PeripheralName.RegisterName.bit.FieldName

/I Access low 16-bits of 32-bit register
/I Access high 16-bits of 32-bit register

/I Access specified bit fields of register

Notes: [1]

(2]

(3]

“PeripheralName” are assigned by Tl and found in the DSP281x header files.
They are a combination of capital and small letters (i.e. CpuTimerORegs).

“RegisterName” are the same names as used in the data sheet.
They are always in capital letters (i.e. TCR, TIM, TPR,..).

“FieldName” are the same names as used in the data sheet.
They are always in capital letters (i.e. POL, TOG, TSS,..).

Code Maestro to the Rescue!
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Example of Peripheral Structure .h file

Example of Peripheral Structure .h file

Example Adc.c or main.c

Example Adc.h

Example of Peripheral Structure .h file

#include “DSP281x_Device.h”

Void InitAdc(void)

{
/* Reset the ADC module */
AdcRegs.ADCTRL1.bit.RESET =1;

[* configure the ADC register */
AdcRegs.ADCTRL1.all = 0x0710;
%

/* ADC Individual Register Bit Definitions */
struct ADCTRL1_BITS {

uint16
uint16
uint16
uint16
uint16
uint16
uint16
uint16
uint16
I

rsvdl:4;
SEQ_CASC:1;
rsvd2:1;
CONT_RUN:1;
CPS:1;
ACQ_PS:4;
SUSMOD:2;
RESET:1;
rsvd3:1;

/I bits description

11 3:0 reserved

/I 4 Cascaded sequencer mode
1I'5 reserved

/' 6 Continuous run

/1’7 ADC core clock prescaler
/1'11:8 Acquisition window size
/1'13:12 Emulation suspend mode
1114 ADC reset

1115 reserved

/* Allow access to the bit fields or entire register */
union ADCTRL1_REG {

uint16

h

all;

struct ADCTRL1_BITS bit;

/I ADC External References & Function Declarations:

extern volatile struct ADC_REGS AdcRegs;
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Mapping Structures to Memory

Mapping Structures to Memory

The data structures describe the register set in detail. And, each instance of the data type (i.e.,
register set) is unique. Each structure is associated with an address in memory. This is done by
(1) creating a new section name via a DATA_SECTION pragma, and (2) linking the new section
name to a specific memory in the linker command file.

DSP281x_GlobalVariableDefs.C

Example Mapping Structure to Memory

¢ “DATA_SECTION pragma used to assign a unique linker section
name to the peripheral structure

#pragma DATA_SECTION(AdcRegs,“ AdcRegsFile");

DSP281x_Headers_BIOS.CMD

¢ Linker command file maps the unique peripheral section
name to the physical memory address

MEMORY

{

PAGEL:
ADC:

-

SECTIONS
{

A-chegsFiIe 1>
}

ADC

origin=0x007100, length=0x000020

PAGE =1

Linker Command File

When using the header files, the user adds the MEMORY regions that correspond to the
CODE_SECTION and DATA_SECTION pragmas found in the .h and global-definitons.c file.

The user can modify their own linker command file, or use the pre-configured linker command
files such as EzDSP_RAM _Ink.cmd or F2812.cmd. These files have the peripheral memory
regions defined and tied to the individual peripheral.
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F281x C-Code Header Files

F281x C-Code Header Files

The C-code header files consists of .h, ¢ source files, linker command files, and other useful
example programs, documentations and add-ins for Code Composer Studio.

DSP281x Header File Package

(http://lwww.ti.com, literature # SPRC097)

¢ Simplifies program of peripherals and
other functions

¢ Takes care of register definitions and
addresses

¢ Header file package consists of:

+ \DSP281x_headers\include - .h files

« \DSP281x_common\src - .c source files

+ \DSP281x_headers\cmd = linker command files
+ \DSP281x_headers\gel - .gel files for CCS

+ \DSP281x_examples -> example programs

+ \doc -> documentation

¢ Tl has done all of the work for you!

A peripheral is programmed by writing values to a set of registers. Sometimes, individual fields
are written to as bits, or as bytes, or as entire words. Unions are used to overlap memory
(register) so the contents can be accessed in different ways. The header files group all the
registers belonging to a specific peripheral.

A DSP281x_Peripheral.gel GEL file can provide a pull down menu to load peripheral data
structures into a watch window. Code Composer Studio can load a GEL file automatically. To
include fuctions to the standard F2812.gel that is part of Code Composer Studio, add:

GEL_LoadGel(“base_path/gel/DSP281x_Peripheral.gel”)
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F281x C-Code Header Files

.h Definition Files

The DSP281x_Device.h header file is the main include file. By including this file in the .c source
code, all of the peripheral specific .h header files are automatically included. Of course, each
specific .h header file can included individually in an application that do not use all the header
files, or you can comment out the ones you do not need. (Also includes typedef statements).

.h Definition Files
¢ Files found in the
\DSP281x_headers\include directory

¢ Define structures and bit fields in
peripheral and system registers

¢ DSP281x_Device.h —main include file
will include all other .h files

+ #include  “DSP281x_Device.h”

DSP281x_Device.h DSP281x_DevEmu.h
DSP281x_SysCtrl.h DSP281x_PieCtrl.h
DSP281x_Adc.h DSP281x_CpuTimers.h
DSP281x_ECan.h DSP281x_Ev.h
DSP281x_Gpio.h DSP281x_Mcbsp.h
DSP281x_Sci.h DSP281x_Spi.h
DSP281x_Xintf.h DSP281x_XIntrupt.h
DSP281x_PieVect.h DSP281x_Defaultlsr.h
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F281x C-Code Header Files

Global Variable Definition File

With DSP281x_GlobalVariableDefs.c included in the project all the needed variable definitions
are globally defined.

Global Variable Definition File

DSP281x_GlobalVariableDefs.C
Defines all variables to use .h files

DATA_SECTION pragma used to
define data section for each
peripheral structure

¢ Linker will link each structure to the
physical address of the peripheral in
memory

¢ Add DSP281x_GlobalVariableDefs.C
to the Code Composer Studio project

* o6 o
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Peripheral Specific Routines

Peripheral Specific Routines

Peripheral Specific C functions are used to initialize the peripherals. They are used by adding the
appropriate .c file to the project.

Peripheral Specific Routines

¢ Contains peripheral specific
initialization routines and other
support functions

DSP281x_SysCitrl.c DSP281x_Gpio.c
DSP281x_PieCtrl.c DSP281x_Mcbsp.c
DSP281x_Adc.c DSP281x_Sci.c
DSP281x_CpuTimers.c DSP281x_Spi.c
DSP281x_ECan.c DSP281x_Xintf.c
DSP281x_Ev.c DSP281x_Xintrupt.c
DSP281x_PieVect.c DSP281x_Defaultlsr.c

Workshop lab files based on above files with modifications

Other files included in the packet:

Other Files in Packet

¢ Linker.cmd files

+ DSP281x_Headers_ BIOS.cmd
DSP281x_Headers nonBIOS.cmd

+ Contains memory allocation for all
peripheral structure definitions
Included in C-code header file package

¢ DSP281x_CodeStartBranch.asm

+ Used to redirect code execution when
booting

ref _c_int00

.sect "codestart"

LB _c_int00 ;branch to start of boot.asm in RTS library

Workshop lab files based on above files with modifications
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Example Usage Flow

Example Usage Flow

// Step 0. Include required header files
// DSP281x_Device.h: device specific definitions #include statements
// for all of the peripheral .h definition files.
// DSP281x_Example.h is specific for the given example.

#include ""'DSP281x_Device.h"

// Prototype statements for functions found within this file.
interrupt void cpu_timerQ_isr(void);

void main(void)

{

// Step 1. Initialize System Control registers, PLL, WatchDog, Clocks to de-
fault state:
// This function is found in the DSP281x_SysCtrl.c file.
InitSysCtri();

// Step 2. Select GPIO for the device or for the specific application:
// This function is found in the DSP281x_Gpio.c file.
InitGpio(Q);

// Step 3. Initialize PIE vector table:
// The PIE vector table is initialized with pointers to shell Interrupt
// Service Routines (ISR). The shell routines are found in

DSP28 Defaultlsr.c.
// Insert user specific ISR code in the appropriate shell ISR routine in
// the DSP281x_Defaultlsr.c file.

// Disable and clear all CPU interrupts:

DINT;
IER = 0x0000;
IFR = 0x0000;

// Initialize Pie Control Registers To Default State:
// This function is found in the DSP281x_PieCtrl.c file.
InitPieCtri();

// Initialize the PIE Vector Table To a Known State:

// This function is found in DSP281x_PieVect.c.

// This function populates the PIE vector table with pointers

// to the shell ISR functions found in DSP281x_Defaultlsr.c.
InitPieVectTable();

// Step 4. Initialize all the Device Peripherals to a known state:
// This function is found in DSP281x_InitPeripherals.c
InitPeripherals();

// Step 5. User specific functions, Reassign vectors (optional), Enable Inter-
rupts:

// Initialize CPU Timer O:
// > Set Up For 1 Second Interrupt Period
// > Point To "cpu_timer0_isr" function

// Reassign CPU-TimerO ISR.

// Reassign the PIE vector for TINTO to point to a different ISR then
// the shell routine found in DSP281x Defaultlsr.c.

// This is done if the user does not want to use the shell ISR routine
// but instead wants to use their own ISR. This step is optional:
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Example Usage Flow

EALLOW; // This is needed to write to EALLOW protected registers
PieVectTable_TINTO = &cpu_timer0_isr;
EDIS; // This is needed to disable write to EALLOW protected registers

// Include application specific functions. This is for this example:

// Configure CPU-Timer O to interrupt every second:
ConfigCpuTimer(&CpuTimer0, 100, 1000000); // 100MHz CPU Freq, 1 second

// Period (in uSeconds)
StartCpuTimer0(Q);

// Enable CPU INT1 which is connected to CPU-Timer O:
IER |= M_INTZ1;

// Enable TINTO in the PIE: Group 1 interrupt 7
PieCtrlRegs.PIEIER1.bit.INTX7 = 1;

// Enable global Interrupts and higher priority real-time debug events:

EINT; // Enable Global interrupt INTM
ERTM; // Enable Global realtime interrupt DBGM

// Step 6. IDLE loop. Just sit and loop forever (optional):
for(;:);

// Step 7. Insert all local Interrupt Service Routines (ISRs) and functions
here:

// IT local ISRs are used, reassign vector addresses iIn vector table as
// shown in Step 5
interrupt void cpu_timer0_isr(void)
CpuTimerO. InterruptCount++;

// Acknowledge this interrupt to recieve more interrupts from group 1
PieCtriRegs.PIEACK.all = PIEACK_GROUP1;
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Summary

Summary

Peripheral Register Header Files
Summary

Easier code development
Easy to use
Generates most efficient Code

Increases Effectiveness of CCS
Watch Window

Tl has already done all the work!

+« Download literature # SPRC097 from www.ti.com

® 6 ¢ o

*
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Summary
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Reset and Interrupts

Introduction

This module describes the interrupt process and explains how the peripheral Interrupt expansion
(PIE) works.

Learning Objectives

Learning Objectives

¢ Describe the C28x reset process
and post-reset device state

¢ List the event sequence during an
interrupt

¢ Describe the C28x interrupt
structure
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Module Topics

Module Topics

RESEE AN INTEITUPDLS ...t bbbttt b e bbbt b e et et e nb e besbesbesbeaneeneas 4-1
T LU TN o o0 4-2
COre INTEITUPL LINES ..ttt bbbttt ettt 4-3

TS TSR 4-3
T T= A = oo 4 T U [T PSRRI 4-5
INEEITUPE SOUICES ...ttt ettt b e bt e bt st e e ae e eb e e bt et e e s bt eh b e sb e e nb e e nbe e nesnnesaeeeaeenas 4-7
INEEITUDPT PrOCESSING ... ceeeuee ettt sttt bbbttt e e bbbt bt bt e n e b e eb e ke sbesbenbesbeeeeanes 4-7
Peripheral Interrupt EXPansion (PIE) ..ot e 4-9
PIE INErrupt VECOr TaBIE . .c.viieiiicicece ettt st renre s 4-10
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Core Interrupt Lines

Core Interrupt Lines

C28x Core Interrupt Lines

RS #—
NMI [——
INTL [——

ey & 2non-maskable
INT3 +—

T4 interrupts (RS,
C28x INTS —— “selectable” NMI)

INT6 = ¢ 14 maskable interrupts
CORE 17 p— (INT1 — INT14)

INT8 *+—

INT9 +—
INT10 +=—
INT11 —
INT12 =—
INT13 *+—
INT14 =—

Reset

C28x Reset Sources

C28x Core
Watchdog Timer

RS

RS pin active

To RS pin
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Core Interrupt Lines

Register Bits Initialized at Reset

Register bits defined by reset

PC

ACC
XARO - XAR7
DP

P

XT

SP

RPC
IFR

IER
DBGIER

0x3F FFCO PC loaded with reset vector
0x0000 0000 Accumulator cleared

0x0000 0000 Auxiliary Registers

0x0000 Data Page pointer points to page 0
0x0000 0000 P register cleared

0x0000 0000 XT register cleared

0x0400 Stack Pointer to address 0400
0x00 0000 Return Program Counter cleared
0x0000 no pending interrupts

0x0000 maskable interrupts disabled
0x0000 debug interrupts disabled

Control Bits Initialized at Reset

Status Register 0 (ST0)

SXM =0
OVM =0
TC=0
Cc=0
Z=0

Sign extension off

Overflow mode off N=0 negative flag
test/control flag V=0 overflow bit

carry bit PM = 000 set to left-shift-by-1
zero flag OVC =00 0000 overflow counter

Status Reqgister 1 (ST1)

INTM =1
DBGM =1
PAGEO =0
VMAP =1
SPA=0
LOOP =0
EALLOW =0
IDLESTAT =0
AMODE =0
OBJMODE =0
MOM1IMAP =1
XF=0

ARP =0

Disable all maskable interrupts - global

Emulation access/events disabled

Stack addressing mode enabled/Direct addressing disabled
Interrupt vectors mapped to PM 0x3F FFCO — 0x3F FFFF
stack pointer even address alignment status bit

Loop instruction status bit

emulation access enable bit

Idle instruction status bit

C27x/C28x addressing mode

C27x object mode

mapping mode bit

XF status bit

ARP points to ARO
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Core Interrupt Lines

Reset - Bootloader

Reset — Bootloader

Reset

OBJMODE=0 AMODE=0
ENPIE=0 VMAP=1

XMPNMC=1
(microprocessor mode)

Reset vector fetched
from XINTF zone 7

XMPNMC=0
(microcomputer mode)

Reset vector fetched
from boot ROM

Notes:

0x3F FFCO

0x3F FFCO

Bootloader sets

OBJMODE =1
AMODE =0

Boot determined by

F2810 XMPNMC tied low internal to device
XMPNMC refers to input signal

MP/MC is status bit in XINTFCNF2 register
XMPNMC only sampled at reset

state of GPIO pins

Execution Bootloading
Entry Point Routines
FLASH SPI
HO SARAM SCI-A
OTP Parallel load

Bootloader Options

GPIO pins
F4 F12 F3 F2

X X

jump to FLASH address 0x3F 7FF6 *
jump to HO SARAM address Ox3F 8000 *
jump to OTP address 0x3D 7800 ks

O O OO0 O k=
O O FP|O O
O B X|O B
O B X |k O X

bootload external EEPROM to on-chip memory via SPI port

bootload code to on-chip memory via SCI-A port

bootload code to on-chip memory via GPIO port B (parallel)

* Boot ROM software configures the device for C28x mode before jump
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Core Interrupt Lines

Reset Code Flow - Summary

0x3D 7800

0x3D 8000

0x3F 8000

0x3F FO00

RESET HEE Ox3F FFCO

OTP (1K)

| FLASH (128K)
'EI .................... 0x3F 7FF6

HO SARAM (8K)

Boot ROM (4K)

Boot Code
0x3F FC00

Execution Entry
Point Determined p===
By GPIO Pins

|

BROM vector (32)

0x3F FC00

v
Bootloading
Routines
(SPI, SCI-A,
Parallel Load)
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Interrupt Sources

Interrupt Sources

Interrupt Sources

Internal Sources

TINT2
TINT1 228)( CORE
TINTO ——— RS
NMI
EV and Non-EV PIE
Peripherals (Peripheral T
(EV, ADC, SPI, Interrupt INT2
SCI, McBSP, CAN) Expansion) a INT3
External Sources :
"""""" i
SNTI INT12
| INT13
XINT2 ———
| INT14
PDPINTx —!
—_— |
RS —
— |
XNMI_XINT13 :

[ —

Interrupt Processing

Maskable Interrupt Processing
Conceptual Core Overview

Core (IFR) (IER) (INTM)

Interrupt  “Latch” “Switch” “Global Switch”

N2 ——{o}—— C28x
: : : e Core
INT14 [1] e -

¢ Avalid signal on a specific interrupt line causes the latch
to display a “1"” in the appropriate bit

¢ If the individual and global switches are turned “on” the
interrupt reaches the core
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Interrupt Sources

Interrupt Flag Register (IFR)

15 14 13 12 11 10 9 8
|RTOSINT|DLOGINT| INT14 | INT13 | INT12 | INT11 | INT10 | INT9 |
7 6 5 4 3 2 1 0
| INT8 | INT7 | INT6 | INTS | INT4 | INT3 | INT2 | INT1 |

Pending: IFRg;=1
Absent : IFR ;=0

/** Manual setting/clearing IFR ***/

extern cregister volatile unsigned int IFR;
IFR |= 0x0008; lIset INT4 in IFR
IFR &= OXFFF7; llclear INT4 in IFR

& Compiler generates atomic instructions (non-interruptible) for setting/clearing IFR
< If interrupt occurs when writing IFR, interrupt has priority

¢ IFR(bit) cleared when interrupt is acknowledged by CPU

& Register cleared on reset

Interrupt Enable Register (IER)

15 14 13 12 11 10 9 8
|RTOSINT|DLOGINT| INT14 | INT13 | INT12 | INT11 | INT10 | INT9 |
7 6 5 4 3 2 1 0
| INTS | INT7 | INT6 | INT5 | INT4 | INT3 | INT2 | INTL |

Enable: Set IER g =1
Disable: Clear IERg;=0

[*** Interrupt Enable Register ***/

extern cregister volatile unsigned int IER;
IER |= 0x0008; /lenable INT4 in IER
IER &= OXxFFF7; /ldisable INT4 in IER

¢ Compiler generates atomic instructions (non-interruptible)
for setting/clearing IER

¢ Register cleared on reset
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Interrupt Sources

Interrupt Global Mask Bit

Bit 0
ST1 INTM

¢ INTM used to globally enable/disable interrupts:
« Enable: INTM =0
« Disable: INTM =1 (reset value)

¢ INTM modified from assembly code only:

[*** Global Interrupts ***/
asm(* CLRC INTM”); /lenable global interrupts
asm(* SETC INTM”); //disable global interrupts

Peripheral Interrupt Expansion (PIE)

Peripheral Interrupt Expansion - PIE

Interrupt Group 1
PIEIFR1 PIEIER1

INT1.x interrupt group |NT1_1/_

INT2.x interrupt grou
: HDIER INTL.2—[0}— -
INT3.x interrupt group . TNTT

INT4.x interrupt group . o
INT5.x interrupt group :
INT6.X interrupt group
INT7.x interrupt group

PIE module for 96 Interrupts

96

INT1.8 ]

S8

28x Core Interrupt logic

INT8.x interrupt group

—_—

Peripheral Interrupts 12x8

INT9.x interrupt group | |'NTL—INT 12
INT10.x interrupt group | | 45 Interrupts YH & H & ; 28x
INT11.x interrupt group =1 || |=| |Core

INT12.x interrupt group :-

INT13 (TINT1/XINT13)
INT14 (TINT2)
NMI
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Interrupt Sources

PIE Registers

PIEIFRX register (x =1to 12)
15-8 7 6 5 4 3 2 1 0
reserved INTX.8[ INTX.7| INTX.6| INTX.5[ INTX.4[ INTX.3| INTX.2 [ INTX.1
PIEIERx register (x=1to 12)
15-8 7 6 5 4 3 2 1 0
reserved INTX.8[ INTX.7| INTX.6| INTX.5[ INTX.4[ INTX.3| INTX.2 [ INTX.1

PIE Interrupt Acknowledge Register (PIEACK)
6 5

15-12 11 10 9 8 7 4 3 2 1 0
reserved PIEACKX
PIECTRL register 15-1 0

PIEVECT

ENPIE

#include “DSP281x_Device.h”
PieCtrIRegs.PIEIFR1.bit.INTx4 = 1;
PieCtrIRegs.PIEIER3.bit.INTx5 = 1; //enable CAPINTL1 in PIE group 3
PieCtrIRegs.PIEACK.all = 0x0004;  //acknowledge the PIE group 3
PieCtrIRegs.PIECTRL.bit.ENPIE = 1; //enable the PIE

/Imanually set IFR for XINT1 in PIE group 1

PIE Interrupt Vector Table

Default Interrupt Vector Table at Reset
Prio| Vector Offset
1 Reset 00 Default Vector Table
5 Int 1 02 Remapped when
6 | Int 2 04 ENPIE=1
7 Int 3 06
8 | Int 4 08 Memory
9| Ints 0A
10 | nt 6 oc
5 Int 7 0E
13 Int 8 10
14 :nt 9 12 PIE Vectors
15 nt 10 14 256 W
16 | Int11 16 T,
17 | Int12 18
18 | Int13 1A
19 | Int14 iCc OX3F FFCO ™,
Dlogint 1E BROM Vectors
64 W
4 | Rtosint 20 0x3F FFFF E
2 | Emuint 22
‘?_’ m'\éléal gg PIE vector generated by config Tool ."’
. User 1-12 283E Used to initialize PIE vectors
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Interrupt Sources

PIE Vector Mapping (ENPIE = 1)
Vector name |PIE vector address PIE vector Description
Not used 0x00 0D00 Reset Vector Never Fetched Here
= INT1 0x00 0D02 INT1 re-mapped below
T re-mapped below
| INT12 0x00 0D18 INT12 re-mapped below
| INT13 0x00 OD1A XINT1 Interrupt Vector
| INT14 0x00 0Di1C Timer2 — RTOS Vector
| Datalog 0x00 0D1D Data logging vector
| ..................
| USER11 0x00 OD3E User defined TRAP
== INT1.1 0x00 0D40 PIEINT1.1 interrupt vector
INT1.8 0x00 OD4E PIEINT1.8 interrupt vector
INT12.1 0x00 ODFO PIEINT12.1 interrupt vector
INT12_8 0x00 ODFE PIEINT12.8 interrupt vector
> PIE vector space - 0x00 0D00 — 256 Word memory in Data space
> RESET and INT1-INT12 vector locations are Re-mapped
» CPU vectors are remapped to 0x00 0DOO in Data space

F281x PIE Interrupt Assignment Table
INTx.8 INTX.7 INTX.6 INTX.5 INTX.4 INTx.3 INTx.2 INTX.1

INT1 WAKEINT TINTO ADCINT XINT2 XINT1 PDPINTB | PDPINTA

INT2 TI1OFINT | TI1UFINT | T1CINT TIPINT | CMP3INT | CMP2INT | CMP1INT

INT3 CAPINT3 | CAPINT2 | CAPINT1 | T20FINT | T2UFINT T2CINT T2PINT

INT4 T3OFINT | T3UFINT | T3CINT T3PINT | CMPGINT | CMP5INT | CMP4INT

INTS CAPINT6 | CAPINTS | CAPINT4 | TAOFINT | TAUFINT | TA4CINT TAPINT

INT6 MXINT MRINT SPITXINTA[SPIRXINTA

INT7

INT8

INT9 ECAN1INT| ECANOINT[SCITXINTB|SCIRXINTB|SCITXINTA[SCIRXINTA

INT10

INT11

INT12
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Interrupt Sources

Device Vector Mapping - Summary

MPNMC = 0 (on-chip ROM memory)

MPNMC = 1 (external memory XINTF)

Reset Vector <0x3F FFCO> = Boot-ROM Code
Flash Entry Point <Ox3F 7FF6 >=LB _c_int00
User Code Start < _c_int00 >

Reset Vector <0x3F FFCO> = _c_int00
User Code Start < _c_int00>

_c_int00:

CALL main(Q)

main()

{ initialization(Q);

}

Initialization ()
{

EALLOW
Load PIE Vectors
Enable the PIEIER
Enable PIECTRL
Enable Core IER
Enable INTM

EDIS

PIE Vector Table
256 Word RAM

0x00 0DOO0 — ODEF
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Interrupt Sources

Interrupt Response and Latency

Interrupt Response - Hardware Sequence

CPU Action Description

Registers — stack 14 Register words auto saved

0 - IFR (bit) Clear corresponding IFR bit

0 - IER (bit) Clear corresponding IER bit

1 -5 INTM/DBGM Disable global ints/debug events
Vector » PC Loads PC with int vector address
Clear other status bits | Clear LOOP, EALLOW, IDLESTAT

Note: some actions occur simultaneously, none are interruptible

T STO

AH AL

PH PL

AR1 ARO

DP ST1
DBSTAT | IER
PC(msw)| PC(lsw)

Interrupt Latency

S Latency

— ext. Internal
interrupt ; interrupt Assumes ISR in
occurs i occurs internal RAM
here i here

| >

T
o ® © © © ® |
. SR
Sync ext.  Recognition Getvector PF1/PF2/D1  Save D2/R1/R2 of i i
}éignal delay (3), SP and place of ISR return ISR gfgﬁggn
alignment (1), inPC instruction  address instruction on next
. (ext. interrupt (3reg. (3 reg. pairs I
interrupt placed in pairs saved) e
only) pipeline saved)

Above is for PIE enabled or disabled

¢ Minimum latency (to when real work occurs in the ISR):
> Internal interrupts: 14 cycles

» External interrupts: 16 cycles

¢ Maximum latency: Depends on wait states, ready, INTM, etc.
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System Initialization

Introduction

This module discusses the operation of the OSC/PLL-based clock module and watchdog timer.
Also, various low power modes, general-purpose digital 1/O ports, and the EALLOW protected

registers will be covered.

Learning Objectives

*

*

*

*

*

Learning Objectives

OSC/PLL Clock Module
Watchdog Timer

Low Power Modes

General Purpose Digital I/O

EALLOW Protected Registers
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Module Topics

Module Topics

SYSEEM INITIAIZATION.......coueiiie e ettt bbb bbb e enes 5-1
T LU TN o o0 5-2
OSCIlAtOr/PLL CIOCK MOTUIE ...ttt bbb 5-3
WALCRAOG TIMET ...ttt bbb et b e bt bt b e bbbt b e et e abe s r b anes 5-5
LOW POWEE IMOGES. ...ttt ettt b bbbt b et bttt b bbb 5-9
General-Purpose DIgItal /O ...ttt s nbe e 5-11
EALLOW ProteCted REGISIEIS. ... eiueitiiieeiieieesteste sttt sttt sttt et bbbt e b b e b e e 5-14
Lab 5: System INITIAlIZALION ........coviiiiee e e e 5-15
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Oscillator/PLL Clock Module

Oscillator/PLL Clock Module

PLLCR @ 0x007021 (lab file: SysCitrl.c)
Watchdog
X1 /CLKIN
Module CLKIN | c28x

2 Core

3 OSCCLK |

E | svscLkout

" PLL
| Clock Module, [HISPCP|  [LOSPcP]
4-bit PLL Select
XF_XPLLDIS HSPCLK LSPCLK
/" | DIV3 [ DIV2 | DIVL | DIVO | Clock Frequency (CLKIN)
0 0 0 0 OSCCLK x1/2 (no PLL) *
0 0 0 1 OSCCLK x1/2
0 0 1 0 OSCCLK x2/2
0 0 1 1 OSCCLK x3/2
E‘IlecsR4 0 1 0 0 OSCCLK x4/2
résservéd 0 1 0 1 OSCCLK x5/2
0 1 1 0 OSCCLK x6/2
0 1 1 1 OSCCLK x7/2
1 0 0 0 OSCCLK x8/2
1 0 0 1 OSCCLK x9/2
L2 0 1 0 OSCCLK x 10/ 2 * default

The OSC/PLL clock module provides all the necessary clocking signals for C28x devices. The
PLL has a 4-bit ratio control to select different CPU clock rates. Two modes of operation are
supported — crystal operation, and external clock source operation. Crystal operation allows the
use of an external crystal/resonator to provide the time base to the device. External clock source
operation allows the internal oscillator to be bypassed, and the device clocks are generated from
an external clock source input on the X1/CLKIN pin. The watchdog receives a clock signal from
OSCCLK. The C28x core provides a SYSCLKOUT clock signal. This signal is prescaled to
provide a clock source for the on-chip peripherals through the high-speed and low-speed
peripheral clock prescalers.
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Oscillator/PLL Clock Module

Peripheral Clock Control Register

PCLKCR @ 0x00701C (lab file: SysCtrl.c)

LSPCLK
A
15 14 13 / 12 11 10 9 8\
reserved eCANA reserved DA SCIB SCIA reserved SEIA
ENCLK ENCLK | ENCLK | ENCLK ENCLK
HSPCLK
AN
7 6 5 4 3 2 1 0
reserved | reserved | reserved | reserved ae reserved 212 2
ENCLK ENCLK | ENCLK

N J
e

Module Enable Clock Bit
0 = disable
1 =enable

The peripheral clock control register allows individual peripheral clock signals to be enabled or
disabled. If a peripheral is not being used, its clock signal could be disabled, thus reducing power
consumption.

High / Low — Speed Peripheral Clock

Prescaler Registers
HISPCP @ 0x00701A / LOSPCP @ 0x00701B (lab file: SysCtrl.c)

15-3 2 1 0
reserved HSPCLK2 | HSPCLK1 | HSPCLKO

15-3 2 1 0
reserved LSPCLK2 | LSPCLK1 | LSPCLKO

H/LSPCLK2 | H/LSPCLK1 | H/LSPCLKO | Peripheral Clock Frequency
0 0 0 SYSCLKOUT /1

0 0 1 SYSCLKOUT / 2 (default HISPCP)
0 1 0 SYSCLKOUT / 4 (default LOSPCP)
0 1 1 SYSCLKOUT /6

1 0 0 SYSCLKOUT /8

1 0 1 SYSCLKOUT /10

1 1 0 SYSCLKOUT /12

1 1 1 SYSCLKOUT /14
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Watchdog Timer

Watchdog Timer

Watchdog Timer

¢ Resets the C28x if the CPU crashes
+ Watchdog counter runs independent of CPU

« If counter overflows, reset or interrupt is
triggered

« CPU must write correct data key sequence to
reset the counter before overflow

¢ Watchdog must be serviced (or disabled)
within ~4.37ms after reset (30 MHz
OSCCLK for 150 MHz device)

¢ This translates into 131,072 instructions!

The watchdog timer provides a safeguard against CPU crashes by automatically initiating a reset
if it is not serviced by the CPU at regular intervals. In motor control applications, this helps
protect the motor and drive electronics when control is lost due to a CPU lockup. Any CPU reset
will revert the PWM outputs to a high-impedance state, which should turn off the power
converters in a properly designed system.

The watchdog timer is running immediately after system power-up/reset, and must be dealt with
by software soon after. Specifically, you have 4.37 ms (for a 150 MHz device) after any reset
before a watchdog initiated reset will occur. This translates into 131,072 instruction cycles,
which is a seemingly tremendous amount! Indeed, this is plenty of time to get the watchdog
configured as desired and serviced. A failure of your software to properly handle the watchdog
after reset could cause an endless cycle of watchdog initiated resets to occur.
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Watchdog Timer

WatCthg T|mer MOdUIG (lab file: SysCitrl.c)

164 111

OSCCLK | 6-Bit [ /32 10 - © O——WDOVERRIDE
Free - 116 101 OO WDPS
1512 Running |18 100 & (WDCR.2-0
Counter -4 Ollg O *
Ll — e
Ji 000° o WDDIS
SReeat ; WDFLAG
Reset 8 - Bit Watchdog O e
Counter nDeéIa))//C e :
CLR
WDRST
Output >
55 + AA Good Key IEI
Detector Bad Key 3, WDENINT
i 37 ) Bad WDCR Key
Watchdog 1]0[1]
Register

Watchdog Period Selection

WDPS FRC C28x timeout
Bits rollover period @ 150 MHz
00x: 1 4,37 ms
010: 2 8.74 ms
011: 4 17.48 ms
100: 8 34.96 ms
101: 16 69.92 ms
110: 32 139.84 ms
111: 64 279.68 ms

¢ WDPS set to 000 after any CPU reset

¢ Watchdog starts counting
is released

immediately after reset

(for OSCCLK =30 MHz = (1/30 MHz) * (512*256) = 4.37 ms)
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Watchdog Timer

WatchdogRTimer Control Register
WD

@ 0x007029 (lab file: SysCtrl.c)

WD Flag Bit
Gets set when the WD causes a reset
« Writing a 1 clears this bit
« Writing a 0 has no effect

15-8 7 6 5 4 3 2 1 0

reserved WDFLAG| WDDIS | WDCHK2| WDCHK1| WDCHKO0| WDPS2 | WDPS1 | WDPS0

Logic Check Bits WD Prescale

Write as 101 or reset Selection Bits
immediately triggered

Watchdog Disable Bit
Write 1 to disable
(Functions only if WD OVERRIDE
bit in SCSR is equal to 1)

Resetting the Watchdog

WDKEY @ 0x007025 (lab file: SysCtrl.c)

15-8 7 6 5 4 3 2 1 0
reserved D7 D6 D5 D4 D3 D2 D1 DO

¢ Allowable write values:
55h - counter enabled for reset on next AAh write
AAh - counter set to zero if reset enabled

& Writing any other value immediately triggers
a CPUreset

¢ Watchdog should not be serviced solely in
an ISR

« If main code crashes, but interrupt continues to
execute, the watchdog will not catch the crash

+ Could put the 55h WDKEY in the main code, and
the AAh WDKEY in an ISR; this catches main
code crashes and also ISR crashes
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Watchdog Timer

WDKEY Write Results

Sequential Value Written
Step to WDKEY Result

1 AAh No action

2 AAh No action

3 55h WD counter enabled for reset on next AAh write
4 55h WD counter enabled for reset on next AAh write
5 55h WD counter enabled for reset on next AAh write
6 AAh WD counter is reset

7 AAh No action

8 55h WD counter enabled for reset on next AAh write
9 AAh WD counter is reset

10 55h WD counter enabled for reset on next AAh write
11 23h CPU reset triggered due to improper write value

System Control and Status Register
SCSR @ 0x007022 (lab file: SysCtrl.c)

WD Override (protect bit)

After RESET - hit gives user ability to disable WD by
setting WDDIS bit=1 in WDCR
« clear only bit and defaults to 1 after reset
0 = protects WD from being disabled by s/w
« bit cannot be set to 1 by s/w (clear-only by writing 1)
1 = (default value) allows WD to be disabled using

WDDIS bit in WDCR

« once cleared, bit cannot set to 1 by s/w \

15-3 2 1 0
reserved WDINTS | WDENINT Ové’gngE
WD Interrupt Status WD Enable Interrupt
(read_only) 0 = WD generates a DSP reset
0 = active 1 = WD generates a WDINT interrupt
1 = not active
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Low Power Modes

Low Power Modes

Low Power Modes

Low Power |CPU Logic  Peripheral = Watchdog PLL/
Mode Clock Logic Clock Clock OSsC
Normal Run on on on on
IDLE off on on on
STANDBY off off on on
HALT off off off off

Low Power Mode Control Register 0
LPMCRO @ 0x00701E (lab file: SysCtrl.c)

000000 =2 OSCCLKs
Qualify before waking 000001 =3 OSCCLKs
from STANDBY mode T :

\ 111111 = 65 OSCCLKS

15-8 7-2 1 0

reserved QUALSTDBY LPM1 LPMO

Low Power Mode Selection

Low Power Mode Entering 00 = Idle (default)

1. Set LPM bits 01 = Standby

2. Enable desired exit interrupt(s) 1x= Halt

3. Execute IDLE instruction

4. The Power down sequence of the hardware
depends on LP mode
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Low Power Modes

Low Power Mode Control Register 1
LPMCR1 @ 0x00701F (lab file: SysCtrl.c)

15 14 13 12 11 10 9 8
CANRXA| SCIRXB [ SCIRXA [ C6TRIP | C5TRIP | CATRIP | C3TRIP | C2TRIP

7 6 5 4 3 2 1 0
CITRIP |TACTRIP|T3CTRIP|T2CTRIP|TICTRIP| WDINT | XNMI XINT1

N v
e

Wake device from
STANDBY mode
0 = disable
1 =enable

Low Power Mode Exit

Exit
Interrupt | RESET Ethlfnal En-abled
Low Power Wake up | Peripheral
Mode Interrupts| Interrupts
|DLE yes yes yes
STANDBY yeS yes no
HALT yes no no

Note: External or Wake up include XINTx, PDPINT, TXCTRIP,
CxTRIP, NMI, CAN, SPI, SCI, WD
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General-Purpose Digital I/O

General-Purpose Digital I/O

GPIO F

GPIOFO
GPIOF1
GPIOF2
GPIOF3
GPIOF4
GPIOF5
GPIOF6
GPIOF7
GPIOF8
GPIOF9

F2812 GPIO Pin Assignment

/
/
/
/
/
/
/
/
/
/

GPIOA10/
GPIOA11/
GPIOA12 /
GPIOA13/
GPIOA14 /
GPIOA15/

/
/
/
/
/
/
/
/
/
/

GPIOF10/
GPIOF11/
GPIOF12/
GPIOF13/
GPIOF14/

GPIO B
PWM1 GPIOBO /
PWM2 GPIOB1 /
PWM3 GPIOB2 /
PWM4 GPIOB3 /
PWM5 GPIOB4 /
PWM6 GPIOB5 /
TIPWM_TICMP GPIOB6 /
T2PWM_T2CMP GPIOB7 /
CAP1_QEP1 GPIOB8 /
CAP2_QEP2 GPIOB9 /
CAP3_QEPI1  GPIOB10/
TDIRA GPIOB11 /
TCLKINA GPIOB12 /
C1TRIP GPIOB13/
C2TRIP GPIOB14 /
C3TRIP GPIOB15 /
GPIO G
SPISIMOA GPIOG4 /
SPISOMIA GPIOG5 /
SPICLKA
SPISTEA
SCITXDA
SCIRXDA
CANTXA
CANRXA
MCLKXA
MCLKRA
MFSXA
MFSRA
MDXA
MDRA
XF

PWM7
PWM8

PWM9

PWM10

PWM11

PWM12
T3PWM_T3CMP
T4PWM_T4CMP
CAP4_QEP3
CAP5_QEP4
CAP6_QEPI2
TDIRB

TCLKINB
CATRIP

C5TRIP

C6TRIP

SCITXDB
SCIRXDB

GPIO D

GPIODO / T1CTRIP_PDPINTA
GPIOD1 / T2CTRIP7 EVASOC
GPIOD5 / T3CTRIP_PDPINTB
GPIOD6 / T4CTRIP7 EVBSOC
GPIOE

GPIOEO / XINT1_XBIO
GPIOE1 / XINT2_ADCSOC
GPIOE2 / XNMI_XINT13

Note: GP10Oxx are pin
functions at reset

GPIO A, B, D, E include
Input Qualification feature

C28x GPIO Register Structure avfie: cpio.c)

A\ 4

GPIO A Mux Control

Register (GPAMUX)

s

_| GPIO A Direction Control |
" Register (GPADIR)

A
A

v

GPI1O B Mux Control

Register (GPBMUX)

s

_| GPIO B Direction Control |
Register (GPBDIR)

Y
A

sng [eusayu|

v

GPI1O D Mux Control

Register (GPDMUX)

s

_| GPIO D Direction Control |
Register (GPDDIR)

Y
A

v

GPIO E Mux Control

Register (GPEMUX)

s

_| GPIO E Direction Control .
" Register (GPEDIR)

a
A

v

GPIO F Mux Control

Register (GPFMUX)

a

v

GPIO F Direction Control |,
Register (GPFDIR)

A
A

v

GPIO G Mux Control

Register (GPGMUX)

a

_| GP10 G Direction Control |,
" Register (GPGDIR)

A
A

Io 0149 |4 0149|[3 0149]|a o149|[g 01d9|[v 0149

GPIO A, B, D, E include Input Qualification feature
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General-Purpose Digital I/O

C28x GPIO Functional Block Diagram
GPXSET
GPXCLEAR
GPXTQGGLE
, Primary
GPXDAT | Peripheral
Out Function
1/0 DAT |
Bit (RIW)| |n |
N MUX Control Bit
0% A1 0 = 1/O Function
”OO DIIR Btit f 1 = Primary Function
= Inpu
12 Ou?put é pin GPxMUX
GPxDIR
15-8 7-0
Some digital 1/0 and GPxQUAL[ reserved [QUALPRD)
peripheral 1/O input 00h no qualification (SYNC to SYSCLKOUT)
signals include an 01h QUALPRD = SYSCLKOUT/2
Input Qualification 02h QUALPRD = SYSCLKOUT/4
feature : : :
FFh QUALPRD = SYSCLKOUT/510

C28x GPIO MUX/DIR Registers gavfile: cpio.)
Address Register Name
0x0070CO GPAMUX GPIO A Mux Control Register
0x0070C1 GPADIR GPIO A Direction Control Register
0x0070C2 GPAQUAL GPIO A Input Qualification Control Register
0x0070C4 GPBMUX GPIO B Mux Control Register
0x0070C5 GPBDIR GPIO B Direction Control Register
0x0070C6 GPBQUAL GPI0 B Input Qualification Control Register
0x0070CC GPDMUX GPIO D Mux Control Register
0x0070CD GPDDIR GPIO D Direction Control Register
0x0070CE GPDQUAL GPI0O D Input Qualification Control Register
0x0070D0 GPEMUX GPIO E Mux Control Register
0x0070D1 GPEDIR GPIO E Direction Control Register
0x0070D2 GPEQUAL GPIO E Input Qualification Control Register
0x0070D4 GPFMUX GPIO F Mux Control Register
0x0070D5 GPFDIR GPIO F Direction Control Register
0x0070D8 GPGMUX GPIO G Mux Control Register
0x0070D9 GPGDIR GPIO G Direction Control Register
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General-Purpose Digital I/O

C28x GPIO Data Registers gab fie: cpio.)
Address Register Name
0x0070EO GPADAT GPIO A Data Register
0x0070E1 GPASET GPIO A Set Register
0x0070E2 GPACLEAR GPIO A Clear Register
0x0070E3 GPATOGGLE GPIO A Toggle Register
0x0070E4 GPBDAT GPIO B Data Register
0x0070E5 GPBSET GPIO B Set Register
0x0070E6 GPBCLEAR GPIO B Clear Register
0x0070E7 GPBTOGGLE GPIO B Toggle Register
0x0070EC GPDDAT GPIO D Data Register
0x0070ED GPDSET GPIO D Set Register
0x0070EE GPDCLEAR GPIO D Clear Register
0x0070EF GPDTOGGLE GPIO D Toggle Register
0x0070F0 GPEDAT GPIO E Data Register
0x0070F1 GPESET GPIO E Set Register
0x0070F2 GPECLEAR GPIO E Clear Register
0x0070F3 GPETOGGLE GPIO E Toggle Register
0x0070F4 GPFDAT GPIO F Data Register
0x0070F5 GPFSET GPIO F Set Register
0x0070F6 GPFCLEAR GPIO F Clear Register
0x0070F7 GPFTOGGLE GPIO F Toggle Register
0x0070F8 GPGDAT GPIO G Data Register
0x0070F9 GPGSET GPIO G Set Register
0x0070FA GPGCLEAR GPIO G Clear Register
0x0070FB GPGTOGGLE GPIO G Toggle Register

I
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EALLOW Protected Registers

EALLOW Protected Registers
EALLOW Protected Registers

Register Name Address Range size (x16)
Device Emulation 0x00 0880 — 0x00 09FF 384
PED FL ASH @iso protected by csv) | Ox00 OAOO — 0x00 OADF 96
Code Security Module| 0x00 OAEO — 0x00 OAEF 16
PIE Vector Table 0x00 0DOO — 0x00 ODFF 256
PF1 eCAN 0x00 6000 — 0x00 60FF | 256 (128x32)
PED System Control 0x00 7010 — 0x00 702F 32
GPIO Mux 0x00 70C0O — 0x00 70DF 32
while(1) /I dummy loop - wait for an interrupt
i\sm(" EALLOW"); /I enable EALLOW protected register access
SysCtrIRegs.WDKEY=0x55; // watchdog enabled for reset on next OxAA write
asm(" EDIS"); /l disable EALLOW protected register access

}

Note: “SysCtrIRegs.WDKEY=0xAA" is located in an interrupt service routine

Lab 5: Procedure - System Initialization

¢ LABS files have been provided as a starting point
¢ Modify LABS files to:

Part 1
+ Disable the watchdog - clear WD flag, disable watchdog, WD
prescale =1

+ Setup the clock module — PLL = x5, HISPCP = /1, LOSPCP =/4,
low-power modes to default values, enable all module clocks

« Setup control register — DO NOT clear WD OVERRIDE bit, WD
generate a DSP reset

« Setup shared /O pins — set all GPIO pins to GPIO function (e.g. a
"0" setting for GPIO function, and a “1" setting for peripheral
function)

Part 2
« Initialize peripheral interrupt expansion (PIE) vectors

¢ Build, debug, and test your code using Code
Composer Studio
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Lab 5: System Initialization

Lab 5: System Initialization
» Objective

The objective of this lab is to perform the processor system initialization by applying the
techniques discussed in module 5. Additionally, the peripheral interrupt expansion (PIE) vectors
will be initialized and tested using the information discussed in the previous module. This
initialization process will be used again in the module 6 analog-to-digital converter lab, and the
module 7 event manager lab. The system initialization for this lab will consist of the following:

o Disable the watchdog — clear WD flag, disable watchdog, WD prescale = 1

e Setup the clock module — PLL = x5, HISPCP =/1, LOSPCP = /4, low-power modes to
default values, enable all module clocks

e Setup control register — DO NOT clear WD OVERRIDE bit, WD generate a DSP reset

e  Setup shared I/O pins — set all GPIO pins to GPIO function (e.g. a "0" setting for GP1O
function, and a “1” setting for peripheral function.)

The first part of the lab exercise will setup the system initialization and test the watchdog
operation by having the watchdog cause a reset. In the second part of the lab exercise the PIE
vectors will be added and tested by using the watchdog to generate an interrupt. This lab will
make use of the DSP281x C-code header files to simplify the programming of the device, as well
as take care of the register definitions and addresses. Please review these files, and make use of
them in the future, as needed.

» Procedure

Create Project File

Note: LAB 5 files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.

1. Create a new project called Lab5.pjt in C:\C28x\LABS\LAB5 and add the
following files to it:

Main_5.c Labcfg.cmd

Lab.cdb DSP281x_Headers_BI10S.cmd
User 5 6_7.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c

DSP281x_GlobalVariableDefs.c

Note that include files, such as DSP281x_Device.hand Lab.h, are automatically
added at project build time.
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Project Build Options

2. We need to setup the search path to include the peripheral register header files. Click:
Project - Build Options..

Select the Compiler tab. In the Preprocessor Category, find the Include Search
Path (-1) box and enter:

. -\DSP281x_headers\include

This is the path for the header files. Then select OK to save the Build Options.

Modify Memory Configuration

3. Open and inspect the user linker command file User_5 6_7.cmd. Notice that the
section “codestart” is being linked to a memory block named BEGIN_HO. The
codestart section contains code that branches to the code entry point of the project. The
bootloader must branch to the codestart section at the end of the boot process. Recall that
the "Boot to HO" bootloader mode branches to address 0x3F8000 upon bootloader
completion.

Modify the configuration file 1ab . cdb to create a new memory block named
BEGIN_HO: base = 0x3F8000, length = 0x0002, space = code. Uncheck the “create
a heap In memory” box. You will also need to modify the existing memory block
HOSARAM to avoid any overlaps with this new memory block.

Setup System Initialization

4. Modify SysCtrl .c to implement the system initialization as described in the objective
for this lab.

5. Open and inspect Gpio.c. Notice that the shared I/O pins have been set to the GPIO
function. (Note: In Main_5.c do not edit the “main loop” section. This section will be
used to test the watchdog operation.) Save your work.

Build and Load

6. Clickthe ““Build button and watch the tools run in the build window. The output
file should automatically load.

7. Under Debug on the menu bar click “Reset CPU™.

8. Under Debug on the menu bar click “Go Main”. You should now be at the start of
Main().
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Run the Code — Watchdog Reset

9. Place the cursor on the first line of code in main() and set a breakpoint by right
clicking the mouse key and select Toggle breakpoint. Notice that line is
highlighted with a red dot indicating that the breakpoint has been set.

10. Single-step your code into the “main loop” section and watch the lines of code
execute. If you don’t want to see each line execute, place the cursor in the “main
loop™ section (on the asm(** NOP’”); instruction line) and right click the mouse key
and select Run To Cursor. This is the same as setting a breakpoint on the selected
line, running to that breakpoint, and then removing the breakpoint.

11. Run your code for a few seconds by using the <F5> key, or using the Run button on the
vertical toolbar, or using Debug > Run onthe menu bar. After a few seconds halt
your code by using Shift <F5>, or the Halt button on the vertical toolbar. Where did your
code stop? Are the results as expected? If things went as expected, your code should be
in the “main loop”™.

12. Modify the InitSysCtrl() function to enable the watchdog (WDCR). This will
enable the watchdog to function and cause a reset. Save the file and click the “Bui 1d”
button. Then reset the DSP by clicking on Debug - Reset CPU. Under Debug on
the menu bar click ““Go Main”.

13. Single-step your code off of the breakpoint.

14. Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should stop at the breakpoint.

Setup PIE Vector for Watchdog Interrupt

The first part of this lab exercise used the watchdog to generate a CPU reset. This was tested
using a breakpoint set at the beginning of main(). Next, we are going to use the watchdog
to generate an interrupt. This part will demonstrate the interrupt concepts learned in the
previous module.

15. Add the following files to the project:

PieCtrl 5 6 7 8 9.c

Defaultlsr 5 6 7.c

Check your files list to make sure the files are there.

16. In Main_5.c, add code to call the InitPieCtrl () function. There are no passed
parameters or return values, so the call code is simply:

InitPieCtri(Q;

17. Using the “PIE Interrupt Assignment Table” shown in the previous module find the
location for the watchdog interrupt, “WAKEINT””.
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18. Modify main() to do the following:

enable the "WAKEINT" interrupt in the PIE (Hint: use the PieCtrlIRegs structure)
enable core INT1 (IER register)
enable global interrupts (INTM bit)

19. In SysCtr1 . c modify the system control and status register (SCSR) to cause the
watchdog to generate a WAKEINT rather than a reset.

20. Open and inspect Defaultlsr_5 6 7.c. This file contains interrupt service
routines. The ISR for WAKEINT has been trapped by an emulation breakpoint contained
in an inline assembly statement using “ESTOPQ”. This gives the same results as placing
a breakpoint in the ISR. We will run the lab exercise as before, except this time the
watchdog will generate an interrupt. If the registers have been configured properly, the
code will be trapped in the ISR.

21. Modify the configuration file Lab . cdb to setup the PIE vector for the watchdog
interrupt. Click on the plus sign (+) to the left of Schedul ing and again on the plus
sign (+) to the left of HW1 — Hardware Interrupt Service Routine
Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate the
interrupt location for the watchdog. Right click, select Properties, and type
_WAKEINT_ISR (with a leading underscore) in the function field. Click OK and save
all updates.

Build and Load

22. Save all changes to the files and click the ““Bui 1d” button. Then reset the DSP, and
then “Go Main™.

Run the Code — Watchdog Interrupt

23. Place the cursor in the “main loop” section, right click the mouse key and select
Run To Cursor.

24. Run your code. Where did your code stop? Are the results as expected? If things went
as expected, your code should stop at the “ESTOPOQ” instruction in the WAKEINT ISR.

End of Exercise

Note: By default, the watchdog timer is enabled out of reset. Code in the file
CodeStartBranch.asm has be configured to disable the watchdog. This can be
important for large C code projects (ask your instructor if this has not already been
explained). During this lab exercise, the watchdog was actually re-enabled (or disabled
again) in the file SysCtrl _c.
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Analog-to-Digital Converter

Introduction

This module explains the operation of the analog-to-digital converter. The system consists of a
12-bit analog-to-digital converter with 16 analog input channels. The analog input channels have
a range from 0 to 3 volts. Two input analog multiplexers are used, each supporting 8 analog input
channels. Each multiplexer has its own dedicated sample and hold circuit. Therefore, sequential,
as well as simultaneous sampling is supported. Also, the ADC system features programmable
auto sequence conversions with 16 results registers. Start of conversion (SOC) can be performed
by an external trigger, software, or an Event Manager event.

Learning Objectives

Learning Objectives

¢ Understand the operation of
Analog-to-Digital converter

¢ Show how to use the Analog-to-
Digital converter to capture data
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Analog-to-Digital Converter

Analog-to-Digital Converter

ADC Module Block Diagram (cascaded mode)
Analog MUX
ADCINAQ —
ADCINAL—{pux S Result MUX —
A A —{ RESULTO |
- —RESULT1 ]
ADCINA7 — ; S 12-bit A/D LT
MUX| “|Converter .
ADCINBO —| | )
ADCINB1 —*MUX S/H Result .
: B B soc| |Eoc Select —[RESULTI5
ADCINB7 — Autosequencer
t—‘ MAX_CONV1
CHSELOO (state 0)
CHSELDOL1 (state 1)
CHSELO2 (state 2)
Software CHSELO3 (state 3)
EVA ;
EVB .
Ext Pin (ADCSOC) CHSEL 15 (state 15)
Start Sequence
Trigger

A DC MO d u | e B | oC k D| ag rfam (Dual-Sequencer mode)
Analog MUX
ADCINAQ — Result MUX —
ADCINAL—{pmux|  [sH —{RESULTO]
A A 2-bit A/ RESULT1
ADCINA7 — Ll D Result )
f l\%'J_'X || Converter o .
ADCINBO —] elect RESULT/
) Sequencer B
ADCINBL —Mux SIH Arbiter i
: B B socy/ soc/ —>LRESUL T8/
ADCINB7 —* EOC1 EOC2 RESULT9
Z—i—é SEQL1 SEQ2 Result :
: Autosequencer | | Autosequencer | [Select| peqr T1g]
[ MAX_CONV1 |i=1[ MAX_Conv2 |
CHSELOO (state 0) CHSELDOS8 (state 8)
CHSELO1 (state 1) CHSELQ9 (state 9)
CHSELDO2 (state 2) |[===[| CHSEL10 (state 10)
Software c c Software
EVA . : EVB
Ext Pin CHSELO?7 (state 7) CHSEL15 (state 15)
(ADCSOC) Start Sequence Start Sequence
Trigger Trigger
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Analog-to-Digital Converter

ADC Module

¢ 12-bit resolution ADC core
Sixteen analog inputs (range of 0 to 3V)
¢ Two analog input multiplexers
+ Up to 8 analog input channels each
¢ Two sample/hold units (for each input mux)
¢ Sequential and simultaneous sampling modes

¢ Autosequencing capability - up to 16
autoconversions

« Two independent 8-state sequencers
« “Dual-sequencer mode”
« “Cascaded mode”

¢ Sixteen individually addressable result registers

¢ Multiple trigger sources for start-of-conversion
« External trigger, S/W, and Event Manager events

*

F2812 ADC Clocking Example

CLKIN PLLCR SYSCLKOUT HISPCP HSPCLK
30 MHz 150 MHz 150 MHz
( ) | DIV ( ) HSECLK ( ) R
bits |_, To CPU bits
1010b 000b
PCLKCR.ADCENCLK =1 7\

¥

ADCTRL3 FCLK ADCTRL1 ADCCLK
ADCCLKPS| (25 MHz) : (25 MHz) To ADC
o »| CPS bit > pipeline
0011b Ob ADCTRL1 sampling
FCLK = HSPCLK/(2*ADCCLKPS) ADCCLK = ACQ_Ps|  Window
FCLK/(CPS+1) bits
0111b

sampling window = (ACQ_PS + 1)*(1/ADCCLK)

Important: ADCCLK can be a maximum of 25 MHz!
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Analog-to-Digital Converter Registers

Analog-to-Digital Converter Registers

(lab file: Adc.c)

Register Address  Description
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Analog-to-Digital Converter

ADC Control Register 1 - Upper Byte

ADCTRL1 @ 0x007100 (lab file: Adc.c)

ADC Module Reset Acquisition Time Prescale (S/H)
0 = no effect Value = (binary+1)
1 = reset (set back to 0 * Time dependent on the “Conversion
by ADC logic) Clock Prescale” bit (Bit 7 “CPS™)
15 14 13 12 11 10 9 8

reserved RESET |SUSMOD1|SUSMODO| ACQ_PS3 | ACQ_PS2 | ACQ_PS1 | ACQ_PS0

Emulation Suspend Mode

00 = [Mode 0] free run (do not stop)

01 = [Mode 1] stop after current sequence
10 = [Mode 2] stop after current conversion
11 = [Mode 3] stop immediately

ADC Control Register 1 - Lower Byte

ADCTRL1 @ 0x007100 (lab file: Adc.c)

Continuous Run Sequencer Mode
0 = stops after reaching 0 = dual mode
end of sequence 1 = cascaded mode

1 = continuous (starts all over
again from “initial state™)

7 6 5 4 3 2 1 0

CPS | CONT_RUN | SEQ1 OVRD | SEQ _CASC| reserved |reserved| reserved| reserved

Conversion Prescale Sequencer Override
0=CLK/1 (continuous run mode)
1=CLK/2 0 = sequencer pointer resets to “initial state”
at end of MAX_CONVnN
1 = sequencer pointer resets to “initial state”
after “end state”
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Analog-to-Digital Converter

ADC Control Register 2 - Upper Byte
ADCTRL2 @ 0x007101 (lab file: Adc.c)
EVB SOC EVA SOC
(ceiscaded r_node only) SEQ1 Mask Bit
0 = no action 0 = cannot be started
1 =start by EVB . by EVA trigger
signal Start Conversion (SEQ1) i
_ . . 1 = can be started
0 = clear pending SOC trigger by EVA trigger
1 = software trigger-start SEQ1 Y 99
15 14 13 12 11 10 9 8
EVB_SOC INT_ENA_| INT_MOD EVA_SOC_
_SEQ RST_SEQL1 [SOC_SEQ1| reserved SEQ1 SEQ1 reserved SEQ1
Reset SEQ1 Interrupt Enable (SEQ1)
0 = no action 0 = interrupt disable
1 = immediate reset 1 = interrupt enable Interrupt Mode (SEQ1)
SEQL1 to “initial state” 0 = interrupt every EOS
1 = interrupt every other EOS

ADCTRL2 @ 0x007101 (lab file: Adc.c)

External SOC (SEQ1)
0 =no action
1 = start by signal

from ADCSOC pin

ADC Control Register 2 - Lower Byte

EVB SOC

SEQ2 Mask bit

0 = cannot be started
by EVB trigger

Start Conversion (SEQZ) 1 = can be started
(dual-sequencer mode only) by EVB trigger
0 = clear pending SOC trigger
1= softvlvare trigger-start SEQ2
7 6 5 4 3 2 1 0
EXT_SOC INT_ENA_[INT_MOD EVB_SOC_
"SEo1 RST_SEQ2|SOC_SEQ2| reserved SEQ2 SEQ2 reserved SEQ2

—

Reset SEQ2 Interrupt Enable (SEQ2)

0 =no action 0 = interrupt disable

1 = immediate reset 1 = interrupt enable
SEQ?2 to “initial state”

Interrupt Mode (SEQ2)
0 = interrupt every EOS
1 = interrupt every other EOS
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ADC Control Register 3

ADCTRL3 @ 0x007118 (lab file: Adc.c)

ADC Reference ADC Bandgap  ADC Power Down

Power Down Power Down (except Bandgap & Ref.)
0 = powered down 0 = powered down 0 = powered down
1 = powered up 1 = powered up 1 = powered up
15-8 7 6 5
reserved ADCRFDN | ADCBGND | ADCPWDN
4 3 2 1 0
ADCCLKPS3 ADCCLKPS2| ADCCLKPS1 ADCCLKPS0|SMODE_SEL

Y

ADC Clock Prescale  Sampling Mode Select
0 = sequential sampling mode
1 = simultaneous sampling mode

Maximum Conversion Channels Register
ADCMAXCONV @ 0x007102 (lab file: Adc.c)

+ Bit fields define the maximum number of autoconversions (binary+1)

Cascaded Mode

AL
- N
rerved | MAX_ | MAX_ | MAX_ | MAX_ | MAX_ | MAX_ | MAX_
CONV 2 2|CONV 2 1|CONV2 0|CONV1 3|CONV1 2|CONV1 1|CONV10
N J J
Y Y

SEQ2 B Dual Mode —_ SEQ1

+ Autoconversion session always starts with the “initial state”
and continues sequentially until the “end state”, if allowed

SEQ1 SEQ2 Cascaded '
Initial state | CONV0O0O CONV08 CONVO00
End state CONVO07 CONV15 CONVi15
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Analog-to-Digital Converter

0x007103
0x007104
0x007105

0x007106

Bits 15-12

Bits 11-8

Bits 7-4

ADC Input Channel Select Sequencing
Control Register gabfie: adc.c)

Bits 3-0

CONVO03

CONVO02

CONVO01

CONVO00

ADCCHSELSEQ1

CONVO07

CONVO06

CONVO05

CONVO04

ADCCHSELSEQ2

CONV11

CONV10

CONVO09

CONVO08

ADCCHSELSEQ3

CONV15

CONV14

CONV13

CONV12

ADCCHSELSEQ4
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Analog-to-Digital Converter

Example — Sequencer “ Start/Stop” Operation

Example - Sequencer “Start/Stop”
Operation

N \\ﬁmm

EVA
PWM

Lol ly Vo Vo Vs Iyl ly  V, VLV,

System Requirements:
*Three autoconversions (I, 1,, 1) off trigger 1 (Timer underflow)
*Three autoconversions (V;, V,, V;) off trigger 2 (Timer period)

Event Manager A (EVA) and SEQ1 are used for this example
with sequential sampling mode

Example - Sequencer “Start/Stop”
Operatl ON (continued)
* MAX_CONV1 is set to 2 and Channel Select Sequencing Control Registers are set to:

Bits —» 15-12 118 7-4 3-0
0x007203 [V, [ 1, [ 1, [1,| ADCCHSELSEQ1
0x007104 [x | X | V5|V, | ADCCHSELSEQ2

« Once reset and initialized, SEQ1 waits for a trigger
« First trigger three conversions performed: CONVOO (I,), CONVO01 (1,), CONV02 (1;)

« MAX_CONV1 value is reset to 2 (unless changed by software)

« SEQ1 waits for second trigger

« Second trigger three conversions performed: CONVO03 (V,), CONV04 (V,), CONVO05 (V,)
« End of second auto conversion session, ADC Results registers have the following values:
RESULTO I, || RESULT3 Vv,

RESULTL 1, | RESULT4 V,
RESULT2 1, | RESULT5 V,

— User can reset SEQL1 by software to state CONVO0O0 and repeat same trigger 1, 2 session
« SEQ1 keeps “waiting™ at current state for another trigger
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ADC Conversion Result Buffer Regi

ster

(lab file: Adc.c)
(Total of 16 Registers)

15 14 13 12 11 10 9 8 7 6 5

ADC Conversion Result Buffer Regoister

ADCRESULTO @ 0x007108 throu ADCRESULT15 @ 0x

7117

4 3 2 1 0

MSB

LSB

With analog input OV to 3V, we have:

analog volts converted value RESUL Tx
3.0 FFFh 1111]1111]1111]0000
1.5 7FFh 0111/1111]1111J0000
0.00073 1h 0000]0000|0001|0000
0 Oh 0000|0000]0000]0000

C28x - Analog-to-Digital Converter
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Numerical Format

How do we Read the Result?
Integer format

XIXIXIXIXIXIXIXIXIXIXIX] o[ o[ 0] 0] RESULTx

15 bit shift right —— 0
[o]oJoJoJoJoJofoJofolofofofoTofo IXIXIXIXIXIXIXIXIXIXIXIXT [ 1 1 | Acc

XIXIXIXAX XX XXX XX Data Mem

Example: read RESULTO register
#include "'DSP281x_Device.h"

void main(void)

{
uintl6 value; // unsigned

value = AdcRegs.ADCRESULTO >> 4;
3

What About Signed Input Voltages?

Example: -1.5 V<V, <+15V R o
V, R N . N C28x
1.5V b b Input
R V v Ch. x
1) Add 1.5 volts to analog input:
2) Subtract “1.5” from digital result: ADCLO
#include "'DSP281x_Device.h* GND
#define offset OxO07FF

void main(void)

{
intl6é value; // signed

value = (AdcRegs.ADCRESULTO >> 4) — offset;

3
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Lab 6: Analog-to-Digital Converter
» Objective

The objective of this lab is to apply the techniques discussed in module 6 and to become familiar
with the programming and operation of the on-chip analog-to-digital converter. The DSP will be
setup to sample a single ADC input channel at a prescribed sampling rate and store the
conversion result in a buffer in the DSP memory. This buffer will operate in a circular fashion,
such that new conversion data continuously overwrites older results in the buffer.

Lab 6: Analog-to-Digital Converter otz
Sampling

GND +33V GPIOAl

LY -

° ° ADC data
CPU copies result memory
connector .
wire RESULTO to buffer during -
ADC ISR §
[<5)
ADCINAO -
. 3
[
S
Q.

! GP Timer 2 triggers

ADC SOC every E
i 20 ps (50 kHz)

GP Timer 2

Recall that there are three basic ways to initiate an ADC start of conversion (SOC):
1. Using software
a. SOC_SEQ1/SOC_SEQ2 bhit in ADCTRL2 causes an SOC upon completion of the current
conversion (if the ADC is currently idle, an SOC occurs immediately)
2. Automatically triggered on user selectable event manager conditions
a. GP Timer 1 or 2 (EVA); 3 or 4 (EVB) underflow (e.g. timer count = 0)
b. GP Timer 1or2 (EVA); 3 or 4 (EVB) period match
c. GP Timer1or2 (EVA); 3 or 4 (EVB) compare match
3. Externally triggered using a pin
a. ADCSOC pin
b. CAP3pin - EVA; CAP6 pin - EVB (capture unit #3 / capture unit #6 edge detection)

One or more of these methods may be applicable to a particular application. In this lab, we will
be using the ADC for data acquisition. Therefore, one of the GP timers (GP Timer 2) will be
configured to automatically trigger an SOC at the desired sampling rate (SOC method 2b above).
The ADC end-of-conversion interrupt will be used to prompt the CPU to copy the results of the
ADC conversion into a results buffer in memory. This buffer pointer will be managed in a
circular fashion, such that new conversion results will continuously overwrite older conversion
results in the buffer. In order to generate an interesting input signal, the code also alternately
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toggles a GPIO pin (GPIOA1) high and low in the ADC interrupt service routine. The ADC ISR
will also toggle LED DS2 on the eZdsp™ as a visual indication that the ISR is running. This pin
will be connected to the ADC input pin, and sampled. After taking some data, Code Composer
Studio will be used to plot the results. A flow chart of the code is shown in the following slide.

Lab 6: Code Flow Diagram of2)

« watchdog disable

* SCSR register

» software stack ADC interrupt

« core interrupts l

* shared pins

* GPIO setup ADC ISR
1 * context save

« read the ADC result
Main Loop  write to result buffer

Timer2 period match loop: B loop ?gggfet »H:g g%ﬁfgrpﬂ?,'“ter

+ send interrupt on « context restore

every conversion . ;
re-enable interr
« setup a results buffer e-enable interrupts

ADC Initialization
« convert channel A0 on )

in memory * return
Timer 2 Initialization return

« clear counter

« set period register

« set to trigger ADC on —
period match

« set the clock prescaler

« enable the timer

Notes

Program performs conversion on ADC channel A0 (ADCINAO pin)

General Purpose Timer 2 is used to auto-trigger the conversions at a 50kHz sampling rate
Data is continuously stored in a circular buffer

GPIOAL pin is also toggled in the ADC ISR

ADC ISR will also toggle the eZdsp™ LED DS2 as a visual indication that it is running

Procedure

Project File

Note: LABG files have been provided as a starting point for the lab and need to be

completed. DO NOT copy files from a previous lab.

1. Aproject named Lab6.pjt has been created for this lab. Open the project by clicking
onProject > Open.. and look in C:\C28x\LABS\LABG6. All Build Options
have been configured like the previous lab. The files used in this lab are:
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Main_6.c Labcfg.cmd

Lab.cdb DSP281x_Headers _B10S.cmd
User 5 6 _7.cmd CodeStartBranch.asm
SysCtrl._c Gpio.c
DSP281x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr 5 6 7.c Adc.c

Ev 6.c

Setup ADC Initialization and Enable Core/PIE Interrupts

2.

In Main_6.c add code to call InitAdc() and InitEv() functions. The
InitEv() function is used to configure Timer 2 to trigger the ADC at a 50 kHz rate.
Details about the event manager will be discussed in the next module.

Edit Adc.c to implement the ADC initialization as described above in the objective for
the lab by configuring the following registers: ADCTRL1, ADCTRL2, ADCMAXCONV
and ADCCHSELSEQ1. (Set ADC for cascaded sequencer mode, CPS = CLK/1, and
acquisition time prescale = 8 * (1/ADCCLK).

Using the “PI1E Interrupt Assignment Table” find the location for the
ADC interrupt, “ADCINT”” and fill in the following information:

PIE group #: # within group:

This information will be used in the next step.

Modify the end of Adc.c to do the following:

enable the "ADCINT" interrupt in the PIE (Hint: use the PieCtrlIRegs structure)
enable core INT1 (IER register)

Open and inspect Defaultlsr_5 6 7.c. This file contains the ADC interrupt
service routine.

Modify the configuration file Iab . cdb to setup the PIE vector for the ADC interrupt.
Click on the plus sign (+) to the left of Schedul ing and again on the plus sign (+) to
the left of HWI — Hardware Interrupt Service Routine Manager. Click
the plus sign (+) to the left of PIE INTERRUPTS. Locate the interrupt location for the
ADC (use the information from step #4). Right click, select Properties, and type
_ADCINT_ISR (with a leading underscore) in the function field. Click OK and save all
updates.

Build and Load

8. Save all changes to the files and click the ““Bui ld” button.

9. Reset the DSP, and then ““Go Main”.
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Run the Code

10.

11.

In Main_6.c place the cursor inthe “main loop™ section, right click on the
mouse key and select Run To Cursor.

Open a memory window to view some of the contents of the ADC results buffer. The
address label for the ADC results buffer is AdcBuf.

Note:

For the next set of steps “VREFLO” must be connected to “GND”. Using a connector
wire provided, connect “VREFLO” (pin # P9-18) to “GND” (pin # P9-17). Exercise
care when connecting any wires, as the power to the eZdsp™ is on, and we do not
want to damage the eZdsp™! Details of pin assignments can be found in Appendix A.

12.

13.

14.

15.

Using another connector wire provided, connect the ADCINAO (pin # P9-2) to “GND”
(pin # P9-1) on the eZdsp™. Then run the code again, and halt it after a few seconds.
Verify that the ADC results buffer contains the expected value of 0x0000.

Adjust the connector wire to connect the ADCINAO (pin # P9-2) to “+3.3V” (pin # P2-
45) on the eZdsp™. Then run the code again, and halt it after a few seconds. Verify that
the ADC results buffer contains the expected value of OXOFFF.

Adjust the connector wire to connect the ADCINAO (pin # P9-2) to IOPAL (pin # P8-10)
on the eZdsp™. Then run the code again, and halt it after a few seconds. Examine the
contents of the ADC results buffer (the contents should be alternating 0x0000 and
OXOFFF values). Are the contents what you expected?

Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: View > Graph -> Time/Frequency.. and setthe following values:

Start Address AdcBuf

Acquisition Buffer Size 50

Display Data Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Time Display Unit us

Select OK to save the graph options.

16.

Recall that the code toggled the IOPA1 pin alternately high and low. (Also, the ADC
ISR is toggling the LED DS2 on the eZdsp™ as a visual indication that the ISR is
running). If you had an oscilloscope available to display IOPAL, you would expect to see
a square-wave. Why does Code Composer Studio plot resemble a saw-tooth wave?
What is the signal processing term for what is happening here?
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17. Recall that the program toggled the IOPAL pin at a 50 kHz rate. Therefore, a complete
cycle (toggle high, then toggle low) occurs at half this rate, or 25 kHz. We therefore
expect the period of the waveform to be 40 ps. Confirm this by measuring the period of
the saw-tooth wave using the graph (you may want to enlarge the graph window using
the mouse). The measurement is best done with the mouse. The lower left-hand corner
of the graph window will display the X and Y axis values. Subtract the X-axis values
taken over a complete waveform period.

Using Real-time Emulation

Real-time emulation is a special emulation feature that offers two valuable capabilities:

1. Windows within Code Composer Studio can be updated at up to a 10 Hz rate while the
DSP is running. This not only allows graphs and watch windows to update, but also
allows the user to change values in watch or memory windows, and have those
changes affect the DSP behavior. This is very useful when tuning control law
parameters on-the-fly, for example.

2. It allows the user to halt the DSP and step through foreground tasks, while specified
interrupts continue to get serviced in the background. This is useful when debugging
portions of a realtime system (e.g., serial port receive code) while keeping critical
parts of your system operating (e.g., commutation and current loops in motor control).

We will only be utilizing capability #1 above during the workshop. Capability #2 is a
particularly advanced feature, and will not be covered in the workshop.

18. Reset the DSP, and enable real-time mode by selecting:
Debug -> Real-time Mode

19. A message box will appear. Select YES to enable debug events. This will set bit 1
(DGBM bhit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit.
When the DGBM bit is set to “0”, memory and register values can be passed to the host
processor for updating the debugger windows.

20. The memory and graph windows displaying AdcBuf should still be open. The connector
wire between ADCINADO (pin # P9-2) and IOPAL (pin # P8-10) should still be connected.
In real-time mode, we would like to have our window continuously refresh. Click:

View > Real-time Refresh Options..

and check “Global Continuous Refresh”. Alternately, we could have right
clicked on each window individually and selected “Continuous Refresh”.

Note: “Global Continuous Refresh” causes all open windows to refresh at the
refresh rate. This can be problematic when a large number of windows are open, as
bandwidth over the emulation link is limited. Updating too many windows can cause the
refresh frequency to bog down. In that case, either close some windows, or disable
global refresh and selectively enable “Continuous Refresh” for individual
windows of interest instead.
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21. Run the code and watch the windows update in real-time mode. Are the values updating
as expected?

22. Fully halting the DSP when in real-time mode is a two-step process. First, halt the
processor with Debug - Halt. Then uncheck the ““Real-time mode” to take
the DSP out of real-time mode.

23. So far, we have seen data flowing from the DSP to the debugger in realtime. In this step,
we will flow data from the debugger to the DSP.

e Open and inspect Defaultlsr_5_6_7.c. Notice that the global variable
DEBUG_TOGGLE is used to control the toggling of the GPIOAL pin. This is the pin
being read with the ADC.

¢ Highlight DEBUG_TOGGLE with the mouse, right click and select “Add to
Watch Window”. The global variable DEBUG_TOGGLE should now be in the
watch window with a value of “1”.

¢ Run the code in real-time mode and change the value to “0”. Are the results shown
in the memory and graph window as expected? Change the value back to “1”. As
you can see, we are modifying data memory contents while the processor is running
in real-time (i.e., we are not halting the DSP nor interfering with its operation in any
way)!

End of Exercise
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Event Manager

Introduction

This module explains how to generate PWM waveforms using the timers and compare units.
Also, the capture units, quadrature encoder pulse circuit, and the hardware deadband units will be
discussed. All devices of the C28x family have two event managers, EVA and EVB. These two
event managers are identical to each other in terms of functionality. Register mapping and bit
definitions are also identical, with the exception of naming conventions and register addresses.
Therefore, for simplicity, only the functionality of EVA will be explained.

Learning Objectives

Learning Objectives

¢ Pulse Width Modulation (PWM) Review

¢ Generate PWM with the Event Manager:
+ General-Purpose Timer
+ Compare Units

¢ Explain other Event Manager functions:
+ Capture Units
+ Quadrature Encoder Pulse (QEP) Circuit

Note: Two identical Event Manager (EVA and EVB) modules
are available. For simplicity, only EVA will be explained.
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Event Manager

Event Manager Block Diagram (EVA)
Resetl T PIE
2
+——{ EV Control Registers / Logicl':_, ;%'{:KIS’;‘Q{ TDIRA
GP Timer 1 Compare Output Logic————» T1IPWM_T1CMP
GP Timer 1
@ Compare Unit 1 PWM Circuits| Output Logic _,EWM%
g Compare Un?t 2 » PWM Circuits| Output Logic [ FWM3
s Compare Unit 3 PWM Circuits| Output Logic [ FWM3
GP Timer 2 Compare Output Logic———— - T2PWM_T2CMP
GP Timer 2
CLK+— QEP e
DIR «—Circuit
. I CAP1/QEP1
Capture Units CAP2/QEP2
CAP3/QEPI1

The Event Manager (EVA and EVB) consist of the following blocks:
General-Purpose Timers

Full Compare Units

Capture Units

Quadrature Encoder Pulse (QEP) circuit

Each block will be discussed in detail in this module. First, pulse width modulation (PWM) will
be reviewed.
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PWM Review

What is Pulse Width Modulation?

¢ PWMis a scheme to represent a signal
as a sequence of pulses

+ fixed carrier frequency
+ fixed pulse amplitude

+ pulse width proportional to instantaneous
signal amplitude

+« PWM energy = original signal energy

¢ Differs from PAM (Pulse Amplitude
Modulation)

+ fixed width, variable amplitude

Pulse width modulation (PWM) is a method for representing an analog signal with a digital
approximation. The PWM signal consists of a sequence of variable width, constant amplitude
pulses which contain the same total energy as the original analog signal. This property is
valuable in digital motor control as sinusoidal current (energy) can be delivered to the motor
using PWM signals applied to the power converter. Although energy is input to the motor in
discrete packets, the mechanical inertia of the rotor acts as a smoothing filter. Dynamic motor
motion is therefore similar to having applied the sinusoidal currents directly.
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PWM Signal Representation

t
Original Signal

/7 same areas (energy) 7
]t
-

e e s || f——]  t

PWM representation PAM representation

Why Use PWM in Digital Motor Control?

¢ Desired motor phase currents or voltages are
known

¢ Power switching devices are transistors
« Difficult to control in proportional region
« Easy to control in saturated region

¢ PWMis adigital signal = easy for DSP to output

DC Supply DC Supply
P uumun
' . PWM
Desired PWM approx.
signal to of desired
motor phase signal
Unknown Gate Signal Gate Signal Known with PWM
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Asymmetric PWM Waveform

Period ................................................................

Compare

Counter

Towm ! Temp PN
(active high) T— Caused by Period match
(toggle output in Asym mode only)

- Caused by Compare match
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Symmetric PWM Waveform

Compare

Counter

Tewm /Teme PiN
(active high)

s 1 1 11 1 1 L1 1

General Purpose Timer Full Compare Units
- »PWM1
Period A Compare »PWM2
» P
Compare Town/ Teme PN < Compare VIV
— Counter Compare :DVWVMg

Each C28x event manager (EVA and EVB) is capable of generating five independent PWM
signals. Up to two different carrier frequencies can be independently selected as follows:

4 PWM @ freql, 1 PWM @ freg2
Of course, frequency 1 need not differ from frequency 2.
In addition, three PWM signals may be generated which are compliments of three of the above
listed five (i.e. full compare units). This forms three complimentary pairs of PWM, and is

intended for use as input to a three-phase power converter.

Two different compare types exist on each C28x event managers (EVA and EVB) for generating
PWM signals:

1. General Purpose Timer Compares
2. Compare Units

Each uses one of the general purpose timers for clocking the PWM calculation, and these timers
will be covered next.
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General-Purpose Timers

General-Purpose Timers (EVA)

Resetl T PIE
2
«——{EV Control Registers / Logict " Aota TOIRA

Output L0gi e TIPWM_T1CMP

v

GP Timer 1 Compare

GP Timer 1
@ Compare Unit 1 PWM Circuits| Output Logic _.EWM%
ﬂ Compare Unit 2 *» PWM Circuits| Output Logic _.EWME
& Compare Unit 3 PWM Circuits| Output Logic [ EWMS

Output Logi Cl—————ee T2PWM_T2CMP

A\ 4

GP Timer 2 Compare

GP Timer 2
CLK «— QEP
DIR «—Circuit
. I CAP1/QEP1
Capture Units CAP2/QEP2
CAP3/QEPI1

The GP Timers provide a time base for the operation of the compare units, and associated PWM
circuits to generate PWM outputs. Additionally, they provide a time base for the operation of the
quadrature encoder pulse (QEP) circuit (GP Timer 2 for EVA, and GP Timer 4 for EVB only)
and the capture units. The GP Timers can also be used to generate a sampling period in a control
system.
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General-Purpose Timer Block Diagram

(EVA)
Internal TXCMPR . 15-0
(HSPCLK) -
TPS2-0 Shadowed
Clock [J|TXxCON.10-8 Compare
Prescaler Register
T — " —
TXCNT .15-0
M - .
| 16 - Bit Timer Compare Output TXPWM_
External )li 1 Counter I_’ LOM_' Logic TXCMP
QEP ' —
TCLKS 1-0 -
ONICE
Register
Shadowed
Note: x=1o0r 2 TxPR.15-0

The TxPR period register holds the user specified counting period. TXPR is automatically loaded
from the period register buffer on a counter underflow, which is defined as TXCNT=0. This
allows for on-the-fly timer period changes. Note that the period register buffer is static in that if
no change in the current period value is desired, one is not required to write the same value to the
buffer on successive timer cycles.

The clocking signal for each GP Timer can be individually selected as either the internal CPU
clock, or the external TCLKINA/B pin. In addition, the QEP outputs can be selected for clocking
GP Timers. The external TDIRA/B pin is used to determine the counting direction only when the
timer is in the directional-up/down counting mode. The prescale counter is used to divide the
clocking signal down to the desired frequency, when necessary.

Each GP Timer has its own set of interrupts, all of which are individually maskable:

1. TxPINT - period match interrupt. Flag is set when the timer counter matches the value in
the timer period register.

2. TXUFINT - underflow interrupt. Flag is set when the timer counter becomes zero.

3. TxOFINT - overflow interrupt. Flag is set when the timer counter matches OFFFFh.

Note: Maximum frequency for External or QEP is CLKIN/4
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GP Timer Modes of Operation

The C28x event managers (EVA and EVB) each have two General Purpose Timers (GP Timers).
Each timer has four different modes of operation. The most simple is the Stop/Hold mode, where
the operation of the timer stops and holds at its current state. The timer counter, its compare
output, and its prescale counter all remain unchanged in this mode. Two of the remaining three
modes are commonly used in PWM generation, the exception being the directional up/down
counting mode. This mode allows the use of external signals for both count clocking and
direction, and is also employed for recording encoder counts from the on-chip QEP units.

Continuous-Up Counting

(Used for Asymmetric PWM Waveforms)

Continuous-Up Counting Mode

This example:
TxCON.3-2 =00 (reload TXCMPR on underflow)

TxXPR =3
TXCMPR =1 (initially)
Prescale = 1

+ Seamless counting continues
+ Up count period is TxPR+1

CPU writesa 2 to
compare reg. buffer

—_— > ——
1

TXCNT Reg.

(active high)

anytime here TXCMPR=2 is loaded here

TXPWM/TXCMP : | 1] L ]

The procedure for GP Timer Continuous-Up Counting is as follows:

User sets bit 6 of TXCON register high to initiate counting
Counting begins on next rising clock edge
1% count is a “Zero” (no increment)

Count up until match with period register
If counter > period counts up to FFFFh
On next rising clock edge:

— Counter resets to zero

— Counting continues seemlessly
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Continuous-Up/Down Counting

Continuous-Up/Down Counting Mode

(Used for Symmetric PWM Waveforms)

This example:

TxCON.3-2 = 01 (reload TXCMPR on underflow or period match)
TxPR =3 o
TXCMPR = 1 (initially) + Seamless up/down ljepe_tltlon
Brescalonn + Up/down count period is 2*TxPR

TxCMPR load TXCMPR loads TxCMPR loads
withal ; : with a 2 / withal

TXCNT Reg.

TXPWM/TXCMP | f '| | |

(active high)

CPUCLK I_I_I_I_I_I_I_I_I_I_I_I_I_I_I_l_I_I_I_I_I_I_I_I_I_I_I_I_I_I_

The procedure for GP Timer Continuous-Up/Down Counting is as follows:
User sets bit 6 of TXCON register high to initiate counting
Counting begins on next rising clock edge
1% count is a “Zero” (no increment)
Count up until match with period register then backwards to zero

If counter > period counts up to FFFFh then resets to zero and start as if the initial counter value
were zero
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PWM Outputs and Interrupts

Generated Outputs and Interrupts

PWM period #2

1€

! - .
CPU Changes 1 New Period is

. Auto-loaded on H
Period Reg. Buffer 1 !
anytime here Underflow here

'
PWM period #1 |

A\

Comp2
Compl

Timer Counter
Value

(active high) __

|
|
|
1 .
TXCMP/TXPWM 1 ! ' ; ;
| H
|
|
|
|
|

TXCMP/TXPWM | '
(active low) . ! . ! )

Compare Ints t {

Period Ints i P | |

Underflow Ints t | t t t

GP Timer Registers

As was the case with the period register, buffering is present for each timer compare register.
Software writes a value to the compare register buffer, from which the TXCMPR register is
automatically loaded on one of three user selected events:

1. timer underflow (TXCNT = 0)
2. timer underflow or period match
3. immediately

The event selection is made using bits 2 and 3 of the TXCON register, and allows for on-the-fly
compare value changes. Note that the compare register buffer is static in that if no change in the
current compare value is desired, one is not required to write the same value to the buffer on
successive timer cycles.

Each GP Timer unit has its own Symmetric/Asymmetric PWM Waveform Generator, which as its
name implies, is capable of generating two types of PWM. The waveform generator uses the
timer compare signal as an input, and outputs a PWM signal to the Output Logic Unit. The
output logic lets the user select the polarity of the TTL signal on the TXPWM/TXCMP pin (e.g.
active high or low) or alternately force the pin either high or low. The selection is made using
bits 0-1, and 2-3 of the GPTCONA register for timers 1 and 2 respectively (EVA), and bits 0-1,
and 2-3 of the GPTCONB register for timers 3 and 4 respectively (EVB).
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GP Timer Registers (aofie: ev.c)
Register Address Description

/| GPTCONA  0x007400 General Purpose Timer Control Register A
TICNT 0x007401 Timer 1 Counter Register
T1CMPR 0x007402 Timer 1 Compare Register Buffer
T1PR 0x007403 Timer 1 Period Register Buffer

EVA < T1CON 0x007404 Timer 1 Control Register

T2CNT 0x007405 Timer 2 Counter Register
T2CMPR 0x007406 Timer 2 Compare Register Buffer
T2PR 0x007407 Timer 2 Period Register Buffer

> T2CON 0x007408 Timer 2 Control Register
GPTCONB  0x007500 General Purpose Timer Control Register B
T3CNT 0x007501 Timer 3 Counter Register
T3CMPR 0x007502 Timer 3 Compare Register Buffer
T3PR 0x007503 Timer 3 Period Register Buffer

EVB < T3CON 0x007504 Timer 3 Control Register

TACNT 0x007505 Timer 4 Counter Register
T4CMPR 0x007506 Timer 4 Compare Register Buffer
T4PR 0x007507 Timer 4 Period Register Buffer

\_| T4ACON 0x007508 Timer 4 Control Register

EXTCONA 0x007409 / EXTCONB 0x007509 ;Extension Control Register

GP Timer Control Register A (EVA)
GPTCONA @ 0x007400 (lab file: Ev.c)

Upper Byte:

Timer 2 Compare Trip Enable Timer 1 Compare Trip Enable
T2CTRIPE (if EXTCONA[0]=1)  T1CTRIPE (if EXTCONA[0]=1)

0 = disable 0 = disable
1= enable 1= enable
15 14 13 12 11 10-9 8-7
T T
reserved | T2STAT | TISTAT T2TOADC T1TOADC
Il Il
\—v—/
GP Timer Status (read-only) ADC start by event of GP Timer x
0 = counting down 00: no event starts ADC
1 = counting up 01: setting of underflow interrupt flag

10: setting of period interrupt flag
11: setting of compare interrupt
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GP Timer Control Register A (EVA)

Lower Byte:

GPTCONA @ 0x007400 (lab file: Ev.c)

Timer 2 Compare Output Enable
T2CMPOE (if EXTCONA[0]=1)

0 = disable (hi-2)

I

1= enable

Compare Output Enable
(reserved when EXTCONA[0]=1)

0 = all disable (hi-impedanced)

1 =all enable

TXPWM/TxCMP Output Pin Conditioning

Timer 1 Compare Output Enable
T1CMPOE (if EXTCONA[0]=1)

0 = disable (hi-2)
1 = enable

1-0

T1PIN

00: forced

low

01: active low
10: active high

11: forced

high

Timer Control Register (EVA)
T1CON @ 0x007404 / T2CON @ 0x007408 (lab file: Ev.c)

Upper Byte:
15 14 13 12 11 10 9 8
FREE SOFT reserved |TMODE1TMODEOQ| TPS2 TPS1 TPSO
%/—/

Emulation Halt Behavior

00 = stop immediately

01 = stop at end of period
1x = free run (do not stop)

Count Mode Select
00 = stop/hold
01 = continuous-up/down
10 = continuous-up
11 = directional-up/down

Timer Clock Prescale

000:+1
001:+2
010:+4
011:+8

100: + 16
101: + 32
110: + 64
111:+128
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Timer Control Register (EvA)
T1CON @ 0x007404 / T2CON @ 0x007408 (lab file: Ev.c)

Lower Byte: Timer Compare Operation Enable
0 = disable
- Enabl Timer Clock Source 1= enalble— Period Register Select
imer Enable .

) ] 00 = internal (HSPCLK) 0 = use own per. reg.
0= t!mer disable 01 = external TCLKIN pin 1 =use Timer 1 per. reg
1 =timer enable 10 = reserved (bit reserved in TLCON)

11 = QEP ‘
/—/%
7 6 5 4 3 2 1 0
T2SWT1 |TENABLE| TCLKS1 | TCLKSO | TCLD1 | TCLDO |TECMPR |SELT1PR

| %/—/

Start with Timer 1 Compare Register Reload Condition

0 = use own TENABLE 00 = when counter equals zero (underflow)

1 =use Timer 1 TENABLE 01 = when counter equals zero or period reg
(bit reserved in TLICON) 10 = immediately

11 = reserved

Extension Control Register A (EVA)
EXTCONA @ 0x007409 (lab file: Ev.c)

Independent Compare

QEP Index Enable Output Enable Mode
0 = disable 0 = disable
1 =enable 1 =enable
15-4 3 2 1 0

reserved EVSOCE QEPIE QEPIQUAL INDCOE

EV Start-of-Conversion CAP3/QEPI Index

Output Enable Qualification Mode
0 = disable 0 = off
1 =enable 1=on
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Asymmetric and Symmetric PWM via General Purpose
Timer Compares

PWM switching frequency:

The PWM carrier frequency is determined by the value contained in the period register TxPR,
and the frequency of the clocking signal. The value needed in the period register is:

Asymmetric PWM:  period register = (SW'tCh'ng perlodj 1

timer period

switching period
2(timer period)

Symmetric PWM:  period register =

Notice that in the symmetric case, the period value is half that of the asymmetric case. This is
because for up/down counting, the actual timer period is twice that specified in the period register
(i.e. the timer counts up to the period register value, and then counts back down).

PWM resolution:

The PWM compare function resolution can be computed once the period register value is
determined. The largest power of 2 is determined that is less than (or close to) the period value.
As an example, if asymmetric was 1000, and symmetric was 500, then:

Asymmetric PWM: approx. 10 bit resolution since 2'° = 1024 ~ 1000

Symmetric PWM: approx. 9 bit resolution since 2° = 512 ~ 500

PWM duty cycle:

Duty cycle calculations are simple provided one remembers that the PWM signal is initially
inactive during any particular timer period, and becomes active after the (first) compare match
occurs. The timer compare register should be loaded with the value as follows:

Asymmetric PWM: TXCMPR = (100% - duty cycle) * TXxPR

Symmetric PWM: TxCMPR = (100% - duty cycle) * TxPR

Note that for symmetric PWM, the desired duty cycle is only achieved if the compare register
TXCMPR contains the computed value for both the up-count compare and down-count compare
portions of the timer period.

7-16 C28x - Event Manager



General-Purpose Timers

GP Timer Compare PWM Exercise

GP Timer Compare PWM Exercise

Symmetric PWM is to be generated as follows:
¢ 50 kHz carrier frequency
e Timer counter clocked by 10 ns CPU clock
e Use the +1 prescale option
¢ 25% duty cycle initially
e Use GP Timer Compare 1 with PWM output active high
e T2PWM/T2CMP pins forced low

Determine the initialization values needed in the GPTCONA,
T1CON, T1PR, and TICMPR registers
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Compare Units

Compare Units

Compare Units (EVA)

Reset

T PIE

<—-| EV Control Registers / Logicl':_,

GP Timer 1 Compare

GP Timer 1

A 4

2 TCLKINA / TDIRA
ADC Start

Output Logic————  » TIPWM_T1CMP

Compare Unit 1

PWM Circuits

Output LOgiC e P\\/ M2

Data Bus

Compare Unit 2

Y

PWM Circuits

Output LogiC ey p\vM2

vy VvV VY

Compare Unit 3

GP Timer 2 Compare

PWM Circuits

Output Logic I—

i

GP Timer 2

Capture Units

Output Logic|

————T2PWM_T2CMP

CLK<— QE
DIR «—Circl

i

Pl
uit
CAP1/QEP1
CAP2/QEP2
CAP3/QEPI1

Each event manager (EVA and EVB) has three compare units. Each compare unit has two
associated PWM outputs. They have capabilities beyond the GP timer compares, and feature
programmable hardware deadband. The time base for the compare units is provided by

GP timer 1 for EVA, and GP timer 3 for EVB.

TICNT.15-0

GP Timer 1
Counter

Compare Units Block Diagram (EvA)

ACTRA .11-0

Compare
Action Control

Shadowed

Register

DBTCONA.11-2

Compare
Logic

Compare
Register

Shadowed

CMPRx.15-0

Dead Band Output
Units I Logic I PWMy, y+1

COMCONA .9

Note: x =1, 2,

FCOMPOE

3;y=135
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Compare Unit Registers

Compare Unit Registers qabiie: ev.)
Register  Address Description
4 COMCONA 0x007411 Compare Control Register A
ACTRA 0x007413 Compare Action Control Register A
EVA< DBTCONA 0x007415 Dead-Band Timer Control Register A
CMPR1 0x007417 Compare Register 1
CMPR2 0x007418 Compare Register 2
9 CMPR3 0x007419 Compare Register 3
( COMCONB 0x007511 Compare Control Register B
ACTRB 0x007513 Compare Action Control Register B
< DBTCONB 0x007515 Dead-Band Timer Control Register B
EVB CMPR4 0x007517 Compare Register 4
CMPR5 0x007518 Compare Register 5
\ CMPR6 0x007519 Compare Register 6
EXTCONA 0x007409 / EXTCONB 0x007509 ;Extension Control Register

Compare Control Register (EVA)
COMCONA @ 0x007411 (lab file: Ev.c)

,—l

CMPRX reload condition
00 =when TICNT =0

10 = immediately
11 = reserved

Upper Byte:

Compare Enable  space \Vector Piwm  Full Compare Output Enable
0 = disable 0 = SV disable (reserved when EXTCONA[0]=1)
1 =enable 1 =SV enable 0 = all disable (hi-impedanced)

1 =all enable
15 14 13 12 11 10 9 8
CENABLE| CLD1 CLDO |SVENABLE|ACTRLD1 ACTRLDO
%/—/

01 =when TICNT=0o0r T1PR

| |

ACTRA reload condition PDPINT Status

00=when TICNT =0 0=low
01=when TICNT=00r TIPR 1= high
10 = immediately

11 = reserved
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Compare Control Register (EVA)
COMCONA @ 0x007411 (lab file: Ev.c)

Lower Byte:
Full Compare 2 Full Compare 2
Output Enable Trip Enable
FCMP20OE C2TRIPE
(if EXTCONA[0]=1) (if EXTCONA[0]=1)
0 = disable 0 = disable
1 =enable 1 =enable

3

reserved

Full Compare 3

Full Compare 1

Full Compare 3 Full Compare 1

Output Enable Output Enable Trip Enable Trip Enable
FCMP30OE FCMP10E C3TRIPE C1TRIPE
(if EXTCONA[0]=1) (if EXTCONA[0]=1) (if EXTCONA[0]=1) (if EXTCONA[0]=1)
0 = disable 0 = disable 0 = disable 0 = disable
1 =enable 1 = enable 1 =enable 1 =enable

Extension Control Register A (EVA)
EXTCONA @ 0x007409 (lab file: Ev.c)

QEP Index Enable

Independent Compare
Output Enable Mode

0 = disable 0 = disable
1 =enable 1 =enable
15-4 3 2 1 0
reserved EVSOCE QEPIE QEPIQUAL

EV Start-of-Conversion

Output Enable
0 = disable
1 =-enable

CAP3/QEPI Index
Qualification Mode
0 = off
1=on
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Compare Action Control Register (EVA)
ACTRA @ 0x007413 (lab file: Ev.c

Basic Space Vector Bits
can write as 0 when SV not in use

15 14 13 12 11 10 9 8
SVRDIR D2 D1 DO CMPG6ACT1| CMPGACTO| CMP5ACT1| CMP5ACTO
7 6 5 4 3 2 1 0

CMP4ACT1 | CMP4ACTO0| CMP3ACT1| CMP3ACTO0| CMP2ACT1| CMP2ACTO0| CMP1ACT1| CMP1ACTO

Pin Action on Compare: CMPYACT1-0

00 force low
) o 01 active low
SV Rotation Direction 10 active high

can write as 0 when SV not in use

11 forced high
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Hardware Dead-Band (Compare Units only)

Motivation for Dead-Band

supply rail

(1

Gate Signals are
Complementary PWM

to motor phase

L

L

¢ Transistor gates turn on faster than they shut off
¢ Short circuit if both gates are on at same time!

Dead-band control provides a convenient means of combating current shoot-through problems in
a power converter. Shoot-through occurs when both the upper and lower gates in the same phase
of a power converter are open simultaneously. This condition shorts the power supply and results
in a large current draw. Shoot-through problems occur because transistors open faster than they
close, and because high-side and low-side power converter gates are typically switched in a
complimentary fashion. Although the duration of the shoot-through current path is finite during
PWM cycling, (i.e. the closing gate will eventually shut), even brief periods of a short circuit
condition can produce excessive heating and over stress in the power converter and power supply.
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Dead-Band Functionality (EvA)

Clck _— | — | — HSPCLK —»|—Prescaler

PHX _T T__T | edge — )
i i detect 4-bit
DT _I_I I_I U_I_I reset CoUNtEr
oren, | 1L |
DTPHX_ _! ? i ._I ,_ o

; 4-bit period
N NG DBTCONA . 11-8

dead time

DTPH,
Asymmetric PWM Example DTPH,

Two basic approaches exist for controlling shoot-through: modify the transistors, or modify the
PWM gate signals controlling the transistors. In the first case, the opening time of the transistor
gate must be increased so that it (slightly) exceeds the closing time. One way to accomplish this

is by adding a cluster of passive components such as resistors and diodes in series with the
transistor gate, as shown in the next figure.

by-pass diode

K
PWM
signal /\/\é\/\/

Shoot-through control via power circuit modification

The resistor acts to limit the current rise rate towards the gate during transistor opening, thus
increasing the opening time. When closing the transistor however, current flows unimpeded from
the gate via the by-pass diode and closing time is therefore not affected. While this passive
approach offers an inexpensive solution that is independent of the control microprocessor, it is
imprecise, the component parameters must be individually tailored to the power converter, and it
cannot adapt to changing system conditions.

The second approach to shoot-through control separates transitions on complimentary PWM
signals with a fixed period of time. This is called dead-band. While it is possible to perform
software implementation of dead-band, the C28x offers on-chip hardware for this purpose that
requires no additional CPU overhead. Compared to the passive approach, dead-band offers more
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precise control of gate timing requirements. In addition, the dead time is typically specified with
a single program variable that is easily changed for different power converters or adapted on-line.

DBTCONA @ 0x007415 (lab file: Ev.c

DB Timer Period

15 14 13

Dead-Band Timer Control Re%;ister (EVA)

dead time = DB period * DB prescaler * CPUCLK period

um

reserved | reserved| reserved| reserved | DBT3 DBT2 DBT1

DBTO

7 6 5 4 3 2

1 0

EDBT3 | EDBT2 | EDBT1 | DBTPS2| DBTPS1| DBTPSO

reserved | reserved

DB Timer Enable DB Timer Prescaler

0 = disable 000=1 100=16
1 =enable 001=2 101=32
010=4 110=32
011=8 111=32

Each compare unit has its own dead-band timer, but shares the clock prescaler unit and the dead-
band period with the other compare units. Dead-band can be individually enabled for each
compare unit by setting bits 5, 6, and 7 in the DBTCONA register for EVA and DBTCONB for

EVB.

The minimum achievable non-zero dead time is one CPU clock cycle (e.g. 50 ns), obtained by
choosing the x/1 prescale option, and setting the DB period to 1 (i.e. DBTCONXx.11-8 = 0001,

where x is A for EVA and x is B for EVB).
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Power Drive Protection

The PDPINTX is a safety feature that is provided for the safe operation of systems such as power
converters and motor drives. PDPINTx can be used to inform the monitoring program of motor
drive abnormalities such as overvoltage, over-current, and excessive temperature rise. If the
PDPINTXx interrupt is unmasked, all PWM output pins will be put in the high-impedance state
immediately after the PDPINTx pin is driven low. An interrupt will also be generated.

Power Drive Protection

¢ Interrupt latency may not protect hardware when responding to over
current through ISR software

+ PDPINTX has a fast, clock independent logic path to high-impedance
the PWM output pins

+ Two options per EV: #1) global trip using PDPINTX signal
#2) independent trips using TRIP signals

core [ ey [T,
L PWM1

——
EXTCON Logic PWM2
*w_T1CTRIP clock sync. PWM3

“~a_ CITRIP - —’PWM4
C2TRIP —
EXTCONA.O = 1 PWM5

C3TRIP — 2
T2CTRIP | PWM6

T2PWM
PDPINTA EXTCONA.O = 0 ——
enable

nw-HCUHCO Z=7TU
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Capture Units

Resetl T PIE
2
«—{EV Control Registers / Logicl':_> L%%KIS’;‘Q{ TDIRA
GP Timer 1 Compare Output Logic————» T1IPWM_T1CMP
GP Timer 1
@ Compare Unit 1 PWM Circuits| Output Logic _,EWM%
m ; N o in ——>PWM3
o Compare Un!t 2 PWM Circuits| Output Logic [, p\wna
< Compare Unit 3 PWM Circuits| Output Logic 3 EWMS
GP Timer 2 Compare Output Logic——————T2PWM_T2CMP
GP Timer 2
CLK+— QEP e
MUX DIR «—Circuit
] < I CAP1/QEP1
< > Capture Units < CAP2/QEP2
< CAP3/QEPI1

Each event manager (EVA and EVB) has three capture units, and each is associated with a
capture input pin. Each capture unit can choose GP timer 1 or 2 for EVA, and GP timer 3 or 4 for
EVB as its time base. The value of GP timer 1 or 2 (EVA) and GP timer 3 or 4 (EVB) is captured
and stored in the corresponding 2-level-deep FIFO stack when a specified transition is detected
on a capture input pin.
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Capture Units

@ | L

Timer
\l( Trigger \—S

Timestamp
Values

¢ Capture units timestamp transitions on
capture input pins

¢ Three capture units (per event manager) -
each associated with a capture input pin

The capture units allow time-based logging of external TTL signal transitions on the capture input
pins. Each C28x event manager (EVA and EVB) has three capture units, two of which are shared
with the quadrature encoder interface circuitry (discussed in next section).

Capture unit #3 on EVA and capture unit #6 on EVB can be configured to trigger an A/D
conversion that is synchronized with an external event. There are several potential advantages to
using the capture for this function over the ADCSOC pin associated with the ADC module. First,
the ADCSOC pin is level triggered, and therefore only low to high external signal transitions can
start a conversion. The capture unit does not suffer from this limitation since it is edge triggered
and can be configured to start a conversion on either rising edges, falling edges, or both. Second,
if the ADCSOC pin is held high longer than one conversion period, a second conversion will be
immediately initiated upon completion of the first. This unwanted second conversion could still
be in progress when a desired conversion is needed. In addition, if the end-of-conversion ADC
interrupt is enabled, this second conversion will trigger an unwanted interrupt upon its
completion. These two problems are not a concern with the capture unit. Finally, the capture unit
can send an interrupt request to the CPU while it simultaneously initiates the A/D conversion.
This can yield a time savings when computations are driven by an external event since the
interrupt allows preliminary calculations to begin at the start-of-conversion, rather than at the
end-of-conversion using the ADC end-of-conversion interrupt. The ADCSOC pin does not offer
a start-of-conversion interrupt. Rather, polling of the ADCSOC bit in the control register would
need to be performed to trap the externally initiated start of conversion.
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Some Uses for the Capture Units

¢ Synchronized ADC start with capture event
¢ Measure the time width of a pulse
¢ Low speed velocity estimation from incr. encoder:

Problem: At low speeds, calculation of . - X
.. < Mk Ak
speed based on a measured position Vi AL I
change at fixed time intervals produces

large estimate errors

Alternative: Estimate the speed using a measured time
interval at fixed position intervals

Signal from one ‘
quadrature

ty - G encoder channel
— x|

AX
V) ~

Capture Units Block Diagram (EvA)

(TieNT.15-0)  (T2CNT .15-0)

GP Timer 1 GP Timer 2
Counter Counter

!J CAPCONA . 14 -12

(CAPCONA . 10 - 9]\ MUX Enabl CAP3TOADC
nable CAPCONA . 8
.\ ADC Start
Edge | (CAP 3)
Detect 3
@—f— CAP1,2,3
2-Level Deep RS Edge Select
FIFO Can latch on:
CAPXFIFO Status CAPRESET * rising edge
(capoona. 15] '
- » falling edge
* both
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Capture Unit FIFO Operation

¢ CPU can read both upper and lower FIFO registers
separately; Standard approach is to read upper, but
lower can be read

value #2
value #1 read by
LOST! CPU
unknoer value #1' value #1' value #ZI value #3'
unknowj unknowj value #2 value #3 unknowj
Capture 1st 2nd 3rd CPU
Unit Capture Capture Capture read
Reset

Capture Units Registers

EVA<

EVB<

Capture Units Registers (abfie: ev.c)

Register Address Description

(| CAPCONA  0x007420 Capture Control Register A
CAPFIFOA  0x007422 Capture FIFO Status Register A
CAP1FIFO  0x007423 Two-Level Deep FIFO 1 Stack
CAP2FIFO  0x007424 Two-Level Deep FIFO 2 Stack
CAP3FIFO  0x007425 Two-Level Deep FIFO 3 Stack
CAP1FBOT  0x007427 Bottom Register of FIFO 1
CAP2FBOT  0x007428 Bottom Register of FIFO 2

\_| CAP3FBOT  0x007429 Bottom Register of FIFO 3

/| CAPCONB  0x007520 Capture Control Register B
CAPFIFOB  0x007522 Capture FIFO Status Register B
CAP4FIFO 0x007523 Two-Level Deep FIFO 4 Stack
CAP5FIFO  0x007524 Two-Level Deep FIFO 5 Stack
CAP6FIFO  0x007525 Two-Level Deep FIFO 6 Stack
CAP4FBOT  0x007527 Bottom Register of FIFO 4
CAPS5FBOT  0x007528 Bottom Register of FIFO 5
CAP6FBOT  0x007529 Bottom Register of FIFO 6

EXTCONA 0x007409 / EXTCONB 0x007509 ;Ext. Cntrl Reg.
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The capture unit interrupts offer immediate CPU notification of externally captured events. In
situations where this is not required, the interrupts can be masked and flag testing/polling can be
used instead. This offers increased flexibility for resource management. For example, consider a
servo application where a capture unit is being used for low-speed velocity estimation via a
pulsing sensor. The velocity estimate is not used until the next control law calculation is made,
which is driven in real-time using a timer interrupt. Upon entering the timer interrupt service
routine, software can test the capture interrupt flag bit. If sufficient servo motion has occurred
since the last control law calculation, the capture interrupt flag will be set and software can
proceed to compute a new velocity estimate. If the flag is not set, then sufficient motion has not
occurred and some alternate action would be taken for updating the velocity estimate. As a
second example, consider the case where two successive captures are needed before a
computation proceeds (e.g. measuring the width of a pulse). If the width of the pulse is needed as
soon as the pulse ends, then the capture interrupt is the best option. However, the capture
interrupt will occur after each of the two captures, the first of which will waste a small number of
cycles while the CPU is interrupted and then determines that it is indeed only the first capture. If
the width of the pulse is not needed as soon as the pulse ends, the CPU can check, as needed, the
CAPFIFOA register for EVA and CAPFIFOB register for EVB to see if two captures have
occurred, and proceed from there.

Capture Control Register (EvA)
CAPCONA @ 0x007420 (lab file: Ev.c)

Capture Reset (not latched)

0 = clear all result FIFO’s and Uonltd:’_’ Ct;)lntrol A_DC Start
CAPFIFO register = disable 0 = no action
1 =no action 1 =enable 1 =CAP3INT flag
I
15 14-13 12 11 10 9 8
T
CAPRES CAPQEPN CAP3EN | reserved | CAP3TSEL |CAP12TSEL|CAP3TOADC
————— I,—/ - ~ J
Unit 1 & 2 Control i
00 = disable Timer Select
01 = enable for capture 0 =GP Timer 2
10 = reserved 1=GP Timer1
11 = enable for QEP
-6 5-4 3-2 1-0
T T t T
CAP1EDGE CAP2EDGE CAP3EDGE reserved
| | | |

Edge Detection Control

00 = no detection 10 = falling edge
01 = rising edge 11 = both edges
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Capture FIFO Status Register (EVA)

CAPFIFOA @ 0x007422 (lab file: Ev.c)

15-14 13;12 11;10 9;8 7-0
reserved CAP3FIFO CAP2FIFO CAP1FIFO reserved
1 1 1

) FIFOx Status:
CAPXFIFO bits are 00 = t
automatically adjusted on a = emply

capture or FIFO read 01 = one entry
10 = two entries

11 = three entries attempted,
1st entry lost
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Quadrature Encoder Pulse (QEP)

Quadrature Encoder Pulse (QEP)

Resetl T PIE
2
+—{ EV Control Registers / Logicl':_> L%%KIS’;‘Q{ TDIRA
GP Timer 1 Compare Output Logic————» T1IPWM_T1CMP
GP Timer 1
@ Compare Unit 1 PWM Circuits| Output Logic _,EWM%
g Compare Un?t 2 » PWM Circuits| Output Logic _,Ewyz
g Compare Unit 3 PWM Circuits| Output Logic _,' PWM6
GP Timer 2 Compare Output Logic—— > T2PWM_T2CMP
GP Timer 2
CLK *=1 QEP |
DIR «=—{Circuit
F N
. t CAP1/QEP1
Capture Units CAP2/QEP2
CAP3/QEPI1

The QEP circuit, when enabled, decodes and counts the quadrature encoded input pulses on pins
CAP1/QEP1 and CAP2/QEP2 in EVA, and CAP4/QEP3 and CAP5/QEP4 in EVB. The QEP
circuit can be used to interface with an optical encoder to get position and speed information from
a rotating machine. When the QEP circuit is enabled, the capture function on CAP1 and CAP2 in
EVA, and CAP4 and CAPS5 in EVB pins is disabled. The QEP time base is provided by

GP timer 2 in EVA and GP timer 4 in EVB.
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Quadrature Encoder Pulse (QEP)

Incr

What is an Incremental Quadrature
Encoder?

A digital (angular) position sensor

photo sensors spaced 6/4 deg. apart
slots spaced 0 deg. apart 0/4

I light source (LED)
\ = g

emental Optical Encoder Quadrature Output from Photo Sensors

(A,

Ch. A

Ch.B l |

How is Position Determined from
Quadrature Signals?

Position resolution is 6/4 degrees.
_ (00) (11 increment decrement
%)= I(1o()l()01) counter /\ counter
| 1 |
| 1 |

: i Quadrature

l Decoder @

! State Machine
| /
| @

®
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Quadrature Encoder Pulse (QEP)

QEPIE
GP Timer 2 [+—

Incremental Encoder Connections (EVA)

Ch. A

Ch.B

Index

QEP CAP1/QEP1
decoder CAP2/QEP2
logic
CLK DIR =
L
o
[se]
QEPIQUAL %

GP Timer 2 selected as
pulse counter

Timer Prescaler
bypassed (i.e. Prescale

always 1)

QEP Initialization with GP Timer 2 (EVA)

o Select Timer 2 for Capture numberl and 2
CAPCONA . 9 =0 (for Timer 2)

TXCNT register

Optionally pre-load Timer 2 counter

Select directional-up/down mode for Timer 2
TXCON.12-11=11
Set T2PER register for desired timer rollover

e.g. set the number of ticks per revolution

Enable QEP operation

CAPCONA .14-13=11
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Extension Control Register A (EVA)
EXTCONA @ 0x007409 (lab file: Ev.c)

Independent Compare

QEP Index Enable Output Enable Mode
0 = disable 0 = disable
1 =enable 1 =enable
15-4 3 2 1 0
reserved EVSOCE QEPIE QEPIQUAL INDCOE

EV Start-of-Conversion CAP3/QEPI Index

Output Enable Qualification Mode
0 = disable 0 = off
1 =enable 1=on
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Lab 7: Event Manager

Lab 7: Event Manager
» Objective

The objective of this lab is to apply the techniques discussed in module 7 and become familiar
with the programming and operation of the Event Manager and its interrupts. General-Purpose
Timer 1 and Compare 1 will be setup to generate a 2 kHz, 25% duty cycle symmetric PWM
waveform. The waveform will then be sampled with the on-chip analog-to-digital converter and
displayed using the graphing feature of Code Composer Studio. Next, Capture Unit 1 will be
setup to detect the rising and falling edges of the waveform. This information will be used to
determine the width of the pulse and duty cycle of the waveform. The results of this step will be
viewed numerically in a memory window.

Lab 7: Event Manager (EVA)

Event Manager

Compare 1 CPU copies data
PWM Circuits conrjector ADC resultto  MEMOry
Output Logic Ll RESULTO buffer during -
- ADC ISR £
o 2
i | Capture 1 o _ =
i |[FIFOJFIFQ I GP Timer 2 triggers - %
: : | ADC SOC every : =
' | | 20 ps (50 kHz) E a

L

GP Timer 1 GP Timer 2

» Procedure

Project File

Note: LAB?7 files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.

1. Aproject named Lab7.pjt has been created for this lab. Open the project by clicking
onProject > Open.. and look in C:\C28x\LABS\LAB7. All Build Options
have been configured like the previous lab. The files used in this lab are:
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Main_7.c Labcfg.cmd

Lab.cdb DSP281x_Headers _B10S.cmd
User 5 6 _7.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP281x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr 5 6 7.c Adc.c

Ev. 7.8 9 10.c

Setup Shared 1/O, General-Purpose Timerl and Comparel
2. Edit Gpio.c and adjust the shared 1/0 pins in Group A for the PWML function.

3. InEv_7 8 9 10.c, setup General-Purpose Timer 1 and Compare 1 to implement the
PWM waveform as described in the objective for this lab. The following registers need
to be modified: TLCON, T1CNT, T1PR, DBTCONA (set deadband units off), CMPR1,
ACTRA, COMCONA. (Hint - the last step should be to enable Timer 1). Make use of
the global variable names and values that have been set using #define in the beginning of
Ev_7_8 9 10.c file. Notice that GRTCONA has been initialized earlier in the code
during Timer 2 setup. Save your work.

Build and Load

4. Save all changes to the files and click the “Bui 1d”” button.

5. Reset the DSP.

Run the Code — PWM Waveform

6. Open a memory window to view some of the contents of the ADC results buffer. The
address label for the ADC results buffer is AdcBuf. We will be running our code in real-
time mode, and need to have our window continuously refresh. Enable Real-time
Mode and be sure that the Global Continuous Refresh option has been checked.

Note: For the next step using the ADC, check to be sure that the jumper wire connecting
“VREFLO” (pin # P9-18) to “GND” (pin # P9-17) is still in place on the eZdsp™ from
the earlier lab.

7. Using another connector wire provided, connect the PWMZ1 (pin # P8-9) to ADCINO (pin
# P9-2) on the eZdsp™.

8. Run the code in real-time mode and watch the window update. Verify that the ADC
result buffer contains the updated values.

9. Open and setup a graph to plot a 50-point window of the ADC results buffer.
Click: View - Graph - Time/Frequency.. and set the following values:
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10.

Start Address AdcBuf

Acquisition Buffer Size 50

Display Data Size 50

DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Time Display Unit us

Select OK to save the graph options.

The graphical display should show the generated 2 kHz, 25% duty cycle symmetric
PWM waveform. The period of a 2 kHz signal is 500 pus. You can confirm this by
measuring the period of the waveform using the graph (you may want to enlarge the
graph window using the mouse). The measurement is best done with the mouse. The
lower left-hand corner of the graph window will display the X and Y-axis values.
Subtract the X-axis values taken over a complete waveform period (you can use the PC
calculator program found in Microsoft Windows to do this).

Frequency Domain Graphing Feature of Code Composer Studio

11. Code Composer Studio also has the ability to make frequency domain plots. It does this

by using the PC to perform a Fast Fourier Transform (FFT) of the DSP data. Let's make
a frequency domain plot of the contents in the ADC results buffer (i.e. the PWM
waveform).

Click: View > Graph -> Time/Frequency.. and set the following values:

Display Type FFT Magnitude

Start Address AdcBuf

Acquisition Buffer Size 50

FFT Framesize 50
DSP Data Type 16-bit unsigned integer
Sampling Rate (Hz) 50000

Select OK to save the graph options.

12. On the plot window, left-click the mouse to move the vertical marker line and observe the

frequencies of the different magnitude peaks. Do the peaks occur at the expected
frequencies?
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13. Fully halt the DSP (real-time mode) by using Debug -> Halt and then unchecking the
“Real-time mode”.

Setup Capture Unit 1 to Measure Width of Pulse
14. Edit Gpio.c and adjust the shared 1/0 pins in Group A for the CAP1 function.
15. InEv_7_8 9 10.c, setup Capture Unit 1 to use Timer 1 as the time base. Configure

to detect both rising and falling edges. (Hint —when configuring the CAPCONA register,
set bit 15 to 0).

16. Using the “PIE Interrupt Assignment Table” find the location for the CAP1
interrupt, “CAPINTZ1”” and fill in the following information:

PIE group #: # within group:
This information will be used in the next step.

17. Modify theendof Ev_7 8 9 10.c to do the following:

enable event manager interrupt (EVAIMRC) (Hint: use the EvaRegs structure)
enable the “CAP1” interrupt in the PIE (Hint: use the PieCtrlRegs structure)
enable core INT3 (IER register)

18. Open and inspect the Capture Unit 1 interrupt service routine (CAPINT1_ISR) in the file
Defaultlsr 5 6 7.c.

19. Modify the configuration file Iab . cdb to setup the PIE vector for the CAP1 interrupt.
Click on the plus sign (+) to the left of Schedull ing and again on the plus sign (+) to
the left of HW1 — Hardware Interrupt Service Routine Manager. Click
the plus sign (+) to the left of PIE  INTERRUPTS. Locate the interrupt location for the
CAP1 (use the information from step #16). Right click, select Properties, and type
_CAPINT1_ISR (with a leading underscore) in the function field. Click OK and save
all updates.

Build and Load
20. Save all changes to the files and click the “Bui 1d”” button.

21. Reset the DSP.

Run the Code — Pulse Width Measurement

22. Open a memory window to view the address label CAP_rising. (Type &CAP_rising in
the address box).

23. Using the connector wire provided, connect the PWM1 (pin # P8-9) to CAP1 (pin # P8-6)
on the eZdsp™.
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24. Run the code in real-time mode. Notice the values for CAP_rising and CAP_falling

(ignore the CAP_duty value until step 25). Then fully halt the DSP.

Questions:

Which GP Timer is being used to clock the PWM1?
Which GP Timer is being used as the Capture 1 timebase?

How do the captured values for CAP_rising and CAP_falling relate to the compare
register setting for PWM1?

How can the differences be accounted for?

Modify Program for Duty Cycle Measurement

25. In order to accurately compute the duty cycle of the PWM signal, we need to configure

26.

Capture Unit 1 to use GP Timer 2 as its timebase, rather than GP Timer 1. GP Timer 1
cannot be used for this, since it is being run in continuous up/down-counting mode,
whereas GP Timer 2 is running in continuous up-counting mode. (Think of Timer 1 as a
clock that runs from 12PM to 6AM, and that runs backwards to 12PM again. It wouldn't
be a good clock to use for measuring the length of an event if you simply wanted to
subtract the starting time from the ending time!)

Edit Ev_7 8 9 10.c asrequired so that Capture 1 uses GP Timer 2 as its timebase.

We also need to increase the period of Timer 2. The width of the active portion of the
25% duty, 2 kHz PWM, is 125 usec. However,in Ev_7 8 9 10.c, the line
“#define ADC_sample_period 2999 gives Timer 2 a period of 3000
SYSCLKOUT cycles (equivalent to 50 kHz, or a 20 usec period). It would be difficult to
use Timer 2 to measure the duty (To understand why, here is as an analogy. Suppose
someone hands you a stopwatch that can record only 1 minute of elapsed time before
rolling over, but asks you to use this watch to measure the length of a 1 hour meeting.
You would need to manually keep track of how many times the stopwatch had rolled
over at the 1 minute mark, which would be inefficient. It would be better to use a watch
that could record up to an hour!). It turns out that the easiest thing to do on a 16-bit
microprocessor is to use a timer that rolls over at 16bits. Then, all we need to do is
subtract the start time from the end time using 2's complement math, and we get the
elapsed time. By rolling over at 16 bits, we do not care if the elapsed time includes a
timer rollover (as long as only one such rollover has occurred).

In Ev_7_8 9 10.c changethe “ADC_sample_period” to “Oxffff”.

Note: This will have the side effect of making the ADC sampling rate only 2.3 kHz.
However, we are done using the ADC in this lab, so it is not a concern.

Build and Load

217.

28.

Save all changes to the files and click the ““Bui 1d”” button.

Reset the DSP.
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Run the Code — Duty Cycle Measurement

29. Be sure that the memory window is open to view the address label CAP_duty. (Use
&CAP_duty in address box).

30. With the wire still connecting the PWM1 (pin # P8-9) to CAP1 (pin # P8-6) on the
eZdsp™, run (real-time mode) the code again, and fully halt it after a few seconds.
Observe the values for CAP_rising, CAP_falling, and CAP_duty in a memory window.
Notice that CAP_duty is simply the difference between CAP_rising and CAP_falling
using 16-bit modulo signed math.

Questions:
o What is the value of CAP_duty in memory?

e How does it compare with the expected value?

End of Exercise
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GP Timer Compare PWM Exercise Solution

GP Timer Compare PWM Exercise
Solution

GPTCONA = (xxx0000001000010)b =0042h
T1CON = (xx00100001000010)b = 0842h

TIPR = 1 carrier period_ 1 20 ps

2 timer period 2 10 ns

=1000 = 3E8h

T1CMPR = (100% - duty cycle)*T1PR = 0.75*1000 = 750 = 2EEh

}(all x’s assigned a value of 0)

Period

Compare

Counter

’4— 50 kHz =20 ps 4*

CPU clock =10 ns

Output Pin
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Numerical Concepts & IQmath

Introduction

In this module, numerical concepts will be explored. One of the first considerations concerns
multiplication — how does the user store the results of a multiplication, when the process of mul-
tiplication creates results larger than the inputs. A similar concern arises when considering accu-
mulation — especially when long summations are performed. Then, IQmath will be described as a
technique for implementing a “virtual floating-point” system to simplify the design process.

The IQmath Library is a collection of highly optimized and high precision mathematical
functions used to seamlessly port floating-point algorithms into fixed-point code. These C/C++
routines are typically used in computationally intensive real-time applications where optimal
execution speed and high accuracy is needed. By using these routines a user can achieve
execution speeds considerable faster than equivalent code written in standard ANSI C language.
In addition, by incorporating the ready-to-use high precision functions, the IQmath library can
shorten significantly a DSP application development time. (The IQmath user's guide is included
in the application zip file, and can be found in the /docs folder once the file is extracted and
installed).

Learning Objectives

Learning Objectives

¢ Compare/contrast integer and
fractional operations

¢ Discuss fixed-point math
development limitations

¢ Compare/contrast floating-point and
IQ representation

¢ Describe the IQmath approach and
the problem it solves
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Numbering System Basics

Numbering System Basics

Given the ability to perform arithmetic processes (addition and multiplication) with the C28x, it is
important to understand the underlying mathematical issues which come into play. Therefore, we
shall examine the numerical concepts which apply to the C28x and, to a large degree, most
processors.

Binary Numbers

The binary numbering system is the simplest numbering scheme used in computers, and is the
basis for other schemes. Some details about this system are:

e Ituses only two values: 1 and 0

e Each binary digit, commonly referred to as a bit, is one “place” in a binary number
and represents an increasing power of 2.

e The least significant bit (LSB) is to the right and has the value of 1.
o Values are represented by setting the appropriate 1's in the binary number.
e The number of bits used determines how large a number may be represented.

Examples:

0110, = (0 * 8) + (1 *4) + (1 * 2) + (0 * 1) = 64
11110, = (L * 16) + (L * 8) + (1 * 4) + (1 * 2) + (0 * 1) = 304

Two's Complement Numbers

Notice that binary numbers can only represent positive numbers. Often it is desirable to be able to
represent both positive and negative numbers. The two's complement numbering system modifies
the binary system to include negative numbers by making the most significant bit (MSB)
negative. Thus, two's complement numbers:

o Follow the binary progression of simple binary except that the MSB is negative — in
addition to its magnitude

e Can have any number of bits — more bits allow larger numbers to be represented

Examples:

0110, = (0 * -8) + (1 * 4) + (L * 2) + (0 * 1) = 6y
11110, = (A * -16) + (1 *8) + (A *4) + (A *2) + (0 * 1) = -2

The same binary values are used in these examples for two's complement as were used above for
binary. Notice that the decimal value is the same when the MSB is 0, but the decimal value is
quite different when the MSB is 1.

Two operations are useful in working with two's complement numbers:
e The ability to obtain an additive inverse of a value
e The ability to load small numbers into larger registers (by sign extending)
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To load small two's complement numbers into larger

registers:

The MSB of the original number must carry to the MSB of the number when represented in the

larger register.

1. Load the small number “right justified” into the larger register.

2. Copy the sign bit (the MSB) of the original number to all unfilled bits to the left in the
register (sign extension).

Consider our two previous values, copied into an 8-bit register:

Examples:

Original No. 0110, | =64 11110, | =-2p

1. Load low 0110 11110

2. Sign Extend 00000110 |=4+2=6 11111110 |[=-128+64+..+2=-2
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Sign Extension Mode

The C28x can operate on either unsigned binary or two's complement operands. The “Sign
Extension Mode” (SXM) bit, present within a status register of the C28x, identifies whether or
not the sign extension process is used when a value is brought into the accumulator. It is good
programming practice to always select the desired SXM at the beginning of a module to assure
the proper mode.

What is Sign Extension?

¢ When moving a value from a narrowed width location
to a wider width location, the sign bit is extended to fill
the width of the destination

Sign extension applies to signed numbers only
It keeps negative numbers negative!

¢ Sign extension controlled by SXM bit in STO register;
When SXM = 1, sign extension happens automatically

L R 4

4 bit Example: Load a memory value into the ACC

memory |1101 | =-23+22+20=-3

l Load and sign extend
G

ACC (1111 /1101 (=-2"+26+25+24+23+22+20
=128 +64+32+16+8+4+1
=3
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Binary Multiplication

Now that you understand two's complement numbers, consider the process of multiplying two
two's complement values. As with “long hand” decimal multiplication, we can perform binary
multiplication one “place” at a time, and sum the results together at the end to obtain the total
product.

Note: This is not the method the C28x uses in multiplying numbers — it is merely a way of observing
how binary numbers work in arithmetic processes.
The C28x uses 16-bit operands and a 32-bit accumulator. For the sake of clarity, consider the
example below where we shall investigate the use of 4-bit values and an 8-bit accumulation:
Four-Bit Integer Multiplication
0100 4
x 1101 X -3
0100
0000
0100
1100
1110100 -12
Accumulator | 11110100 I
Data Memory ? I
Is there a better numbering system?
In this example, consider the following:
e What are the two input values, and the expected result?
e Why are the “partial products” shifted left as the calculation continues?
e Why is the final partial product “different” than the others?
e What is the result obtained when adding the partial products?
e How shall this result be loaded into the accumulator?
o How shall we fill the remaining bit? Is this value still the expected one?
e How can the result be stored back to memory? What problems arise?
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Note: With two’s complement multiplication, the leading “1” in the second multiplicand is a
sign bit. If the sign bit is “1”, then take the 2’s complement of the first multiplicand.
Additionally, each partial product must be sign-extended for correct computation.

Note: All of the above questions except the final one are addressed in this module. The last
question may have several answers:

e Store the lower accumulator to memory. What problem is apparent using this
method in this example?

e Store the upper accumulator back to memory. Wouldn't this create a loss of
precision, and a problem in how to interpret the results later?

e Store both the upper and lower accumulator to memory. This solves the above
problems, but creates some new ones:

— Extra code space, memory space, and cycle time are used

— How can the result be used as the input to a subsequent calculation? Is such a
condition likely (consider any “feedback” system)?

From this analysis, it is clear that integers do not behave well when multiplied. Might some other
type of number system behave better? Is there a number system where the results of a
multiplication are bounded?
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Binary Fractions

Given the problems associated with integers and multiplication, consider the possibilities of using
fractional values. Fractions do not grow when multiplied, therefore, they remain representable
within a given word size and solve the problem. Given the benefit of fractional multiplication,
consider the issues involved with using fractions:

e How are fractions represented in two's complement?
e What issues are involved when multiplying two fractions?

Representing Fractions in Binary

In order to represent both positive and negative values, the two's complement process will again
be used. However, in the case of fractions, we will not set the LSB to 1 (as was the case for
integers). When one considers that the range of fractions is from -1 to ~+1, and that the only bit
which conveys negative information is the MSB, it seems that the MSB must be the “negative
ones position.” Since binary representation is based on powers of two, it follows that the next bit
would be the “one-halves” position, and that each following bit would have half the magnitude
again. Considering, as before, a 4-bit model, we have the representation shown in the following
example.

1 ({.]0 1 1 |=-1+14+1/8=-5/8

-1 12 1/4 1/8
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Multiplying Binary Fractions

When the C28x performs multiplication, the process is identical for all operands, integers or

fractions. Therefore, the user must determine how to interpret the results. As before, consider the

4-bit multiply example:

Four-Bit Multiplication

0100 1/2
x 1101 x - 3/8
0100
0000
0100
1100 _
1110100 -3/16

Accumulator 1&110&.00 I

Data Memory 1_110' -1/4

As before, consider the following:
e What are the two input values and the expected result?
o As before, “partial products” are shifted left and the final is negative.

e How is the

result (obtained when adding the partial products) read?

e How shall this result be loaded into the accumulator?
o How shall we fill the remaining bit? Is this value still the expected one?
e How can the result be stored back to memory? What problems arise?

To “read” the result of the fractional multiply, it is necessary to locate the binary point (the base 2
equivalent of the base 10 decimal point). Start by identifying the location of the binary point in
the input values. The MSB is an integer and the next bit is 1/2, therefore, the binary point would
be located between them. In our example, therefore, we would have three bits to the right of the
binary point in each input value. For ease of description, we can refer to these as “Q3” numbers,
where Q refers to the number of places to the right of the point.

When multiplying numbers, the Q values add. Thus, we would (mentally) place a binary point
above the sixth LSB. We can now calculate the “Q6” result more readily.
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As with integers, the results are loaded low, and the MSB is a sign extension of the seventh bit. If
this value were loaded into the accumulator, we could store the results back to memory in a
variety of ways:

e Store both low and high accumulator values back to memory. This offers maximum
detail, but has the same problems as with integer multiply.

e Store only the high (or low) accumulator back to memory. This creates a potential for
a memory littered with varying Q-types.

e Store the upper accumulator shifted to the left by 1. This would store values back to
memory in the same Q format as the input values, and with equal precision to the
inputs. How shall the left shift be performed? Here’s three methods:

— Explicit shift
— Shift on store
— Use Product Mode shifter

Correcting Redundant Sign Bit

Correcting Redundant Sign Bit

Accumulator 1 1 1 1 O 1 O OI

Redundant
Sign Bit

¢ Correcting Redundant Sign Bit
+ IQmath: automatically handled (next topic)
+« Q math in “C”, shift in software:
int x,y,z;

z = ((long)x * (long)y) >> 15;
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Fraction Coding

Although COFF tools recognize values in integer, hex, binary, and other forms, they understand
only integer, or non-fractional values. To use fractions within the C28x, it is necessary to describe
them as though they were integers. This turns out to be a very simple trick. Consider the
following number lines:

How is a fraction coded?

~1 = ~ 32K 7FFF ==

Yo -+ 16K - 4000 -+

0 = 0 0000 ==
*32768

Y =+ -16K =~ C000 =1

-1 = _32K 8000 ——

Fractions Integers Hex

¢ Example: represent the fraction number 0.707
void main(void) {
int coef = 32768 * 707 / 1000;

By multiplying a fraction by 32K (32768), a normalized fraction is created, which can be passed
through the COFF tools as an integer. Once in the C28x, the normalized fraction looks and
behaves exactly as a fraction. Thus, when using fractional constants in a C28x program, the coder
first multiplies the fraction by 32768, and uses the resulting integer (rounded to the nearest whole
value) to represent the fraction.

The following is a simple, but effective method for getting fractions past the assembler:
1. Express the fraction as a decimal number (drop the decimal point).
2. Multiply by 32768.
3. Divide by the proper multiple of 10 to restore the decimal position.
» Examples:

e Torepresent 0.62: 32768 X 62 / 100
e To represent 0.1405: 32768 x 1405 / 10000

This method produces a valid number accurate to 16 bits. You will not need to do the math
yourself, and changing values in your code becomes rather simple.
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Fractional vs. Integer Representation

Fractional vs. Integer

¢ Range

+ Integers have a maximum range
determined by the number of bits

+ Fractions have a maximum range of +1
¢ Precision

+ Integers have a maximum precision of 1

+ Fractional precision is determined by
the number of bits

The C28x accumulator, a 32-bit register, adds extra range to integer calculations, but this
becomes a problem in storing the results back to 16-bit memory.

Conversely, when using fractions, the extra accumulator bits increase precision, which helps
minimize accumulative errors. Since any number is accurate (at best) to + one-half of a LSB,
summing two of these values together would yield a worst case result of 1 LSB error. Four
summations produce two LSBs of error. By 256 summations, eight LSBs are “noisy.” Since the
accumulator holds 32 bits of information, and fractional results are stored from the high
accumulator, the extra range of the accumulator is a major benefit in noise reduction for long
sum-of-products type calculations.
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IQmath

Implementing complex digital control algorithms on a Digital Signal Processor (DSP), or any
other DSP capable processor, typically come across the following issues:

e Algorithms are typically developed using floating-point math

e Floating-point devices are more expensive than fixed-point devices

o Converting floating-point algorithms to a fixed-point device is very time consuming

o Conversion process is one way and therefore backward simulation is not always possible

The diagram below illustrates a typical development scenario in use today:

So how do we really use all this fraction stuff?
The Fix-Point Development Dilemma

Natural development
starts with simulation in
floating-point

Simulation
Platform
(i.e. MatLab)

Takes many days/weeks
to convert (one way
process)

Can be easily ported
to floating-point
device

Fixed-Point
Algorithm
(ASM, C, C++)

Floating-Point
Algorithm
(Cor C++)

Floating-Point DSP

Fix-Point DSP

The design may initially start with a simulation (i.e. MatLab) of a control algorithm, which
typically would be written in floating-point math (C or C++). This algorithm can be easily ported
to a floating-point device, however because of cost reasons, most likely a 16-bit or 32-bit fixed-
point device would be used in many target systems.

The effort and skill involved in converting a floating-point algorithm to function using a 16-bit or
32-bit fixed-point device is quite significant. A great deal of time (many days or weeks) would
be needed for reformatting, scaling and coding the problem. Additionally, the final
implementation typically has little resemblance to the original algorithm. Debugging is not an
easy task and the code is not easy to maintain or document.
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Floating-Point Representation

|IEEE Std. 754 Single Precision
Floating-Point

31 30 23 22 0
| s| eeeeeeee | FFFFFFFFFFFFFFFFFFFFFFF
1 bit sign 8 bit exponent 23 bit mantissa (fraction)

Casel: ife=255andf#0, thenv=NaN

Case 2: ife=255andf=0, thenv =[(-1)%]*infinity

Case 3:if 0<e <255,  then v = [(-1)5]*[2€120]*(L.f)
Case 4:ife=0and f £ 0, then v = [(-1)5]*[2¢126]]*(0.f)
Case5: ife=0andf=0, then v = [(-1)%]*0

Advantage = Exponent gives large dynamic range
Disadvantage = Precision of a number depends on its exponent

Floating-Point does not Solve
Everything!

Example: x=10.0 (0x41200000)
+ y= 0.000000238 (0x347F8CF1)

z=10.000000238  WRONG!

You cannot represent 10.000000238 with
single-precision floating point

0x412000000 = 10.000000000
10.000000238 « can't represent!
0x412000001 = 10.000000950

So z gets rounded down to 10.000000000
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IQ Fractional Representation

A new approach to fixed-point algorithm development, termed “IQmath”, can greatly simplify the
design development task. This approach can also be termed “virtual floating-point” since it looks
like floating-point, but it is implemented using fixed-point techniques.

IQ Fractional Representation

31 0
(S 1ML, FEFFFFFFrFFFFFFFFFFrrree]

32 bit mantissa

20+ 2+ L+ 21+ 20, 20422+ 420

Advantage = Precision same for all numbers in an IQ format
Disadvantage = Limited dynamic range compared to floating point

The IQmath approach enables the seamless portability of code between fixed and floating-point
devices. This approach is applicable to many problems that do not require a large dynamic range,
such as motor or digital control applications.
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IQmath Can Solve the Problem!

18Q24 Example: x=10.0 (Ox0C000000)
+ y= 0.000000238 (0x00000002)

z =10.000000238 (0x0C000002)

Exact Result (this example)
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Traditional “Q” Math Approach

Traditional 16-bit “Q” Math Approach

y=mx+Db
se 015 | M
— ss, Q30
se Q15 | X
[ sssssssssssss, Q15 |je—s, Q15 | B
Align Binary
Point For Add
—— SS, Q30 |
sl 030 |
Align Binary
Point For Store
[ ssssssssssssl, Q15 |——————s. Q15 |Y
in C:|Y = ((i32) M * (i32) X + (i32) B << Q) >> Q|

y=mx+Db

Traditional 32-bit “Q” Math Approach

18 Q24 M
—{ 116, Q48 ‘
18, Q24 X
[ Ssssssssssssssssssi g, Q24 }4— 18 4 Q24
@ Align Decimal
Point for Add
L ssssl8, Q48 ]
116, Q48 |
Align Decimal
@ Point for Store
116, Q24 b /18, Q24 Y

in C:| Y = ((i64) M * (i64) X + (i64) B << Q) >> Q; |

Note: Requires support for 64-bit integer data type in compiler
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The traditional approach to performing math operations, using fixed-point numerical techniques
can be demonstrated using a simple linear equation example. The floating-point code for a linear
equation would be:

float Y, M, X, B;

Y=M*X+B;

For the fixed-point implementation, assume all data is 32-bits, and that the "Q" value, or location
of the binary point, is set to 24 fractional bits (Q24). The numerical range and resolution for a
32-bit Q24 number is as follows:

Q value Min Value Max Value Resolution

Q24 | -2%29=_128.000 000 00 | 22 _ (15)** = 127.999 999 94 | (%2)** = 0.000 000 06

The C code implementation of the linear equation is:

int32 'Y, M, X, B; // numbers are all Q24
Y = ((int64) M * (int64) X + (int64) B << 24) >> 24;

Compared to the floating-point representation, it looks quite cumbersome and has little resem-
blance to the floating-point equation. It is obvious why programmers prefer using floating-point
math.

The slide shows the implementation of the equation on a processor containing hardware that can
perform a 32x32 bit multiplication, 64-bit addition and 64-bit shifts (logical and arithmetic) effi-
ciently.

The basic approach in traditional fixed-point "Q" math is to align the binary point of the operands
that get added to or subtracted from the multiplication result. As shown in the slide, the multipli-
cation of M and X (two Q24 numbers) results in a Q48 value that is stored in a 64-bit register.
The value B (Q24) needs to be scaled to a Q48 number before addition to the M*X value (low
order bits zero filled, high order bits sign extended). The final result is then scaled back to a Q24
number (arithmetic shift right) before storing into Y (Q24). Many programmers may be familiar
with 16-bit fixed-point "Q" math that is in common use. The same example using 16-bit numbers
with 15 fractional bits (Q15) would be coded as follows:

intlé Y, M, X, B; // numbers are all Q15
Y = ((int32) M * (int32) X + (int32) B << 15) >> 15;

In both cases, the principal methodology is the same. The binary point of the operands that get
added to or subtracted from the multiplication result must be aligned.
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IQmath Approach
32-bit IQmath Approach

y=mx+Db

18, Q24 M
[116 Q48

18 24
Align Decimal . O X
Point Of Multiply

[ sssssssssssssssssli16, Q24 |

. Q24 B

18 Q24 118, Q24 Y

in C: \Y = ((i64) M * (i64) X) >> Q + B;

In the "IQmath™ approach, rather then scaling the operands, which get added to or subtracted
from the multiplication result, we do the reverse. The multiplication result binary point is scaled
back such that it aligns to the operands, which are added to or subtracted from it. The C code
implementation of this is given by linear equation below:

int32 Y, M, X, B;
Y = ((int64) M * (int64) X) >> 24 + B;

The slide shows the implementation of the equation on a processor containing hardware that can
perform a 32x32 bit multiply, 32-bit addition/subtraction and 64-bit logical and arithmetic shifts
efficiently.

The key advantage of this approach is shown by what can then be done with the C and C++ com-
piler to simplify the coding of the linear equation example.

Lets take an additional step and create a multiply function in C that performs the following opera-
tion:

int32 _1Q24mpy(int32 M, int32 X) { return ((int64) M * (int64) X) >> 24; }
The linear equation can then be written as follows:
Y = _1Q24mpy(M , X) + B;

Already we can see a marked improvement in the readability of the linear equation.
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Using the operator overloading features of C++, we can overload the multiplication operand "*"
such that when a particular data type is encountered, it will automatically implement the scaled
multiply operation. Lets define a data type called "ig" and assign the linear variables to this data

type:
iq Y, M, X, B// numbers are all Q24
The overloading of the multiply operand in C++ can be defined as follows:
ig operator * (const iq &M, const iq &X) { return ((int64) M * (int64) X) >> 24; }
Then the linear equation, in C++, becomes:
Y=M*X+B;

This final equation looks identical to the floating-point representation. It looks "natural”. The
four approaches are summarized in the table below:

Math Implementations Linear Equation Code
32-bit floating-point math in C Y=M*X+B;
32-bit fixed-point "Q" math in C Y = ((int64) M * (int64) X) + (int64) B << 24) >> 24;
32-bit IQmath in C Y = _1Q24mpy(M, X) + B;
32-bit IQmath in C++ Y=M*X+B,;

Essentially, the mathematical approach of scaling the multiplier operand enables a cleaner and a
more "natural” approach to coding fixed-point problems. For want of a better term, we call this
approach "1Qmath™ or can also be described as "virtual floating-point".
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IQmath Approach
Multiply Operation

| Y = ((i64) M * (i64) X) >> Q + B; |
Redefine the multiply operation as follows:
| _1Qmpy(M,X) == ((i64) M * (i64) X) >> Q |
This simplifies the equation as follows:
| Y = _10mpy(M.X) + B: |

C28x compiler supports “_IQmpy” intrinsic; assembly code generated:

MOVL XT,@M
IMPYL P,XT,@X ; P
QMPYL ACC,XT,@X ; ACC high 32-bits of M*X
LSL64 ACC:P,#(32-Q) ; ACC ACC:P << 32-Q

; (same as P = ACC:P >> Q)

low 32-bits of M*X

ADDL ACC,@B ; Add B
MOVL @Y ,ACC ; Result = Y = _1Qmpy(M*X) + B
; 7 Cycles

IQmath Approach
It looks like floating-point!

) ) float Y, M, X, B;
Floating-Point

Y=M?=*X + B;
long Y, M, X, B;

Traditional
Fix-Point Q v = ((i64) M * (i64) X + (i64) B << Q)) >> Q;
uIQmathn _iq Y, M, X, B;
InC Y = _1Qmpy(M, X) + B;
“IQmath” iq Y, M, X, B;
In C++

Y =M*X+ B;

Taking advantage of operator overloading feature in C++,
“IQmath” looks like floating-point math (looks natural!)
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IQmath Approach
(gOBAL_Q si%%lification

User selects “Global Q" value for the whole application
GLOBAL_Q

o
based on the required dynamic range or resolution, for example:
GLOBAL_Q Max Val Min Val Resolution
28 7-.999 999 996 -8.000 000 000 | 0.000 000 004
24 127.999 999 94 -128.000 000 00 |0.000 000 06
20 2047.999 999 -2048.000 000 0.000 001

#define GLOBAL_Q 18 // set in “IQmathLib.h” file
_iq Y, M, X, B;
Y = _1Q0mpy(M,X) + B; // all values are in Q = 18

The user can also explicitly specify the Q value to use:
_igq20 Y, M, X, B;

Y = _1Q20mpy(M,X) + B; // all values are in Q = 20

The basic "IQmath" approach was adopted in the creation of a standard math library for the Texas
Instruments TMS320C28x DSP fixed-point processor. This processor contains efficient hardware
for performing 32x32 bit multiply, 64-bit shifts (logical and arithmetic) and 32-bit add/subtract
operations, which are ideally suited for 32 bit "IQmath".

Some enhancements were made to the basic "IQmath" approach to improve flexibility. They are:

Setting Of GLOBAL_Q Parameter Value: Depending on the application, the amount of nu-
merical resolution or dynamic range required may vary. In the linear equation example, we used
a Q value of 24 (Q24). There is no reason why any value of Q can't be used. In the "1Qmath"
library, the user can set a GLOBAL_Q parameter, with a range of 1 to 30 (Q1 to Q30). All func-
tions used in the program will use this GLOBAL_Q value. For example:

#define GLOBAL_Q 18
Y = _1Qmpy(M, X) + B; // all values use GLOBAL_Q =18

If, for some reason a particular function or equation requires a different resolution, then the user
has the option to implicitly specify the Q value for the operation. For example:

Y = _1Q23mpy(M,X) + B; // all values use Q23, including B and Y

The Q value must be consistent for all expressions in the same line of code.

C28x - Numerical Concepts & IQmath



IQmath

IQmath Approach

Targeting Fixed-Point or Floating-Point device

Y = _1IQmpy(M, X) + B;

User selects target math type
<~ (in “IQmathLib.h” file)

#if MATH_TYPE == 1Q_MATH #1T MATH_TYPE == FLOAT_MATH

i

Y = (float)M * (float)X + (Float)B;

Compile & Run
using “lQmath” on
C28x

Compile & Run
using floating-point math on
C3x, C67x,C28x (RTS), PC,..

All “1Qmath” operations have an equivalent floating-point operation

Selecting FLOAT_MATH Or IQ_MATH Mode: As was highlighted in the introduction, we
would ideally like to be able to have a single source code that can execute on a floating-point or
fixed-point target device simply by recompiling the code. The "1Qmath" library supports this by
setting a mode, which selects either IQ_MATH or FLOAT_MATH. This operation is performed
by simply redefining the function in a header file. For example:

#if MATH_TYPE == 1Q_MATH

#define _1Qmpy(M , X) _IQmpy(M , X)
#elseif MATH_TYPE == FLOAT_MATH
#define _1Qmpy(M , X) (float) M * (float) X
#endif

Essentially, the programmer writes the code using the "1Qmath" library functions and the code
can be compiled for floating-point or "IQmath" operations.
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IQmath Library

IQmath Library: math & trig functions (v1.4)

Operation Floating-Point “IQmath” in C “IQmath” in C++
type float A, B; _ig A B; ig A, B;
constant A =1.2345 A = _1Q(1.2345) A =1Q(1.2345)
multiply A*B _lQmpy(A , B) A*B
divide A/B _lQdiv (A, B) A/B
add A+B A+B A+B
substract A-B A-B A-B
boolean >, >=, <, <=, =5, |5, &&, || >, >=, <, <=, =5, |5, &&, || >, >=, <, <=, =5, |5, &&, ||
trig sin(A),cos(A) _1Qsin(A), _IQcos(A) 1Qsin(A),IQcos(A)

functions sin(A*2pi),cos(A*2pi) | _IQsinPU(A), _IQcosPU(A) | IQsinPU(A),IQcosPU(A)
atan(A),atan2(A,B) | _IQatan(A), _IQatan2(A,B) | IQatan(A),IQatan2(A,B)

atan2(A,B)/2pi _IQatan2PU(A,B) IQatan2PU(A,B)
sqrt(A),1/sqrt(A) _1Qsqrt(A), _1Qisqrt(A) 1Qsqrt(A),IQisqrt(A)
sqrt(A*A + B*B) _IQmag(A,B) IQmag(A,B)
saturation if(A > Pos) A = Pos _lQsat(A,Pos,Neg) IQsat(A,Pos,Neg)

if(A <Neg) A = Neg

Accuracy of functions/operations approx ~28 to ~31 bits

Additionally, the "IQmath” library contains DSP library modules for filters (FIR & IIR) and Fast
Fourier Transforms (FFT & IFFT).

IQmath Library: Conversion Functions (v1.4)
Operation Floating-Point “IQmath” in C “lIQmath” in C++
ig to igN A _IQtolQN(A) IQtolQN(A)
igN to iq A _IQNtolIQ(A) IQNtolQ(A)
integer(iq) (long) A _lQint(A) 1Qint(A)
fraction(iq) A —(long) A _IQfrac(A) IQfrac(A)
ig =ig*long A * (float) B _1Qmpyl32(A,B) 1Qmpyl32(A,B)
integer(ig*long) (long) (A * (float) B) _IQmpyl32int(A,B) IQmpyl32int(A,B)
fraction(ig*long) | A - (long) (A * (float) B) | _IQmpyl32frac(A,B) | 1Qmpyl32frac(A,B)
gNtoiq A _QNtolQ(A) QNtolQ(A)
iq to gN A _|QtoQN(A) IQtoQN(A)
string to iq atof(char) _atolQ(char) atolQ(char)
IQ to float A _IQtoF(A) IQtoF(A)
IQmath.lib > contains library of math functions
IQmathLib.h > C header file
IQmathCPP.h > C++ header file

8-24 C28x - Numerical Concepts & IQmath



IQmath Library

16-Bit vs. 32-Bit

The "IQmath" approach could also be used on 16 bit sized numbers and for many problems, this
is sufficient resolution. However, in many control cases, the user needs to use many different
"Q" values to accommodate the limited resolution of a 16-bit number.

With DSP devices like the TMS320C28x processor, which can perform 16 bit and 32 bit sized
math with equal efficiency, the choice becomes more of productivity (time to market). Why
bother spending a whole lot of time trying to code using 16 bit numbers when you can simply use
32 bit numbers, pick one value of "Q" that will accommodate all cases and not worry about
spending too much time optimizing.

Of course there is a concern on data RAM usage if numbers that could be represented in 16 bits
all use 32 bits. This is becoming less of an issue in today's processors because of the finer tech-
nology used and the amount of RAM that can be cheaply integrated. However, in many cases,
this problem can be mitigated by performing intermediate calculations using 32 bit numbers and
converting the input from 16 bit to 32 bit and converting the output from 32 to 16 bit before stor-
ing the final results. In many problems, it is the intermediate calculations that require additional
accuracy to avoid quantization problems.
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AC Induction Motor Example

AC Induction Motor Example
One of the more complex motor control algorithms

AC INDUCTION MOTOR
T FORWARD CONTROL MODEL
id_rof=§  pPin_REGI
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)
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ek D] PARK |........_,J
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FEEDBACK CONTROL . . % E! [!

Alpha.fxis Stator Curront Plot

Figure &

& Sensorless, ACl induction machine direct rotor flux control
& Goal: motor speed estimation & alpha-axis stator current estimation

The "IQmath" approach is ideally suited for applications where a large numerical dynamic range
is not required. Motor control is an example of such an application (audio and communication
algorithms are other applications). As an example, the IQmath approach has been applied to the
sensor-less direct field control of an AC induction motor. This is probably one of the most chal-
lenging motor control problems and as will be shown later, requires numerical accuracy greater
then 16-bits in the control calculations.

The above slide is a block diagram representation of the key control blocks and their interconnec-
tions. Essentially this system implements a "Forward Control™ block for controlling the d-g axis
motor current using PID controllers and a "Feedback Control” block using back emf's integration
with compensated voltage from current model for estimating rotor flux based on current and volt-
age measurements. The motor speed is simply estimated from rotor flux differentiation and open-
loop slip computation. The system was initially implemented on a "Simulator Test Bench" which
uses a simulation of an "AC Induction Motor Model" in place of a real motor. Once working, the
system was then tested using a real motor on an appropriate hardware platform.

Each individual block shown in the slide exists as a stand-alone C/C++ module, which can be
interconnected to form the complete control system. This modular approach allows reusability
and portability of the code.
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The next few slides shows the coding of one particular block, PARK Transform, using floating-
point and "IQmath" approaches in C and C++:

AC Induction Motor Example
Park Transform - floating-point C code

#include “math.h”
#define TWO_PI 6.28318530717959
void park_calc(PARK *v)

{
float cos_ang , sin_ang;
sin_ang = sin(TWO_PI * v->ang);
cos_ang = cos(TWO_PI * v->ang);
v->de = (v->ds * cos_ang) + (v->gs * sin_ang);
v->ge = (v->Qs * cos_ang) - (v->ds * sin_ang);
3

AC Induction Motor Example
Park Transform - converting to “1Qmath” C code

#include “math.h”
#include “IQmathLib.h”

#define TWO_PI _1Q(6.28318530717959)
void park_calc(PARK *v)
{
_ig cos_ang , sin_ang;
sin_ang = _1Qsin(_1Qmpy(TWO_PI1 , v->ang));
cos_ang = _1Qcos(_IQmpy(TWO_P1 , v->ang));
v->de = _lIQmpy(v->ds , cos_ang) + _I1Qmpy(v->gs , sin_ang);
v->ge = _IQmpy(v->gs , cos_ang) - _IQmpy(v->ds , sin_ang);
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AC Induction Motor Example
Park Transform - converting to “IQmath” C++ code

#include “math.h”

extern “C” { #include “lIQmathLib.h> }
#include “1QmathCPP.h"

#define TWO_PI 1Q(6.28318530717959)
void park_calc(PARK *v)

{
ig cos_ang , sin_ang;
sin_ang = 1Qsin(TWO_PI1 * v->ang);
cos_ang = 1Qcos(TWO_P1 * v->ang);
v->de = (v->ds * cos_ang) + (v->gs * sin_ang);
v->ge = (v->Qs * cos_ang) - (v->ds * sin_ang);
3

As can be seen, the floating-point C and "1Qmath" C++ code looks almost identical. It is quite a
simple and fast procedure to take any floating-point algorithm and convert it to an "IQmath" algo-
rithm.

The complete system was coded using "IQmath"”. Based on analysis of coefficients in the system,
the largest coefficient had a value of 33.3333. This indicated that a minimum dynamic range of 7
bits (+/-64 range) was required. Therefore, this translated to a GLOBAL_Q value of 32-7 = 25
(Q25). Just to be safe, the initial simulation runs were conducted with GLOBAL_Q = 24 (Q24)
value.
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The code was compiled and run on the Texas Instruments TMS320C28x fixed-point DSP device
(IQ_MATH mode) and on the TMS320C3x floating-point DSP device (FLOAT_MATH mode).
The plots of speed and stator current for both devices matched and are shown below.

The plots start from a step change in reference speed from 0.0 to 0.5 and 1024 samples are taken.
The speed eventually settles to the desired reference value and the stator current exhibits a clean
and stable oscillation. The block diagram slide shows at which points in the control system the

plots are taken from.

GLOBAL_Q = 24, system stable
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AC Induction Motor Example
GLOBAL_Q =27, system unstable
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With the ability to select the GLOBAL_Q value for all calculations in the "IQmath", an experi-
ment was conducted to see what maximum and minimum Q value the system could tolerate be-
fore it became unstable. The results are tabulated in the slide below:

AC Induction Motor Example
Q stability range

Q range Stability Range
Unstable
Q31 to Q27 (not enough dynamic range)
Q26 to Q19 Stable
Q18 to QO Unstable

(not enough resolution, quantization problems)

The developer must pick the right GLOBAL_Q value!

The above indicates that, the AC induction motor system that we simulated requires a minimum
of 7 bits of dynamic range (+/-64) and requires a minimum of 19 bits of numerical resolution (+/-
0.000002). This confirms our initial analysis that the largest coefficient value being 33.33333
required a minimum dynamic range of 7 bits. As a general guideline, users using 1Qmath should
examine the largest coefficient used in the equations and this would be a good starting point for
setting the initial GLOBAL_Q value. Then, through simulation or experimentation, the user can
reduce the GLOBAL_Q until the system resolution starts to cause instability or performance deg-
radation. The user then has a maximum and minimum limit and a safe approach is to pick a mid-
point.

What the above analysis also confirms is that this particular problem does require some calcula-
tions to be performed using greater then 16 bit precision. The above example requires a mini-
mum of 7 + 19 = 26 bits of numerical accuracy for some parts of the calculations. Hence, if one
were implementing the AC induction motor control algorithm using a 16 bit fixed-point DSP, it
would require the implementation of higher precision math for certain portions. This would take
more cycles and programming effort.

The great benefit of using GLOBAL_Q is that the user does not necessarily need to go into de-
tails to assign an individual Q for each variable in a whole system, as is typically done in conven-
tional fixed-point programming. This is time consuming work. By using 32-bit resolution and the
"IQmath" approach, the user can easily evaluate the overall resolution and quickly implement a
typical digital motor control application without quantization problems.
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AC Induction Motor Example

Using the profiling capabilities of the respective DSP tools, the table above summarizes the num-

AC Induction Motor Example

Performance comparisons

(20kHz control loop)

C28x C C3x C C67x C C67x C
IQmath (-g) | float (-g) | float (-g) |float (no —g)
Benchmark (150MHz) | (75MHz) | (167MHz) | (167MH2)

B1: Forward control cycles 482 308 627 432
B2: ACI model cycles 564 215 321 183
B3: Feedback control cycles 1081 829 1295 973
Key benchmark cycles (B1+B3) 1563 1137 1922 1405

% of available MHz used 20.9% 30.3% 23.0% 16.8%

Notes: C28x compiled on CGT V3.03, V1.4c IQmath Lib (debug enabled (-g), max opt).

C3x compiled on CGT V5.12, RTS30R Lib (debug enabled (-g), max opt).

C67x compiled on CGT V4.20, RTSFast Lib (debug enabled (-g)/disabled, max opt).
On C67x, when debug is enabled (-g), parallel execution of operations are limited.
On C28x & C3x, turning off debug (no —g) has minimal impact on performance.

ber of cycles and code size of the forward and feedback control blocks.

The MIPS used is based on a system sampling frequency of 20kHz, which is typical of such sys-

tems.

C28x - Numerical Concepts & IQmath




IQmath Appications and Summary

IQmath Appications and Summary
Where Is IQmath Applicable?

Anywhere a large dynamic range is not required

Motor Control (PID, State Estimator, Kalman,...)
Servo Control
Modems
Audio (MP3, etc.)
Imaging (JPEG, etc.)
Any application using 16/32-bit fixed-point Q math

Where it is not applicable

Graphical applications (3D rotation, etc.)

When trying to squeeze every last cycle

IQmath Approach Summary

“IQmath” + fixed-point processor with 32-bit capabilities =

¢ Seamless portability of code between fixed and floating-
point devices

« User selects target math type in “IQmathLib.h” file
+  #if MATH_TYPE == IQ_MATH
+ #if MATH_TYPE == FLOAT_MATH
¢ One source code set for simulation vs. target device

¢ Numerical resolution adjustability based on application
requirement

+ Setin “IQmathLib.h” file
+ #define GLOBAL_Q 18
- Explicitly specify Q value
« _ig20 X, Y, Z;
¢ Numerical accuracy without sacrificing time and cycles
¢ Rapid conversion/porting and implementation of algorithms

IQmath library is freeware - available from TI DSP website
http://www.dspvillage.ti.com (follow C2000 DSP links)
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IQmath Appications and Summary

The 1Qmath approach, matched to a fixed-point processor with 32x32 bit capabilities enables the
following:

Seamless portability of code between fixed and floating-point devices
Maintenance and support of one source code set from simulation to target device
Adjustability of numerical resolution (Q value) based on application requirement
Implementation of systems that may otherwise require floating-point device
Rapid conversion/porting and implementation of algorithms
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Converting ADC Results into IQ Format

Converting ADC Results into 1Q Format

As you may recall, the converted values of the ADC are placed in the upper 12 bit of the
RESULTO register. Before these values are filtered using the IQmath library, they need to to be
put into the 1Q format as a 32-bit long.

Getting the ADC Result into 1Q Format

XXX XXX IXIXIXIXIXIX] 0] 0] 0] O] RESULTX

Do not sign extendl

31 15 0
ololololololololololololoTol ol o IXIXIXIXIXIXIXIXIXTXIXIXT0[0[0[0] 32-bit long

Notice that the 32-bit long is already in 1Q16 format!

#define AdcFsVoltage 10(3.0) // ADC full scale voltage
_iq Result, temp; // ADC result
void main(void)
{
// convert the unsigned 16-bit result to unsigned 32-bit
// temp = AdcRegs.ADCRESULTO;
// convert resulting 1016 to 1Q format
// temp = _1Q16tolQ(temp);
// scale by ADC full-scale range (optional)
// Result = _IQmpy(AdcFsVoltage, temp);
Result = _1Qmpy(AdcFsVoltage, _1Q16tolQ( (_iq)AdcRegs.ADCRESULTO0));

}

For uni-polar ADC inputs (i.e., 0 to 3 V inputs), a conversion to global 1Q format can be achieved
with:

IQresult_unipolar = _1Qmpy(_1Q(3.0),_1Q16tolQ((_ig) AdcRegs.ADCRESULTO0));

How can we modify the above to recover bi-polar inputs, for example +-1.5 volts? One could do
the following to offset the +1.5V analog biasing applied to the ADC input:

IQresult_bipolar =
_1Qmpy(_1Q(3.0),_1Q16tolQ((_ig) AdcRegs. ADCRESULTO0)) - _1Q(1.5);

However, one can see that the largest intermediate value the equation above could reach is 3.0.
This means that it cannot be used with an 1Q data type of 1Q30 (1Q30 range is -2 < x < ~2). Since
the IQmath library supports 1Q types from 1Q1 to 1Q30, this could be an issue in some applica-
tions.

The following clever approach supports 1Q types from 1Q1 to 1Q30:

IQresult_bipolar =
_1Qmpy(_1Q(1.5),_1Q15tolQ((_iq) ((int16) (AdcRegs. ADCRESULTO ” 0x8000))));

The largest intermediate value that this equation could reach is 1.5. Therefore, 1Q30 is easily
supported.
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Lab 8: IQmath FIR Filter

Lab 8: IQmath FIR Filter
» Objective

PWM Circuits .
Output Logic FIR Filter
4 connector ¥
1 wire g
GP Timer 2 triggers
ADC SOC every data
20 ps (50 kHz) memory
GP Timer 1 GP Timer 2
= «
= CPU copies
[ result to
. buffer during
) - ADC ISR
k= :
2 \l==
Display
using CCS
» Procedure
Project File

The objective of this lab is to apply the techniques discussed in module 8 and to become familiar
with 1Qmath programming. In the previous lab, General-Purpose Timer 1 and Compare 1 from
Event Manager A (EVA) were setup to generate a 2 kHz, 25% duty cycle symmetric PWM
waveform. The waveform was then sampled with the on-chip analog-to-digital converter. In this
lab the sampled waveform will be passed through an IQmath FIR filter and displayed using the
graphing feature of Code Composer Studio.

Event Manager ADC

Lab 8: IQmath FIR Filter

Compare 1

ADCINAO | RESULTO

IQmath

Note: LABS files have been provided as a starting point for the lab and need to be
completed. DO NOT copy files from a previous lab.

1. Aproject named Lab8.pjt has been created for this lab. Open the project by clicking

onProject -

Open... and look in C:\C28x\LABS\LAB8. All Build Options

have been configured like the previous lab. The files used in this lab are:
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Lab 8: IQmath FIR Filter

Main_8.c Labcfg.cmd

Lab.cdb DSP281x_Headers_B10S.cmd
User 8 9.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP281x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr_8.c Adc.c

Ev 7 8 9 10.c Filter.c

Project Build Options

2. Setup the include search path to include the IQmath header file. Open the Build
Options and select the Compiler tab. In the Preprocessor Category, find the Include
Search Path (-1) box and add to the end of the line (preceeded with a semicolon to
append this directory to the existing search path):

;c:\tidcs\c28\1Qmath\clQmath\include

3. Setup the library search path to include the IQmath library. Open the Build Options
and select the linker tab.

a. In the Basic Category, find the Library Search Path (-i) box and enter:
c:\tidcs\c28\I1Qmath\clQmath\lib
b. Inthe Include Libraries (-1) boxenter: IQmath.lib

Then select OK to save the Bui ld Options.

Include IQmathLib.h

4. Open Lab.h and uncomment the line that includes the 1QmathLib.h header file.
Next, in the Function Prototypes section, uncomment the function prototype for 1Qssfir(),
the 1Q math single-sample FIR filter function.

Inspect User_8 9.cmd

5. Open and inspect User_8_ 9.cmd. First, notice that a section called “1Qmath’ is
being linked to HOSARAM. The IQmath section contains the IQmath library functions
(code). Second, notice that a section called “IgmathTables™ is being linked to the
BOOTROM with a TYPE = NOLOAD modifier after its allocation. The IQmath tables are
used by the 1Qmath library functions. The NOLOAD modifier allows the linker to
resolve all addresses in the section, but the section is not actually placed into the .out
file. This is done because the section is already present in the device ROM (you cannot
load data into ROM after the device is manufactured!). The tables were put in the ROM
by TI when the device was manufactured. All we need to do is link the section to the
addresses where it is known to already reside (the tables are the very first thing in the
BOOT ROM, starting at address 0x3FF000).
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Lab 8: IQmath FIR Filter

Select a Global 1Q value

6.

Open the file cz\tidcs\c28\1Qmath\clQmath\include\lQmathLib_h.
Confirm that the GLOBAL_Q type (near beginning of file) is set to a value of 24. If it is
not, modify as necessary:

#define GLOBAL_Q 24

Recall that this Q type will provide 8 integer bits and 24 fractional bits. Dynamic range
is therefore -255 < x < +255, which is sufficient for our purposes in the workshop.

IQmath Single-Sample FIR Filter

7.

Open and inspect Defaultlsr_8.c. Notice that the ADCINT_ISR calls the IQmath
single-sample FIR filter function, 1Qssfir(). The filter coefficients have been defined in
the beginning of the file. Now open and inspect the 1Qssfir() function in Filter.c.
This is a simple, unoptimized coding of a basic IQmath single-sample FIR filter.

Build and Load

8.
9.

Click the ““Bui 1d”” button.

Reset the DSP.

Run the Code - Filtered Waveform

10.

Open a memory window to view some of the contents of the filtered ADC results buffer.
The address label for the filtered ADC results buffer is AdcBufFiltered. Set the Q-Value
to 24 (which matches the 1Q format being used for this variable) and the Format to 32-Bit
Signed Int. We will be running our code in real-time mode, and need to have our window
continuously refresh. Enable Real-time Mode and be sure that the Global

Continuous Refresh option has been checked.

Note:

For the next step, check to be sure that the jumper wire connecting “VREFLO”
(pin # P9-18) to “GND” (pin # P9-17) and the wire connecting PWML1 (pin # P8-9) to
ADCINO (pin # P9-2) are still in place on the eZdsp™.

11.

12.

Run the code in real-time mode and watch the memory window update. Verify that the
ADC result buffer contains updated values.

Open and setup a dual time graph to plot a 50-point window of the filtered and unfiltered
ADC results buffer. Click: View > Graph -> Time/Frequency.. and set the
following values:
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Lab 8: IQmath FIR Filter

Display Type

Dual Time

Start Address — upper display

AdcBufFiltered

Start Address — lower display | AdcBuf
Acquisition Buffer Size 50
Display Data Size 50

DSP Data Type

32-bit signed integer

Q-value 24
Sampling Rate (Hz) 50000
Time Display Unit us

Select OK to save the graph options.

13. The graphical display should show the generated IQmath FIR filtered 2 kHz, 25% duty

cycle symmetric PWM waveform in the upper display and the unfiltered waveform

generated in the previous lab exercise in the lower display. Notice the shape and phase
differences between the waveform plots (the filtered curve has rounded edges, and lags
the unfiltered plot by several samples). The amplitudes of both plots should run from 0

to 3.0.

14. Fully halt the DSP (real-time mode) by using Debug -> Halt and then unchecking the

“Real-time mode”.

End of Exercise
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Lab 8 Reference: IQmath FIR Filter

Bode Plot of Digital Low Pass Filter
Coefficients: [1/16, 4/16, 6/16, 4/16, 1/16]

Sample Rate: 50 kHz

LowFass Filter Magnitude

o o =
15N (a7 ]

o
(]

hagnitude (dimensionless)

Freguency (HE:I. w10t

Lowe-Fass Fiter Phase
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100
7
=
w 200
i :
i 1
D_ 1

-300 .

400 i | | i

a 0.5 1 1.5 2 25
Frequency (Hz) « 10
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Using DSP/BIOS

Introduction

This module discusses the basic features of using DSP/BIOS in a system. Scheduling threads,
periodic functions, and the use of real-time analysis tools will be demonstrated.

Learning Objectives

Learning Objectives

¢ Introduction to DSP/BIOS

¢ Scheduling DSP/BIOS threads
¢ Periodic Functions

¢ Real-time Analysis Tools

¢ DSP/BIOS APl modules and summary
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Module Topics

Module Topics
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Introduction to DSP/BIOS

Introduction to DSP/BIOS
Introduction to DSP/BIOS

What is DSP/BIOS?

¢ A full-featured, scalable real-time kernel
« System configuration tools
+ Preemptive multi-threading scheduler
+ Real-time analysis tools

Why use DSP/BIOS?

¢ Helps manage complex system resources
¢ Integrated with Code Composer Studio IDE

« Requires no runtime license fees

« Fully supported by Tl and is a key component of TlI's
eXpressDSP™ real-time software technology

¢ Uses minimal MIPS and memory (2-8Kw)

DSP/BIOS Configuration Tool il cab)

Estimated Data Size: 913 Est. Min. Stack Size [Mallz): 260

System Setup Tools

Global Settings

.
o MEM - Memory Section Manager . .

il BUF - Buffer pocl Manager Handles memory configuration

B 55 - system settings < (builds .cmd file), run-time support
@} HOOK - Madule Hook Manager libraries, interrupt vectors, system

- Instrumentation setup and reset, etc.
- [B LG - Evert Log Manager

5T5 - Statistics Object Manager

¢ Real-Time Analysis Tools
-8 Scheduiing ] )
-5 CLK - Clock Manager & Allows application to run

----- &) PRD - Periodic Function Manager uninterrupted while d|sp|ay|ng
3| I"l, HWI - Hardware Interrupt Service Routine Manager debug data

[
-3 SWI - Software Interrupt Manager
514G TSK - Task Manager N Real-Time Scheduler
[ZI---[:] I0L - Idle Function Manager
£-@@ Synchronization Preemptive tread manager kernel
2

----- ‘K' SEM - Semaphore Manager
----- QR MEx: - Mailbox Manager Real-Time |/O

----- 'l_.| QUE - Abornic Queus Manager

..... & LCK - Resource Lock Manager <:I Allows two way communication
-8 TnpujOutpu: between threads or between

@ RTDY - Real-Time Data Exchange Settings target and PC hOSt
[#-B3 H5T - Host Channel Manager

----- :‘&, PIP - Buffered Pipe Manager
----:::_': 510 - Stream Input and Gutput Manager
(-4 Device Drivers
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Introduction to DSP/BIOS

DSP/BIOS Terminology

thread a path of program execution
scheduler aprogram that manages threads

preemption the act of a higher priority thread
interrupting a lower priority thread

post an event signal that often makes a
thread “ready”

pend When a thread waits for an event post

semaphore a data object that tracks event
occurrences (used by post and pend)
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Scheduling DSP/BIOS Threads

Scheduling DSP/BIOS Threads

Problem: Add a Function to your Code

| Function1 [~ Existing Function
—] | New Function

+ Issues:
+ Do we have enough bandwidth (MIPS)?
+« Will one routine conflict with the other?

TI DSP

+« How is acompound system created?

What are some possible solutions?

Possible Solution Using while Loop

Main() ¢ Call each function from an

while(1); endless loop within main

& Potential Problems:

I

Function 1 What if Algorithms run at different rates:

- motor current loop at 20 kHz

) - respond to keypad input at 2 Hz

} What if one algorithm consumes enough
MIPS to force the other algorithm to miss its
real-time deadlines / delays its response?

How are these problems typically solved?
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Scheduling DSP/BIOS Threads

Possible Solution Using Interrupts

main

{
}

Functionl_ISR

{

}

Function2_ISR

{

while(1);

¢ Aninterrupt driven system places
each function in its own ISR

Period Compute CPU Usage

Function 1: 0.05ms lus 2%
Function 2: 500 ms 3us ~ 0%
2%
P RPN

runnini ’ A : . 4
° ! \ Function 1

idle 1 ‘:

1 L
‘\ /' Function 2

) R \
UlIeist Time o0 1 2 3\4 5 6 7
Only one can run at atime
Interrupt is missed...
DSP/BIOS Solution - HWI
: ¢ Nested interrupts allow hardware
Jr{naln interrupts to preempt each other
return; S
}

Functionl_ISR

{

}

Function2_ISR

{

}

¢ Use DSP/BIOS HWI dispatcher for context
save/restore, and allow preemption

¢ Reasonable approach if you have limited
number of interrupts/functions

¢ Limitation: number of HWI and their priorities
are statically determined, only one HWI
function for each interrupt
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Scheduling DSP/BIOS Threads

HWI Dispatcher for ISRs

¢ For non-BIOS code, we use the interrupt keyword to declare an ISR
> tells the compiler to perform context save/restore
interrupt void MyHwi(void)
{
}

¢ For DSP/BIOS code, the dispatcher will perform the save/restore
> Remove the interrupt keyword from the MyHwi()
> Check the “Use Dispatcher” box when you configure the interrupt
vector in the DSP/BIOS config tools
PIE_INT1 G Properties |
R Dlspalchell
¥ Use Dispatcher
tig [oooomon
Inteiupt Mask IERD [ =]
Interiupt Bit Mask EF: - [Bam00T

Ok I Cancel Apply; Help

Using Software Interrupts - SWI

¢ Make each algorithm an independent

main software interrupt

{.. .

Il retumn to OIS ¢ SWI scheduh-ng is .handled by DSP/BIOS

} ¢ HWI function triggered by hardware
& SWI function triggered by software

%DSP/BI10S

e.g. a call to SWI_post()

)
¢ Why use a SWr

¢ No limitation on number of SWiIs, and
priorities for SWIs are user-defined

¢ SWI can be scheduled by hardware or
software event(s)

& Defer processing from HWI to SWI

Function 2
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Scheduling DSP/BIOS Threads

SWI Properties

ADC_swi Properties i x|
B¥ Lab.cdb General I

Estimated Data Size: 948 Est. Min. Stack Size [Mallz) 272
EL-@ Syskem

7[5 Instrumentation

g

Scheduling

@ PRD - Periodic Function Manager
M HWI - Hardware "L'WH"H":['H: £ B 1A 0ET
B S - Software [ Pl

Wndo

Cuk

comment: | =/l

function: I_Achuw—
pricirity | 1 - I
mnailbos: ID—
argll: IW
argl: W

@ TSk - Task Manag  Copy
-3 IO - Idle Functio Paste

ak I Cancel | Aipply | Help |

Insert Ohject, .,

[t

- Synchronization
t - Input/Cukput

Delete
Rename

® Property fvalue view

Shiow Dependency:

Managing SWI Priority

¢ Drag and Drop SWIs to change
priority

& Equal priority SWIs run in the
order that they are posted

ol x|
S| - Software [nterupt Manager objects by priority
{1 Priority 14 (Highest)

Instrumentation

EI!Q% Scheduling

[-£5 CLK - Clock Manager

EI@ PRD - Periodic Function Manager
E| M HWI - Hardware Interrupt Service Routine Manager
- e Interrupt Manager

i PRD_swi

EI@ T3k - Task Manager

-4 IDL - Idle Function Manager
[~ Synchronization

(-1 InpukyCutpuk

[0 Prioricy 13

[=1-{_1 Priority 0 {Reserved when T3K is enabled)
2B KML_swi
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Scheduling DSP/BIOS Threads

Priority Based Thread Scheduling

post3 rtn
HWI 2 TN 14

(highest) SWI_post(&swi2);
post2 rtn
HWI 1 IS

po§t1 rtn
SWI 3 [TINTTT1

int2 rtn
I R

SWI1 2 |

rtn
SWi1 [TTTTTTTITTTT

rtn
MAIN

intl
IDLE (IS T T T T T T T T T T T T T T T T T T T T I T T T I T T T TITT1]
(lowest)

[T}
User sets the priority...BIOS does the scheduling

Another Solution — Tasks (TSK)

main & DSP/BIOS tasks (TSK) are similar to SWI, but
{.. offer additional flexibility
g/ (LT 15O & SWIs must run to completion

¢ TSKs can be terminated by software
YDSP/BIOS | o Tradeoffs

X ¢ SWI context switch is faster than TSK

¢ TSK module requires more code space
Function 2 ¢ TSKs have their own stack

¢ User preference and system needs usually
dictates choice, easy to use both
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Scheduling DSP/BIOS Threads

SWis and TSKs

SWI SWI_post TSK SEM_post

start —
SEM_pend Pause
“run to (blocked
completion” — state)

+ Similar to hardware interrupt, + SEM_post() readies the TSK

but triggered by SWI_post() which pends on an event
+ All SWI's share system + The event triggers the TSK
software stack to run once and pend

¢ Each TSK has its own stack,
which allows them to pause
(or be terminated)

Priority

DSP/BIOS Thread Types

HWI + Used to implement ‘urgent’ part of real-time event
# Triggered by hardware interrupt
Hardware Interrupts | o Hw| priorities set by hardware

& Use SWI to perform HWI ‘follow-up' activity
SWI - .
& SWI's are 'posted' by software
Software Interrupts | o pyltiple SWis at each of 15 priority levels

TSK & Use TSK to run different programs concurrently
under separate contexts

Tasks & TSK's enabled by posting 'semaphore’ (a signal)

IDL & Multiple IDL functions
¢ Runs as an infinite loop, like traditional while loop
Background & All BIOS data transfers to host occur here
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Scheduling DSP/BIOS Threads

Enabling BIOS — Return from main()

main & Must delete the endless while() loop
{ ¢ main() returns to BIOS IDLE thread,
// return to BIOS allowing BIOS to schedule events,
} transfer info to host, etc.

¢ An endless while() loop in main()
will not allow BIOS to activate

%DSP BIOS

Function 2
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Periodic Functions

Periodic Functions

¢ Use the PRD Manager to specify the period (for the function) in ticks

¢ Allows multiple periodic functions with different rates

Periodic Functions

 tick
DSP/BIOS —
CLK
period |_| |—| |_|

LED LED LED

Periodic functions run at a specific rate in your system:
- e.g. LED blink requires 0.5 Hz

Use the CLK Manager to specify the DSP/BIOS CLK rate in
microseconds per “tick”

Creating a Periodic Function

 tick
DSP/BIOS =
CLK
period |_|

]

1

fuﬁcl

CLK - Clock Manager Properties

General |

Dbjsct Merory

¥ Enatile CLK Manager

¥ Use high resolution time for intemal timings

|M|croseconds.‘\nt: IWDDDDDDD I

fur=101

g Lab.cdb
Estimated D'ata Size: 948 Est. Min. Stack Si

@ Syskem

(2 Instrumentation
= 5 Scheduling
)

{5 CLK - Clock Manager mode Icont\nuous Ll
BED - Perind pckion Manager
I™ Directly configure an-chip timer registers . _LedBlink
= Fix TODR rupk Service aral) IUHUUUUUUUU
TOOR Fegist |2— 3 upk Manage
s & 7K - Task Manager il [o0000000
PADRegiver  [8885 .
. 0 I0L - Idle Function Manager il I—EDD il
Instructions/Int 150000 B Synchronization
(-8 Inputoutput
0K ]| Comeel | oo | ok | Concel | Apply |

fuﬁcl

LedBlink_PRD Properties

General I

comment

Ipanod[tlcks]: ISDU I
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Real-time Analysis Tools

Real-time Analysis Tools

ADC_swi

PRO_swi
KML_swi
SEM Posts

FRD Ticks
Time
Aszertions

LedBlink_PRD

Other Threads | ml m = = |

Built-in Real-Time Analysis Tools

& Gather data on target (3-10 CPU cycles)

¢ Send data during BIOS IDL (100s of cycles)
¢ Format data on host (1000s of cycles)

¢ Data gathering does NOT stop target CPU

+ Execution Graph

4|

CPU Load Graph

100%:

FEH

50%

25./D_
0%

=101

| Last 49.45% 00 | Peak: 49.43%

Execution Graph

¢ Software logic analyzer

¢ Debug event timing
and priority

CPU Load Graph

& Shows amount of CPU
horsepower being
consumed

Built-in Real-Time Analysis Tools

: Statistics View -0l x|
5TS | Count | Tatal | Max ‘ Avelage-r
LedBlink_PRD 1093 -1.3527e+003 2.1468Re+009 -1.2742e+006
PRD_swi 136725 264184161 inst 3192 inst 193223
ADC_swi 273452+ 13550754183 inst 3102 inst 49554
TSk _ide a Oinst -2147483648 inst ooo
IDL_busyObj 175701 -3.82691e+007 10 217.802

i Message Log =10] x|

Log Mame: Itrace 'I

16273 AdcSwi_count = 19480465
16274 AdcSwi_count = 19480466
16275 AdcSwi_count = 19480467
16276 AdcSwi_count = 13480468
16277 AdcSwi_count = 19480469
16278 AdcSwi_count = 13480470
16279 AdcSwi_count = 19480471
16280 AdcSwi_count = 19480472
2561 AdeSwi_count = 19532289
2662 AdcSwi_count = 19532250
2563 AdeSwi_count = 19532291
2664 AdcSwi_count = 19532252

Cammnn

i

=l

Statistics View
& Profile routines w/o

halting the CPU

Message LOG

L 4

cycle count

& More efficient than

traditional printf()

LOG_printf(&trace, "AdcSwi_count = %u", AdcSwi_count++);

Send debug msgs to host
& Doesn’t halt the DSP
& Deterministic, low DSP
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DSP/BIOS API Module and Summary
DSP/BIOS - API Modules

TSK Communication/Synchronization

Instrumentation/Real-Time Analysis

SEM | Semaphores manager
LOG | Message log manager MBX | Mailboxes manager
STS | Statistics accumulator manager LCK | Resource lock manager
TRC | Trace manager

RTDX| Real-Time Data eXchange manager

Device-Independent Input/Qutput

PIP Data pipe manager

HST | Host input/output manager
HWI | Hardware interrupt manager SIO | Stream l/O manager

SWI | Software interrupt manager DEV | Device driver interface
TSK | Multi-tasking manager

IDL Idle function & process loop manager

Thread Types

Memory and Low-Level Primitives

MEM | Memory manager

SYS | System services manager
CLK | System clock manager QUE | Queue manager

PRD | Periodic function manager ATM | Atomic functions

GBL | Global setting manager

Clock and Periodic Functions

Summary and Benefits of DSP/BIOS

¢ Fast time to market
+ no need to develop or maintain a “home-brew” kernel
¢ Efficient debugging of real-time applications
+ Real-Time Analysis
¢ Create robust applications
« industry proven kernel technology
¢ Reduce cost of software maintenance
« code reuse and standardized software
¢ Standardized APIs
« enable rapid migration across C28x TMS320 DSPs
¢ Small footprint (2-8Kw)
« easily fits in limited memory space
¢ Set of library functions (scalable)
« use only what is needed to minimize code and data size
¢ Full featured kernel (extensible)
« allows additional OS functions in future
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Lab 9: DSP/BIOS

» Objective

The objective of this lab is to apply the techniques discussed in module 9 and to become familiar
with DSP/BIOS. In this lab exercise, we are going to change the ADCINT_ISR HWI to a SWI.

Then, we will replace the LED blink routine with a Periodic Function. Also, some features of the
real-time analysis tools will be demonstrated.

Event Manager

Compare 1
PWM Circuits
Output Logic

Y

@

Lab 9: DSP/BIOS

ADC
ADCINAO | RESULTO
connector *
wire

ADC SOC every

GP Timer 2 triggers @
20 ps (50 kHz)

GP Timer 1 GP Timer 2
Objective:
¢ Change ADCINT_ISR
HWI to SWI

¢ Replace LED blink
routine with a
Periodic Function

pointer rewind

IQmath

FIR Filter

data
memory
CPU copies
result to
buffer during
- ADC ISR

—

Display
using CCS

» Procedure

Project File

Note: LABO9 files have been provided as a starting point for the lab and need to be

completed. DO NOT copy files from a previous lab.

1. A project named Lab9.pjt has been created for this lab. Open the project by clicking
onProject > Open.. and look in C:\C28x\LABS\LAB9. All Build Options
have been configured like the previous lab. The files used in this lab are:

Note: Due to a bug in CCS and DSP/BIOS, the configuration file name (.cdb) and the project
output (.out) and map (.map) names must be the same. Therefore, in this module the
Build Options output and map file names will be lab.out and map.out, respectively.

C28x - Using DSP/BIOS



Lab 9: DSP/BIOS

Main_9.c Labcfg.cmd

Lab.cdb DSP281x_Headers _B10S.cmd
User 8 9.cmd CodeStartBranch.asm
SysCtrl._c Gpio.c
DSP281x_GlobalVariableDefs.c PieCtrl 5 6 7 8 9.c
Defaultlsr_9 10.c Adc.c

Ev 7 8 9 10.c Filter.c

Add a SWI to main.c

2. Open Main_9.c and notice that space has been added at the end of main() for two new

functions which will be used in this module — AdcSwi() and LedBlink(). In the next few
steps, we will move part of the ADCINT _ISR() routine from Defaultlsr_9 10.cto
this space in Main_9.c.

Open Defaultlsr_9_10.c and locate the ADCINT_ISR() routine. Move the entire
contents of the ADCINT _ISR() routine to the AdcSwi() function in Main_9. c with the
following exceptions:

DO NOT MOVE:

e The instruction used to acknowledge the PIE group interrupt.
e The GPIO pin toggle code.
e The LED toggle code.

Be sure to move the static local variable declaration that is used to index into the ADC
buffers.

Comment: In almost all appplications, the PIE group acknowledge code is left in the HWI
(rather than move it to a SWI). This allows other interrupts to occur on that PIE group
even if the SWI has not yet executed. On the other hand, we are leaving the GPIO and
LED toggle code in the HWI just as an example. It illustrates that you can post a SWI
and also do additional operations in the HWI. DSP/BIOS is extremely flexible!

In the beginning of Defaultlsr_9 10.c, move the global variables, definition
statements and coefficients for the filter function to the beginning of Main_9.c.

Delete the interrupt key word from the ADCINT_ISR. The interrupt keyword is not
used when a HWI is under DSP/BIOS control. A HWI is under DSP/BIOS control when
it uses any DSP/BIOS functionality, such as posting a SWI, or calling any DSP/BIOS
function or macro.

In Main_9. c remove the in-line assembly code used to enable global interrupts.
DSP/BIOS will enable global interrupts after main().

In Main_9.c remove the while() loop (the endless loop). When using DSP/BIOS, you
must return from main(). DSP/BIOS will then take-over control of the software
execution.
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Post a SWiI

8. InDefaultlsr_9 10.c add the following SWI_post to the ADCINT_ISR(), just
after the structure used to acknowledge the PIE group:

SWI1_post(&ADC_swi); // post a SWI

This post a SWI that will execute the ADC_swi() code you populated a few steps back in
the lab. In other words, the ADC interrupt still executes the same code as before.
However, some of that code is now in a posted SWI that DSP/BIOS will execute
according to the specified scheduling priorities.

Add the SWI to the CDB File

9. In the configuration file Lab . cdb we need to add and setup the AdcSwi() SWI. Open
Lab.cdb and click on the plus sign (+) to the left of Schedul ing and again on the
plus sign (+) to the left of SWI — Software Interrupt Manager.

10. Rightclick on SWI — Software Interrupt Manager and select Insert SWI.
SWI0 will be added. Right-click on it, and rename it to ADC_swi. This is just an
arbitrary name. We want to differentiate the AdcSwi() function itself (which is nothing
but an ordinary C function) from the DSP/BIOS SWI object which we are calling
ADC_swi.

11. Select the Properties for ADC_swi and type _AdcSwi (with a leading underscore)
in the function field. Click OK. This tells DSP/BIOS that it should run the function
AdcSwi() when it executes the ADC_swi SWI.

12. We need to have the PIE for the ADC interrupt use the dispatcher. The dispatcher will
automatically perform the context save and restore, and allow the DSP/BIOS scheduler to
have insight into the ISR. You may recall from an earlier lab that the ADC interrupt is
located at PIE_INT1_6.

Click on the plus sign (+) to the left of HWl — Hardware Interrupt Service
Routine Manager. Click the plus sign (+) to the left of PIE INTERRUPTS. Locate
the interrupt location for the ADC: PIE_INT1_6. Right click, select Properties, and
select the Dispatcher tab.

Now check the “Use Dispatcher” box and select OK. Close the configuration file
and click YES to save changes.

Build, Load, and Reset
13. Click the ““Bui 1d”” button to rebuild and load the project.

14. Reset the DSP.
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Run the Code — AdcSwi()

15. We will be running our code in real-time mode, and need to have our window
continuously refresh. Enable Real-time Mode and be sure that the Global
Continuous Refresh option has been checked.

Note: For the next step, check to be sure that the jumper wire connecting “VREFLO”
(pin # P9-18) to “GND” (pin # P9-17) and the wire connecting PWM1 (pin # P8-9) to
ADCINO (pin # P9-2) are still in place on the eZdsp™.

16. Run the code in real-time mode watch the window update. Verify that the ADC result
buffer contains updated values.

17. Open and setup a dual time graph to plot a 50-point window of the filtered and unfiltered
ADC results buffer. Click: View > Graph -> Time/Frequency.. and set the
following values:

Display Type Dual Time

Start Address — upper display | AdcBufFiltered
Start Address — lower display | AdcBuf

Acquisition Buffer Size 50

Display Data Size 50

DSP Data Type 32-bit signed integer
Q-value 24

Sampling Rate (Hz) 50000

Time Display Unit us

Select OK to save the graph options.

18. The graphical display should show the generated IQmath FIR filtered 2 kHz, 25% duty
cycle symmetric PWM waveform in the upper display and the unfiltered waveform
generated in the previous lab exercise in the lower display. The results should be the
same as the previous lab, but we are using a SWI rather than a HWI.

19. Fully halt the DSP (real-time mode) by using Debug -> Halt and then unchecking the
“Real-time mode”.

Add a Periodic Function

Recall that an instruction was used in the ADCINT_ISR to toggle the LED on the eZdsp™. This
instruction will be moved into a periodic function that will toggle the LED at the same rate.
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20. Open Defaultlsr_9 10.c and locate the ADCINT_ISR routine. Move the
instruction used to toggle the LED to the LedBlink() function in Main_9.c:

GpioDataRegs.GPFTOGGLE.bit.GPIOF14 = 1; // Toggle the pin

21. In the configuration file Lab . cdb we need to add and setup the LedBlink_PRD. Open
Lab.cdb and click on the plus sign (+) to the left of Schedull ing. Right click on
PRD — Periodic Function Manger and select Insert PRD. PRDO will be
added. Right-click on it and rename it to LedBlink_PRD.

22. Select the Properties for LedBlink PRD and type LedBlink (with a leading
underscore) in the function field. This tells DSP/BIOS to run the LedBlink() function
when it executesd the LedBlilnk_PRD periodic function object.

Next, in the period (ticks) field type 500. Click OK. Close the configuration file and
click YES to save changes.

Build and Load

23. Click the ““Bui 1d”” button to rebuild and load the project.

24. Reset the DSP.

Run the Code — LedBlink

25. Run the code and check to see if the LED on the eZdsp™ is blinking. When done, halt
the code. If you would like, experiment with different period (tick) values and notice that
the blink rate changes.

DSP/BIOS — Real-time Analysis

The DSP/BIOS analysis tools complement the CCS environment by enabling real-time program
analysis of a DSP/BIOS application. You can visually monitor a DSP application as it runs with
essentially no impact on the application’s real-time performance. In CCS, the DSP/BIOS
analysis tools are found on the DSP/BIOS menu. Unlike traditional debugging, which is external
to the executing program, DSP/BIOS program analysis requires that the target program be
instrumented with analysis code. By using DSP/BIOS APIs and objects, developers
automatically instrument the target for capturing and uploading real-time information to CCS
using these tools.

26. Open the CPU load graph. On the menu bar click:
DSP/BIOS - CPU Load Graph

The CPU load graph displays the percentage of available CPU computing horsepower
that the application is consuming. The CPU may be running ISRs, software interrupts,
periodic functions, performing I/0O with the host, or running any user routine. When the
CPU is not executing user code, it will be idle (in the DSP/BIOS idle thread). You will
notice that we are consuming about 50% of the CPU with our lab code.
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217.

28.

29.

30.

31.

32.

33.

34.

35.

Next, open the execution graph. On the menu bar click:
DSP/BIOS - Execution Graph

The execution graph is a special graph used to display information about different threads
in the system and when they occur relative to the other events. This graph is not based on
time, but the activity of events (i.e. when an event happens, such as a SWI or periodic
function begins execution). You can enable or disable logging for each of the object
types using the RTA Control Panel (DSP/BIOS > RTA Control Panel). Note
that the execution graph simply records DSP/BIOS CLK events along with other system
events (the DSP/BIOS clock periodically triggers the DSP/BIOS scheduler). As a result,
the time scale on the execution graph is not linear.

Halt the DSP.

In the next few steps the Log Event Manager will be setup to capture an event in real-
time while the program executes. We will be using Log_printFf() to write to a log
buffer. The LOG_printf() function is a very efficient means of sending a message
from the code to the CCS display. Unlike an ordinary C-language printf(), which can
consume several hundred DSP cycles to format the data on the DSP before transmission
to the CCS host PC, a log_printf() transmits the raw data to the host. The host then
formats the data and displays it in CCS. This consumes only 10’s of cycles rather than
100’s of cycles.

Add the following to Main_9. c just after the static local variable declaration in
AdcSwi():

static Uint32 AdcSwi_count=0; // used for LOG printf
/*** Using LOG_printf() to write to a log buffer ***/

LOG_printf(&trace, "AdcSwi_count = %u', AdcSwi_count++);

In the configuration file Lab . cdb we need to add and setup the trace buffer. Open
Lab.cdb and click on the plus sign (+) to the left of Instrumentation and again on
the plus sign (+) to the left of LOG — Event Log Manager.

Right click on LOG — Event Log Manager and select Insert LOG. LOGO will
be added. Right-click on it and rename it to trace.

Select the Properties for trace and set the logtype to circular and the datatype to
printf. Click OK.

Since the configuration file was modified, we need to rebuild the project. Click the
“Bui 1d” button.

Reset the DSP.
Open the Message Log by clicking:

DSP/BI0S -> Message Log
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The message log dialog box is displaying the number of times (count value) that
AdcSwi() has executed.

36. Run the DSP.

37. Observe the operation of the various windows that are open, and the information that they
are conveying in real-time.

Note: In this module only the basic features of DSP/BIOS and the real-time analysis tools have
been used. For more information and details, please refer to the DSP/BIOS user’s
manuals and other DSP/BIOS related training.

End of Exercise
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System Design

Introduction

This module discusses various aspects of system design. Details of the emulation and analysis
block along with JTAG will be discussed and the external interface will be explored. Flash
memory programming and the Code Security Module will be described.

Learning Objectives

Learning Objectives

¢ Emulation and Analysis Block

¢ External Interface (XINTF)

¢ Flash Configuration and
Memory Performance

¢ Flash Programming

¢ Code Security Module (CSM)
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Module Topics
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Emulation and Analysis Block

JTAG Emulation System
(based on IEEE 1149.1 Standard)

System Under Test

SCAN IN

Emulator TMS320F2812
Pod e R

Taxos Instrumants

*

Some Available Emulators

Spectrum Digital XDS510PP+
Spectrum Digital XDS510USB TMS320F2812
Spectrum Digital PCI
BlackHawk USB

DSP Research PCI *ip

SCAN OUT

Texas Instruments

eZdsp™ has XDS510PP+ on the board

Connections Between Emulator and
vee Target
T R Vce
JTAG Device % % % % Emulator Header
EMUO|—s 13| Emuo PD [
14
EMU1 EMU1
- ol —— 4
TRST TRST GND
TMS—< Y rms GND |8
8
TDI—< 3! 1 GND
10
TDO > "l 1o GND
11 12
TCK > TCK GND
9
LF TCK_RET '
GND
-= If distance between device and header is greater than 6 inches
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Multiprocessor Connections
JTAG Device JTAG Device
1 TDO TDI ] TDO TDI [ Vee
95533 | 25f3s ]
E 8 E w w E (I—) E W w Emulator Header
| % J |'> 13 | Emuo PD [
~_ 14
% | > EMU1
2 | —— 4
$ TRST GND
1 6
§ <,| ™S GND
8
<‘, 3 | 1pi GND
g |'> " oo D [0
P \, o I
TCK_RET GND

On-Chip Emulation Analysis Block:
Capabilities

Two hardware analysis units can be configured to provide
any one of the following advanced debug features:

Analysis Configuration

Debug Activity

2 Hardware Breakpoints —»> Halton aspecified instruction
(for debugging in Flash)

2 Address Watchpoints —> Amemory location is getting
corrupted. Halt the processor when
any value is written to this location

1 Address Watchpoint with Data ——» Halt program execution after a
specific value is written to a variable

1 Pair Chained Breakpoints —> Halt on a specified instruction only

after some other specific routine has
executed

10-4

C28x - System Design



Emulation and Analysis Block

On-Chip Emulation Analysis Block:
Hardware Breakpoints

Analysis Unit 1 [ x]

Instuction Breakpoint | Bus Address Montor | 1 32 Bit Counter | 216 Bit Counters | Action | /_ Sym bolic 3 rd
1 numeric address

Instruction breakpoints and don't car "
Mask value for

Frogram address or expression: | ADCINT_ISR L

[¥ Enabls AU breakpoint /’ S peCIfyI n g

Bit number: 219 15 " 7 : ok address ranges
Binary representation: 111111 1001 0011 0111 0100

Don't cares:

Chained breakpoi
I™ Chain breakpoints (il enable AUZ breakpoint]
™ Clear mark tag

Start address (4U2): |9

Erd address [AUTE _ADCINT_ISR \

[——~—— Chained
breakpoint
selection

Ok | Cancel Help

On-Chip Emulation Analysis Block:
Watchpoints

Analysis Unit 1

.
Instuction Breakpoint Bus Address Moniter | 1 32 Bit Counter | 216 Bt Counters | Action | ‘/_ Sym bolic or

numeric address

~ Maonitor

Bus addiess and don't cai —

: = Mask value for
Bus addiess or expression: |_40DC_buf

A specifying
Bit number FARRE 15 i 7 R g
Binary representation: 00 0000 1001 0100 11000110 address ranges
Dion't cares: [T ITTT T [TTT [T MM

Watch for
’Vf" Data memory reads & Data memory wites 4e_’——-__-— B us s e| ection

€ Program memory reads  { Program memory wiites

™ Watch for bus data contents (requires AUIZ) \

———— Address with Data
selection

0k | Cancel Help
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On-Chip Emulation Analysis Block:
Online Stack Overflow Detection

¢ Emulation analysis registers are accessible to code as well!
¢ Configure a watchpoint to monitor for writes near the end of

the stack

& Watchpoint triggers maskable RTOSINT interrupt

¢ Works with DSP/BIOS and non-DSP/BIOS
« See Tl application report SPRA820 for implementation details

Region of
memory
occupied
by the
stack

Stack grows
towards higher
memory
addresses

Data Memory

Monitor for data
writes in region near
the end of the stack
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External Interface (XINTF)

TMS320F2812 XINTF Memory Map

0x3D 7C00 reserved

0x3D 8000|  FLASH (128K) reserved

128-Bit Password :
Ox3F 8000 HO SARAM (8K) | i

0x3F A000 reserved
0x3F FO00| Boot ROM 64K)
MP/MC=

XINT Zone 7 (16K) | Ox3F C000
MP/MC=1
XINT Vector-RAM (32)
MP/MC=1 ENPIE=0

0x3F FFCO| BROM vector ES%)
MP/MC=0 ENPIE=

Data | Program : Data | Program :
0x00 00001 '\ SARAM (1K) |
0x0004001 11 SARAM (1K) |
0x00 0800 [ PF 0 (2K) | reserved | : eserved :
0x00 0DOOp|E yector : :

(252) reserved | = :

ENPIE=1 : 0x00 2000 =

0x00 1000 reserved ¢ | XINT Zone 0 (8K) 2000 -
0x00 6000| PF 2 (4K) | reserved | N_XINT Zone 1 (8K) {0x00 4000 :
0x00 7000 PF 1 (4K) | reserved | : i
0x00 8000 LO SARAM (4K) i reserved
0x00 9000 ; :

L1 SARAM (4K) | i 0x08 0000 §

¥ |_XINT Zone 2 (0.5M) H

XD Ao SRR 2 [ XINT Zone 6 (0.5M) | 0x10 0000 £
X h b H
OTP (1K) : 0x18 0000 :

F2812 External Interface (XINTF) Signals
XD{15:0) Data Bus
XA(18:0) Address Bus
—.m XINTF Zone 0 and 1 Chip Select
_XZCS2 | XINTF Zone 2 Chip Select
. —.XZ(%NW XINTF Zone 6 and 7 Chip Select
Write Enable Strobe
XRD Read Enable Strobe
XRIW Read Not Write Strobe
XREADY Ready (Hardware Waitstates)
XMP/MC Microprocessor/Microcomputer Mode

C28x - System Design
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F2812 XINTF Timings

¢ Five external zones: 0,1, 2,6, 7
¢ Each zone has separate read and write timings
¢ XREADY signal can be used to extend ACTIVE phase
—! XRDLEAD | +—— XRDACTIVE —* ! XRDTRAIL | +—
XZCS \i DSP latches data—\ i/
' ! \: 1
XRD § \ i §
XA[18:0] X X ! valid address i i
XD[15:0] >< >< vaiid data
§ {«<—— SRAM —i | §
: : ta(A) : :
Read Timing
XINTF Clocking
XTIMINGO
XTIMING1
XTIMING2 Lead/Active/Trail
XTIMING6
XTIMING7
XBANK
C28x | syscikouTt I TTN XTIMCLK — (é(llNKE)(fzﬁzit)
CPU o —{/2 1
0 = —_—
0 XCLKOUT
XTIMCLK b1t XINTCNE?
( (CLKMODE bhit)

¢ Specify read timing and write timing separately, for
each zone:

Lead: 0-3 XTIMCLK Cycles
Active: 1-7 XTIMCLK Cycles
Trail:  0-3 XTIMCLK Cycles

¢ Each zone has a X2TIMING bit that can double the
timing values (both read and write affected)
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XINTF Registers
(lab file: Xintf.c)
Name Address Size (x16) | Description
XTIMINGO 0x00 0B20 2 XINTF Zone 0 Timing Register
XTIMING1 0x00 0B22 2 XINTF Zone 1 Timing Register
XTIMING2 0x00 0B24 2 XINTF Zone 2 Timing Register
XTIMING6 0x00 0B2C 2 XINTF Zone 6 Timing Register
XTIMING7 0x00 0B2E 2 XINTF Zone 7 Timing Register
XINTCNF2 0x00 0B34 2 XINTF Configuration Register
XBANK 0x00 0B38 2 XINTF Bank Control Register
¢ XTIMINGX specifies read (lead, active, trail), write
(lead, active, trail), X2TIMING, and use XREADY
¢ XINTCNF2 selects fundamental clock XTIMCLK (for
lead, active, trail), CLKMODE and CLKOFF
¢ XBANK specifies the number of XTIMCLK cycles to
add between two specified zone (bank switching)

Configuring XINTF with Header Files

XINTCNF2 example: Timing for all zones based on XTIMCLK = SYSCLKOUT/2

XintfRegs.XINTCNF2.bit . XTIMCLK = 1;
XintfRegs.XINTCNF2.bit.CLKOFF = 0;
XintfRegs . XINTCNF2.bit.CLKMODE = 1;

// XTIMCLK = SYSCLKOUT/2
// XCLKOUT is enabled
// XCLKOUT = XTIMCLK/2

Zone write and read timing example:

XintfRegs . XTIMINGO.bit.XWRLEAD = 1;
XintfRegs.XTIMINGO.bit.XWRACTIVE = 2;
XintfRegs . XTIMINGO.bit.XWRTRAIL = O;
XintfRegs.XTIMINGO.bit.XRDLEAD = 1;
XintfRegs.XTIMINGO.bit.XRDACTIVE = 3;
XintfRegs . XTIMINGO.bit.XRDTRAIL = 1;

Bank switching example: Suppose the external device in zone 7 is slow
getting off the bus; Add 3 additional cycles when switching from zone 7 to
another zone to avoid bus contention

XintfRegs.XBANK.bit.BANK = 7;
XintfRegs.XBANK.bit.BCYC = 3;

C28x - System Design
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Flash Configuration and Memory Performance

Basic Flash Operation

Flash is arranged in pages of 2048 bits

¢ Wait states are specified for consecutive accesses without a page,
and random accesses across pages

¢ OTP has random access only

¢ Must specify the number of SYSCLKOUT wait-states Reset defaults
are maximum values

¢ Flash configuration code should not be run from the Flash memory

*

FBANKWAIT 15 12 11 8 7 4 3 0
@ 0x00 0A86 reserved PAGEWAIT reserved RANDWAIT
FOTPWAIT 15 4 3 0
@ 0x00 0A87 reserved OTPWAIT

*** Refer to the F281x datasheet for detailed numbers ***
For 150 MHz, PAGEWAIT =5, RANDWAIT =5, OTPWAIT =8
For 135 MHz, PAGEWAIT = 4, RANDWAIT =4, OTPWAIT =8

Speeding Up Code Execution in Flash:
Flash Pipelining (for code fetch only)
k— 16—
16 or 32
1 64 | dispatched
64 C28x Core
decoder unit
Aligned 2-level deep
64-bit fetch buffer
fetch
Flash Pipeline Enable
0 = disable (default)
1 =enable
FOPT @ 0x00 0A80
15 1 0
reserved ENPIPE
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Other Flash Configuration Registers

Address | Name Description

0x00 0A80| FOPT Flash option register

0x00 0A82 | FPWR Flash power modes registers
0x00 OA83 | FSTATUS Flash status register

0x00 0A84 | FSTDBYWAIT | Flash sleep to standby wait register
0x00 OA85 | FACTIVEWAIT | Flash standby to active wait register
0x00 0A86 | FBANKWAIT Flash read access wait state register
0x00 0A87 | FOTPWAIT OTP read access wait state register

¢ FPWR: Save power by putting Flash/OTP to ‘Sleep’ or ‘Standby’
mode; Flash will automatically enter active mode if a Flash/OTP
access is made

FSTATUS: Various status bits (e.g. PWR mode)

¢ FSTDBYWAIT: Specify number of cycles to wait during wake-up
from sleep to standby

¢ FACTIVEWAIT: Specify number of cycles to wait during wake-up
from standby to active

L 2

Defaults for these registers are often sufficient — See “TMS320F28x DSP
System Control and Interrupts Reference Guide,” SPRUQ78, for more information

Code Execution Performance
& Assume 150 MHz SYSCLKOUT, 16-bit instructions

(80% of instructions are 16 bits wide — Rest are 32 bits)

Internal RAM: 150 MIPS
Fetch up to 32-bits every cycle = 1 instruction/cycle * 150 MHz = 150 MIPS

Flash (w/ pipelining): 100 MIPS

RANDWAIT =5

Fetch 64 bits every 6 cycles = 4 instructions/6 cycles * 150 MHz = 100 MIPS
RPT will increase this; PC discontinuity will degrade this

External SRAM (10 or 12 ns): 37.5 MIPS

XRDLEAD=1, XRDACTIVE=2, XRDTRAIL=0

Fetch 16 bits every 4 cycles = 1 instruction/4 cycles * 150 MHz = 37.5 MIPS
RPT will increase this

¢ Don’t put code in external memory!
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Data Access Performance
¢ Assume 150 MHz SYSCLKOUT (CPU clock)

Memory 16-bit access 32-bit access Notes
(words/cycle) | (words/cycle)

Internal RAM 1 1

Flash 0.167 0.167 AN =
Flash is read only!

Ext. SRAM 0.25 0.125 XRDLEAD =1,
XRDACTIVE =2,

(10 or 12 ns) XRDTRAIL =0

* 6 0 o

system

External RAM can outperform the flash on 16-bit data reads
Flash can outperform the external RAM on 32-bit data reads
Flash performance usually sufficient for most constants and tables

For cost and power savings, and ease-of-design, use internal RAM
for time-critical constants before adding external memory to your

10-12
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Flash Programming

Flash Programming Basics

The DSP CPU itself performs the flash programming

The CPU executes Flash utility code from RAM that reads the
Flash data and writes it into the Flash

We need to get the Flash utility code and the Flash data into RAM

F28x DSP

FLASH @ CPU

————->|Emu|ator |—-> JTAG I- -------- > RAM
>[Rs232 |- > 8CI f-o i ;

------------ » SPI --98%--——

———————————— > GPIO i__—" @

*

Flash Programming Basics

Sequence of steps for Flash programming:

Algorithm Function
1. Erase - Set all bits to zero, then to one
2. Program - Program selected bits with zero
3. Verify - Verify flash contents

Minimum Erase size is a sector
Minimum Program size is a bit!

Important not to lose power during erase step:
If CSM passwords hapPen to be all zeros, the
CSM will be permanently locked!

Chance of this happeningbis gquite small! (Erase
step is performed sector by sector)

C28x - System Design
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Flash Programming Utilities

L R 4

Code Composer Studio Plug-in (uses JTAG) *
Serial Flash loader from Tl (uses SCI boot) *
Gang Programmers (use GPIO boot)

+ BP Micro programmer
+ Data I/O programmer

Build your own custom utility
+ Use a different ROM bootloader method than SCI
+ Embed flash programming into your application

« Flash APl algorithms provided by Ti

* Available from Tl web at www.ti.com

Code Composer Studio Flash Plug-In

On-Chip Flash Programmer

r— Cloclk Canfiguration

A

~ Erase Sector Selection

e EC I¥ Sectord: [3FEOD0BFTFFF) ¥ SectorF: (3E4000-3E7FFF)
I¥ Sector B [3F4000FSFFF) ¥ Sector G- (3E0000-3E3FFF)
PLLER Yalue: m - [V SectorC [3FOD00-3F3FFF] ¥ Sector H: [3DCO0D-30FFFF)
¥ SectorD: [3ECO00-3EFFFF) ¥ Sectorl: (3DA000-3DBFFF)
SYSCLEOUT [MHz): [150.0000 ¥ Sector £ [JEAO00OEBFFF] W Sector): [ADE000-309FFF)
r— Code Security Pazsward — Operation

Key7 (0w€7:  [FFFF
Key (06} [FFFF
Key5(0:4E5)  [FFFF
Koy 4 [IRAE4): W
Key3(0:4E3)  [FFFF
Key2 (DAE2):  [FFFF
Key1(0wETE [FFFF
Key D (DAED:  [FFFF

Unlack | Lock. |
Program Password |

Flazh Pragrammer Settings...

Please specify the COFF file to Program Y erify:
|C:CZBK\LABS\Lab1 0hDebughlab.out

Browse I

=" Erase, Program, Verify  ( Load RAM Orly

" Erase Orly  Fraquency Test

" Frogram, Werify Register: IGF‘AMux 'I
" Program Only Fire  [Pwhd1 (0] -
 Werify Orly

€ Caleulate Checksums

Flash Random Wait State: |15 ¥

Flash:
Flash Page Wait State: 15 = oTE: T
OTP Walt State: ELI Flash+0TF:

Execute Operation Help
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Code Security Module (CSM)

Code Security Module (CSM)

¢ Access to the following on-chip memory is

restricted:

0x00 8000 ) 5 SARAM (4K)
0x00 90001 ) 1 SARAM (4K)
0x00 A000 reserved
0x3D 7800 OTP (1K)
0x3D 7C00 reserved
0x3D 8000

FLASH (128K)

¢ Datareads and writes from restricted memory
are only allowed for code running from
restricted memory

& All other data read/write accesses are blocked:

JTAG emulator/debugger, ROM bootloader, code running in
external memory or unrestricted internal memory

CSM Password

0x00 8000

LO SARAM (4K)

0x00 9000

L1 SARAM (4K)

0x00 A00O0

reserved

0x3D 7800

0x3D 7C00

0x3D 8000

OTP (1K)
reserved
FLASH (128K)

128-Bit Password

CSM Password
Locations (PWL)

O0x3F 7FF8 - Ox3F 7FFF

¢ 128-bit user defined password is stored in Flash

¢ 128-bit Key Register used to lock and unlock the
device
+ Mapped in memory space 0x00 OAEO — 0x00 OAE7

+ Register “EALLOW" protected

C28x - System Design
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CSM Registers

Key Registers — accessible by user; EALLOW protected

Address Name Reset Value Description

0x00 OAEOQO|KEYO OxFFFF Low word of 128-bit Key register
0x00 OAE1|KEY1 OxFFFF 2nd word of 128-bit Key register
0x00 OAE2 | KEY2 OxXFFFF 34 word of 128-bit Key register
0x00 OAE3|KEY3 OxXFFFF 4th word of 128-bit Key register
0x00 OAE4|KEY4 OxFFFF 5th word of 128-bit Key register
0x00 OAE5| KEY5 OxFFFF 6th word of 128-bit Key register
0x00 OAE6 | KEY6 OxXFFFF 7th word of 128-bit Key register
0x00 OAE7|KEY7 OxFFFF High word of 128-bit Key register
0x00 OAEF| CSMSCR | OxFFFF CSM status and control register
PWL in memory — reserved for passwords only

Address Name Reset Value Description

0x3F 7FF8 | PWLO user defined Low word of 128-bit password
0x3F 7FF9 | PWL1 user defined 2nd word of 128-bit password
0x3F 7FFA| PWL2 user defined 3d word of 128-bit password
0x3F 7FFB| PWL3 user defined 4th word of 128-bit password
0x3F 7FFC| PWL4 user defined 5t word of 128-bit password
0x3F 7FFD| PWL5 user defined 6th word of 128-bit password
0x3F 7FFE| PWL6 user defined 7th word of 128-bit password
0x3F 7FFF | PWL7 user defined High word of 128-bit password

Locking and Unlocking the CSM

¢ The CSMis locked at power-up and reset

¢ To unlock the CSM:

+ Perform a dummy read of each password in
the Flash

+ Write the correct passwords to the key
registers

¢ New Flash Devices (PWL are all OxFFFF):

+ When all passwords are OxFFFF — only a
read of the PWL is required to bring the
device into unlocked mode

10-16
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Code Security Module (CSM)

CSM Caveats

¢ Never program all the PWL’s as 0x0000
+ Doing so will permanently lock the CSM
¢ Flash addresses 0x3F7F80 to Ox3F7FF5,

inclusive, must be programmed to 0x0000 to
securely lock the CSM

¢ Remember that code running in unsecured
RAM cannot access data in secured memory

« Don’'t link the stack to secured RAM if you have
any code that runs from unsecured RAM

¢ Do not embed the passwords in your code!
+ Generally, the CSM is unlocked only for debug
+ Code Composer Studio can do the unlocking

Start

Flash device
secure after
reset or runtime

Do dummy read of PWL|

0x3F 7FF8 — Ox3F 7FFH

I (EALLOW) protected

CSM Password Match Flow

Device permanently locked

CPU access is limited —
device cannot be debugged
or reprogrammed

Write password to KEY registers
— 0x00 OAEO — 0x00 OAE7

Device unlocked

User can access on-
chip secure memory

Correct Yes

password?

C28x - System Design
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Code Security Module (CSM)

CSM C-Code Examples

Unlocking the CSM:

volatile int *PWL = &CsmPwl.PSWDO; //Pointer to PWL register file
volatile int i, tmp;

for (i = 0; i<8; i++) tmp = *PWL++; //Dummy reads of PWL locations

asm (’ EALLOW™); //KEY regs are EALLOW protected
CsmRegs.KEYO = PASSWORDO; //\Write the passwords
CsmRegs.KEY1 = PASSWORDO; //to the Key registers
CsmRegs.KEY2 = PASSWORD2;

CsmRegs.KEY3 = PASSWORD3;

CsmRegs.KEY4 = PASSWORD4;

CsmRegs.KEY5 = PASSWORDS5;

CsmRegs.KEY6 = PASSWORDG6 ;

CsmRegs.KEY7 = PASSWORD7;

asm (’ EDIS”);

Locking the CSM:

asm(’ EALLOW™); //CSMSCR reg is EALLOW protected
CsmRegs.CSMSCR.bit.FORCESEC = 1; //Set FORCESEC bit

asm (PEDIS™);
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Lab 10: Programming the Flash

Lab 10: Programming the Flash

» Objective

The objective of this lab is to use the techniques discussed in module 10 and program the on-chip
flash memory. The TMS320F2812 device has been designed for standalone operation in an
embedded system. Using the on-chip flash eliminates the need for external non-volatile memory
or a host processor from which to bootload. In this lab, the steps required to properly configure
the software for execution from internal flash memory will be covered.

Event Manager

Compare 1
PWM Circuits
OQutput Logic

[

GP Timer 1

Objective:

Plug-in

ADC

ADCINAO | RESULTO

Lab 10: Programming the Flash

connector +
wire 0
GP Timer 2 triggers
ADC SOC every
20 ps (50 kHz)
GP Timer 2

¢ Program system into Flash
Memory

& Learn use of CCS Flash

¢ DO NOT PROGRAM

PASSWORDS

pointer rewind

IQmath
FIR Filter

data
memory

CPU copies
resultto
buffer during
ADC ISR

Display
using CCS

» Procedure

Project File

Note: LAB1O files have been provided as a starting point for the lab and need to be

completed. DO NOT copy files from a previous lab.

1. A project named Lab1O.pjt has been created for this lab. Open the project by
clicking on Project -> Open.. and look in C:\C28x\LABS\LAB10. All Build
Options have been configured like the previous lab. The files used in this lab are:

Note: Due to a bug in CCS and DSP/BIOS, the configuration file name (.cdb) and the project
output (.out) and map (.map) names must be the same. Therefore, in this module the
Build Options output and map file names will be lab.out and map.out, respectively.

C28x - System Design
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Main_10.c Labcfg.cmd

Lab.cdb DSP281x_Headers _B10S.cmd
User_10.cmd CodeStartBranch.asm
SysCtrl.c Gpio.c
DSP281x_GlobalVariableDefs.c PieCtrl_10.c
Defaultlsr_9 10.c Adc.c

Ev 7 8 9 10.c Filter.c

Link Initialized Sections to Flash

Initialized sections, such as code and constants, must contain valid values at device power-up.
For a stand-alone embedded system with the F2812 device, these initialized sections must be
linked to the on-chip flash memory. Note that a stand-alone embedded system must operate
without an emulator or debugger in use, and no host processor is used to perform bootloading.

Each initialized section actually has two addresses associated with it. First, it has a LOAD
address which is the address to which it gets loaded at load time (or at flash programming time).
Second, it has a RUN address which is the address from which the section is accessed at runtime.
The linker assigns both addresses to the section. Most initialized sections can have the same
LOAD and RUN address in the flash. However, some initialized sections need to be loaded to
flash, but then run from RAM. This is required, for example, if the contents of the section needs
to be modified at runtime by the code.

2. This step assigns the RUN address of those sections that need to run from flash. Using
the memory section manager in the DSP/BIOS configuration tool (Lab . cdb) link the
following sections to on-chip flash memory:

DSP/BIOS Datatab | DSP/BIOS Code tab | Compiler Sections tab

.gblinit .bios text
.Sysinit .switch
hwi .cinit
rtdx_text pinit

.econst / .const

.data

3. This step assigns the LOAD address of those sections that need to load to flash. Again
using the memory section manager in the DSP/BIOS configuration tool (Lab . cdb),
select the Load Address tab and check the “Specify Separate Load
Addresses” box. Then set all entries to the flash memory block.

10-20
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Copying .hwi_vec Section from Flash to RAM

The DSP/BIOS .hwi_vec section contains the interrupt vectors. This section must be loaded to
flash (load address) but run from RAM (run address). The code that performs this copy is located
in InitPieCtrl(). The DSP/BIOS configuration tool generates global symbols that can be accessed
by code in order to determine the load address, run address, and length of the .hwi_vec section.
The C-compiler runtime support library contains a memory copy function called memcpy() which
will be used to perform the copy.

4. Open and inspect InitPieCtrl() (in PieCtrl_10.c file). Notice the memcpy() function
and the symbols used to initialize (copy) the .hwi_vec section.

Copying the .trcdata Section from Flash to RAM

The DSP/BIOS .trcdata section is used by CCS and DSP/BIOS for certain real-time debugging
features. This section must be loaded to flash (load address) but run from RAM (run address).
The DSP/BIOS configuration tool generates global symbols that can be accessed by code in order
to determine the load address, run address, and length of the .trcdata section. The memory copy
function memcpy() will again be used to perform the copy.

The copying of .trcdata must be performed prior to main(). This is because DSP/BIOS modifies
the contents of .trcdata during DSP/BIOS initialization, which also occurs prior to main(). The
DSP/BIOS configuration tool provides a user initialization function which will be used to
perform the .trcdata section copy prior to both main() and DSP/BIQS initialization.

5. Open and inspect the file Main_10.c. Notice that the function User Init() is used
to copy the .trcdata section from its load address to its run address before main().

6. Open the DSP/BIOS configuration file (Lab . cdb) and select the Properties for the
Global Settings. Checkthe box “Call User Init Function’ and enter
the UserInit() function name with a leading underscore: _UserlInit.

Initializing the Flash Control Registers

The initialization code for the flash control registers cannot execute from the flash memory (since
it is changing the flash configuration!). Therefore, the initialization function for the flash control
registers must be copied from flash (load address) to RAM (run address) at runtime. The memory
copy function memcpy() will again be used to perform the copy. The initialization code for the
flash control registers InitFlash() is located in the Flash. c file.

7. Add Flash.c to the project.

8. Open and inspect Flash.c. The C compiler CODE_SECTION pragma is used to place
the InitFlash() function into a linkable section named ““secureRamFuncs”.

9. Since the DSP/BIOS configuration tool does not know about user defined sections, the
“secureRamFuncs” section will be linked using the user linker command file
User_10.cmd. Open and inspect User_10.cmd. The “secureRamFuncs™ will
load to flash (load address) but will run from LLSARAM (run address). Also notice that
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the linker has been asked to generate symbols for the load start, load end, and run start
addresses.

While not a requirement from a DSP hardware perspective (since the C28x DSP has a
unified memory architecture). Code Composer Studio generally prefers code to be linked
to program space (and data to be linked to data space). Therefore, notice that for the
L1SARAM memory we are linking “secureRamFuncs” to, we are specifiying
“PAGE = 0”(which is program space). The LISARAM memory is currently defined in
data space in the Lab . cdb, but in the next step we will redefine it to exist in the
program space.

10. Using the DSP/BIOS configuration tool (Lab . cdb) modify the entry for LISARAM so
that it is defined in the program space (code).

11. Open and inspect Main_10.c. Notice that the memory copy function memcpy() is
being used to copy the section “secureRamFuncs, which contains the initialization
function for the flash control registers.

12. Add a line of code to main() to call the InitFlash() function. There are no passed
parameters or return values. You just type

InitFlash(Q);

at the desired spot in main().

Code Security Module and Passwords

The CSM module provides protection against unwanted copying (i.e. pirating!) of your code from
flash, OTP memory, and the LO and L1 RAM blocks. The CSM uses a 128-bit password made
up of 8 individual 16-bit words. They are located in flash at addresses Ox3F7FF8 to Ox3F7FFF.
During this lab, dummy passwords of OxFFFF will be used — therefore only dummy reads of the
password locations are needed to unsecure the CSM. DO NOT PROGRAM ANY REAL
PASSWORDS INTO THE DEVICE. After development, real passwords are typically placed in
the password locations to protect your code. We will not be using real passwords in the
workshop.

The CSM module also requires programming values of 0x0000 into flash addresses 0x3F7F80
through Ox3F7FF5 in order to properly secure the CSM. Both tasks will be accomplished using a
simple assembly language program Passwords.asm.

13. Add Passwords.asm to your CCS project.

14. Open and inspect Passwords.asm. This file specifies the desired password values
(DO NOT CHANGE THE VALUES FROM 0xFFFF) and places them in an initialized
section named “passwords™. It also creates an initialized section named
““csm_rsvd” which contains all 0x0000 values for locations 0x3F7F80 to 0x3F7FF5
(length of 0x76).

10 -22

C28x - System Design



Lab 10: Programming the Flash

15. Open User_10.cmd and notice that the initialized sections for ““passwords’ and
“csm_rsvd” are linked to memories named PASSWORDS and CSM_RSVD,
respectively.

16. Using the DSP/BIOS configuration tool (Lab . cdb) define memory blocks for
PASSWORDS and CSM_RSVD. You will need to setup the MEM Properties for each
memory block with the proper base address and length. Set the space to code for both
memory blocks. (Uncheck the “create a heap in this memory” box for each block). You
may also need to modify the existing flash memory block to avoid conflicts.

Executing from Flash after Reset

The F2812 device contains a ROM bootloader that will transfer code execution to the flash after
reset. When the boot mode selection pins are set for “Jump to Flash” mode, the bootloader will
branch to the instruction located at address Ox3F7FF6 in the flash. An instruction that branches
to the beginning of your program needs to be placed at this address. Note that the CSM
passwords begin at address Ox3F7FF8. There are exactly two words available to hold this branch
instruction, and not coincidentally, a long branch instruction “LB” in assembly code occupies
exactly two words. Generally, the branch instruction will branch to the start of the C-
environment initialization routine located in the C-compiler runtime support library. The entry
symbol for this routine is _c_int00. Recall that C code cannot be executed until this setup routine
is run. Therefore, assembly code must be used for the branch. We are using the assembly code
file named CodeStartBranch.asm.

17. Open and inspect CodeStartBranch.asm. This file creates an initialized section
named ““codestart” that contains a long branch to the C-environment setup routine.
This section needs to be placed in memory using the DSP/BIOS configuration tool.

18. Using the DSP/BIOS configuration tool (Lab . cdb) define a memory space named
BEGIN_FLASH.

19. Setup the MEM Properties with the proper base address, length, and space.
(Uncheck the “create a heap in this memory” box). Be sure to avoid memory section
conflicts.

20. In the earlier lab exercises, the section “codestart’ was directed to the memory
named BEGIN_HO. Open and modify User_10.cmd so that the section
“codestart” will be directed to BEGIN_FLASH.

21. The eZdsp™ board needs to be configured for “Jump to Flash” bootmode. Move jumper
JP7 to position 1-2 to accomplish this. This jumper controls the pullup/down resistor on
the GPIOF4 pin, which is one of the pins sampled by the bootloader to determine the
bootmode. GPIOF4 alone is sufficient to configure “Jump to Flash” bootmode (see the
TMS320F28x DSP Boot ROM Reference Guide, and also the eZdsp F2812 Technical
Reference, for more information).
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Build — Lab.out

22.

23.

At this point we need to build the project, but not have CCS automatically load it since
CCS cannot load code into the flash! (the flash must be programmed). On the menu bar
click: Option > Customize.. and select the ““Program Load Options” tab.
Uncheck “Load Program After Build”, then click OK.

Click the ““Bui 1d”” button to generate the Lab . out file to be used with the CCS Flash
Plug-in.

CCS Flash Plug-in

24.

25.

26.

27.

28.

29.

30

Open the Flash Plug-in tool by clicking :
Tools > F28xx On-Chip Flash Programmer

Notice that the eZdsp™ board uses a 30 MHz oscillator (located on the board near LEDs
DS1 and DS2). Confirm the “Clock Configuration” in the upper left corner has the
OSCCLK set to 30 MHz and the PLLCR value is set to 10. Recall that the PLL is
divided by two, which gives a SYSCLKOUT of 150 MHz.

Confirm that all boxes are checked in the “Erase Sector Selection” area of the plug-in
window. We want to erase all the flash sectors.

We will not be using the plug-in to program the “Code Security Password”. Do not
modify the Code Security Password fields.

In the “Operation” block, notice that the “COFF file to Program/Verify” field
automatically defaults to the current _out file. Check to be sure that “Erase, Program,
Verify” is selected. We will be using the default wait states, as shown on the slide in this
module.

Click “Execute Operation” to program the flash memory. Watch the programming status
update in the plug-in window.

After successfully programming the flash memory, close the programmer window.

Running the Code — Using CCS

31.

32.

In order to effectively debug with CCS, we need to load the symbolic debug information
(e.g., symbol and label addresses, source file links, etc.) so that CCS knows where
everything is in your code. Click:

File > Load Symbols - Load Symbols Only..

and select Lab . out in the Debug folder.

Reset the DSP. The program counter should now be at 0Ox3FFCO00, which is the start of
the bootloader in the Boot ROM.
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33. Single-Step through the bootloader code until you arrive at the beginning of the codestart
section in the CodeStartBranch.asm file. (Be patient, it will take about 55 single-
steps). Notice that we have placed some code in CodeStartBranch.asm to give an
option to first disable the watchdog, if selected.

34. Step a few more times until you reach the start of the C-compiler initialization routine at
the symbol _c_int0QO0.

35. Now do Debug > Go Main. The code should stop at the beginning of your main()
routine. If you got to that point succesfully, it confirms that the flash has been
programmed properly, and that the bootloader is properly configured for jump to flash
mode, and that the codestart section has been linked to the proper address.

36. You can now RUN the DSP, and you should observe the LED on the board blinking. Try

resetting the DSP and hitting RUN (without doing all the stepping and the Go Main
procedure). The LED should be blinking again.

Running the Code — Stand-alone Operation (No Emulator)

37. Close Code Composer Studio.

38. Disconnect the emulator from the eZdsp™ board.
39. Remove the power from the board.

40. Re-connect the power to the board.

41. The LED should be blinking, showing that the code is now running from flash memory.

End of Exercise
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Lab 10 Reference: BIOS Startup Sequence from Flash Memory

BIOS Startup Sequence from Flash Memory

”””””””” BIOS code Sections
0x3D 8000 _c_int00 BIOS_reset()
FLASH (128K) BIOS_init()
main ()
----------------------- BI <
— OX3F7FF6 | | LB OELSETIL)
e int00 —— oL
Passwords (8) @) )
0x3F 8000 HO SARAM (8K) | ™\ “rts2800_ml.lib”
<3> \\ “user” code sections 6)
N main ()
O0x3F FO00 | Boot ROM (4K) N {
Boot Code AN
0x3F FCOO0 \\ roturn:
{SCAN GPIO} AN } '
\
BROM vector (32) N

0x3F FFCO 0x3F FC00 —

RESET
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Communications

Introduction

The TMS320C28x contains features that allow several methods of communication and data
exchange between the C28x and other devices. Many of the most commonly used
communications techniques are presented in this module.

The intent of this module is not give to exhaustive design details of the communication
peripherals, but rather to provide an overview of the features and capabilities. Once these
features and capabilities are understood, additional information can be obtained from various
resources such as documentation, as needed. This module will cover the basic operation of the
communication peripherals, as well as some basic terms and how they work.

Learning Objectives

Learning Objectives

¢ Serial Peripheral Interface (SPI)

¢ Serial Communication Interface (SCI)
¢ Multi-Channel Buffered Serial Port (McBSP)

¢ Enhanced Controller Area Network (eCAN)
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Communications Techniques

Several methods of implementing a TMS320C28x communications system are possible. The
method selected for a particular design should reflect the method that meets the required data rate
at the lowest cost. Various categories of interface are available and are summarized in the
learning objective slide. Each will be described in this module.

Synchronous vs. Asynchronous

¢ SPI (synchronous) # SCI (asynchronous)

+ Short distances (on- + longer distances
board) + Lower data rate (= 1/8 of
+ High datarate SPI)

«+ Explicit clock . mggg? clock (clk/data

« Economical with
reasonable performance

C28x C28x

SPI " U2 E_D_T/T_

| Destination

¥

PCB PCB

Serial ports provide a simple, hardware-efficient means of high-level communication between
devices. Like the GPIO pins, they may be used in stand-alone or multiprocessing systems.

In a multiprocessing system, they are an excellent choice when both devices have an available
serial port and the data rate requirement is relatively low. Serial interface is even more desirable
when the devices are physically distant from each other because the inherently low number of
wires provides a simpler interconnection.

Serial ports require separate lines to implement, and they do not interfere in any way with the data
and address lines of the processor. The only overhead they require is to read/write new words
from/to the ports as each word is received/transmitted. This process can be performed as a short
interrupt service routine under hardware control, requiring only a few cycles to maintain.

The C28x family of devices have both a synchronous and asynchronous serial ports. Detailed
features and operation will be described next.
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Serial Peripheral Interface (SPI)

Serial Peripheral Interface (SPI)

The SPI module is a synchronous serial 1/0O port that shifts a serial bit stream of variable length
and data rate between the C28x and other peripheral devices. During data transfers, one SPI
device must be configured as the transfer MASTER, and all other devices configured as
SLAVES. The master drives the transfer clock signal for all SLAVES on the bus. SPI
communications can be implemented in any of three different modes:

e MASTER sends data, SLAVES send dummy data
¢ MASTER sends data, one SLAVE sends data
e MASTER sends dummy data, one SLAVE sends data

In its simplest form, the SPI can be thought of as a programmable shift register. Data is shifted in
and out of the SPI through the SPIDAT register. Data to be transmitted is written directly to the
SPIDAT register, and received data is latched into the SPIBUF register for reading by the CPU.
This allows for double-buffered receive operation, in that the CPU need not read the current
received data from SPIBUF before a new receive operation can be started. However, the CPU
must read SPIBUF before the new operation is complete of a receiver overrun error will occur. In
addition, double-buffered transmit is not supported: the current transmission must be complete
before the next data character is written to SPIDAT or the current transmission will be corrupted.

The Master can initiate a data transfer at any time because it controls the SPICLK signal. The
software, however, determines how the Master detects when the Slave is ready to broadcast.

SPI Data Flow

¢ Simultaneous transmits and receive
¢ SPI Master provides the clock signal

SPI Device #1 - Master SPI Device #2 - Slave
shift shift
_____________
| SPI Shift Register s | SPI Shift Register s
clock

11-4
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Serial Peripheral Interface (SPI)

SPI Block Diagram

C28x - SPI Master Mode Shown

RX FIFO_ 0

RX FIFO_15

SPIRXBUF.15-0

t

" SPIDAT.15-0

1. LsB

SPISIMO

SPISOMI

t

SPITXBUF.15-0

TXFIFO_ 0

TX FIFO_15

LSPCLK —

baud
rate

clock

clock

polarity

phase

SPICLK

SPI Transmit / Receive Sequence

1.

2.

Slave writes data to be sent to its shift register (SPIDAT)

Master writes data to be sent to its shift register (SPIDAT or SPITXBUF)

Completing Step 2 automatically starts SPICLK signal of the Master

MSB of the Master’s shift register (SPIDAT) is shifted out, and LSB of the Slave’s shift

register (SPIDAT) is loaded

Step 4 is repeated until specified number of bits are transmitted

SPIDAT register is copied to SPIRXBUF register

SPI'INT Flag bitis setto 1

An interrupt is asserted if SPI INT ENA bitis setto 1

If data is in SPITXBUF (either Slave or Master), it is loaded into SPIDAT and transmission
starts again as soon as the Master’s SPIDAT is loaded

C28x - Communications
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Serial Peripheral Interface (SPI)

Since data is shifted out of the SPIDAT register MSB first, transmission characters of less than 16
bits must be left-justified by the CPU software prior to be written to SPIDAT.

Received data is shifted into SPIDAT from the left, MSB first. However, the entire sixteen bits
of SPIDAT is copied into SPIBUF after the character transmission is complete such that received
characters of less than 16 bits will be right-justified in SPIBUF. The non-utilized higher
significance bits must be masked-off by the CPU software when it interprets the character. For
example, a 9 bit character transmission would require masking-off the 7 MSB’s.

SPI| Data Character Justification

¢ Programmable data
length of 1to 16 bits

'S E’r{anslrg Itt)t?d data:[ %f ||esf? SPIDAT - Processor #1
an ITS mMust be le

fhande, 11001001XXXXXXXX |

+MSB transmitted first

¢ Received data of less
than 16 bits are right
justified SPIDAT - Processor #2

XXXXXXXX11001001 I<—

& User software must
mask-off unused MSB’s

11-6
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Serial Peripheral Interface (SPI)

SPI Registers

15-8

SPI-A Configuration Control Register

SPICCR @ 0x007040

5-4 3

reserved

reserved

— CLOCK POLARITY
0 = rising edge data transfer
1 = falling edge data transfer

— SPI SW RESET
0 = SPI flags reset
1 = normal operation

SPI CHAR.3-0

character length = number + 1
e.g. 0000b = length =1
1111b = length = 16

SPI-A Operation Control Register

SPICTL @ 0x007041

0 =no CLK delay

OVERRUN INT ENABLE MASTER/SLAVE

0 = disabled 0 = slave SPIINT ENABLE
1 =enabled 1 = master 0 = disabled

| 1 =enabled

|
15-5 4 3 2 1 0
reserved
CLOCK PHASE TALK

1 = CLK delayed 1/2 cycle

0 = transmission disabled,
output pin hi-Z’d
1 = transmission enabled

C28x - Communications
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Serial Peripheral Interface (SPI)

SPI-A Baud Rate Register

SPIBRR @ 0x007044

Need to set this only when in master mode!

15-7 6-0
reserved SPI BIT RATE
_LSPCLK _  spIBRR=310127
(SPIBRR + 1)
SPICLK signal =
qu(, SPIBRR =0, 1, or 2

Baud Rate Determination: The Master specifies the communication baud rate using its baud rate
register (SPIBRR.6-0):

e For SPIBRR =310 127: SPI Baud Rate = % bits/sec
(SPIBRR +1)
e ForSPIBRR=0,1,0or2: SPIBaud Rate = w bits/sec

From the above equations, one can compute
Maximum data rate = 37.5 Mbps @ 150 MHz
(Note: 1/0 pin buffer speed is limited to 20 MHz maximum on the ‘C/F281x devices)

Character Length Determination: The Master and Slave must be configured for the same
transmission character length. This is done with bits 0, 1, 2 and 3 of the configuration control
register (SPICCR.3-0). These four bits produce a binary number, from which the character length
is computed as binary + 1 (e.g. SPICCR.3-0 = 0010 gives a character length of 3).

11-8
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Serial Peripheral Interface (SPI)

15-

SPI-A Status Register

SPISTS @ 0x007042

8

7

6

5

40

reserved

reserved

L TX BUF FULL (read only)
« Set to 1 when char written

to SPITXBUF

* Cleared when char in SPIDAT

SPI INT FLAG (read only)
« Set to 1 when transfer completed

« Interrupt requested if SPI INT ENA
bit set (SPICTL.0)

¢ Cleared by reading SPIBRXUF

RECEIVER OVERRUN (read/clear only)
« Set to 1 if next reception completes before SPIRXBUF read

* Interrupt requested if OVERRUN INT ENA bit set (SPICTL.4)
* Cleared by writing a 1

SPIFFTX @ 0x00704A

SPI-A FIFO Transmit Register

TX FIFO Status (read-only)

SPI FIFO TX FIFO Reset 00000 TX FIFO empty
0 = disable . 00010 TXFIFO has 2 words
1= enable 1 = enable operation 00011  TXFIFO has 3 words
\ / 10000  TX FIFO has 16 words
15 14 13 12 11 10 9 8 N
reserved |SPIFFEN TRXEFSIETO TXFFST4|TXFFST3|TXFFST2| TXFFST1{TXFFSTO
7 6 5 4 3 2 1 0
TXFFINT, TXCFE'LNT TXFFIEN| TXFFIL4| TXFFIL3| TXFFIL2| TXFFILL | TXFFILO
/N ;
TXFIFO TXFIFO TXFIFO TX FIFO Interrupt Level
Interrupt Interrupt Interrupt | hen TXFESTA-0
Flag (read-only) Flag Clear  (on match) nt;rruptw eno N
0=not occurred 0 = no effect Enable and TXFFIL4-0 matc
1 = occurred 1 =clear 0 = disable
1 =enable

C28x - Communications
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Serial Peripheral Interface (SPI)

RX FIFO RX FIFO
Overflow Overflow RX FIFO Reset 00000 RX FIFO empty
) 00001 RX FIFO has 1 word
Flag (read-only) Flag Clear 0 = reset (pointer to 0) 00010  RX FIFO has 2 words
0=nooverflow O=noeffect 7 =enableoperation 00011  RXFIFO has 3 words
1 = overflow 1 =clear : : :
\ 10000 RX FIFO has 16 words
15 14 13 7 12 11 10 9 8
RXFF- | RXFF- [RXFIFO
OVE  love cLrl RESET [RXFFST4[RXFFST3|RXFFST2|RXFFSTLRXFFSTO
7 6 5 4 3 2 1 0
RXFFINT RXCFE"QNT RXFFIEN|RXFFIL4|RXFFIL3|RXFFIL2| RXFFIL1|RXFFILO
/ \ \ /
RX FIFO RX FIFO RX FIFO RX FIFO Interrupt Level
Interrupt Interrupt Interrupt | hen RXFEST4-0
Flag (read-only) Flag Clear  (on match) nt;rruptw eno N
0=not occurred 0 = no effect Enable and RXFFIL4-0 matc
1 = occurred 1 =clear 0 = disable
1 =enable

SPI-A FIFO Receive Register

SPIFFRX @ 0x00704B

RX FIFO Status (read-only)

*

SPI Summary

Provides synchronous serial
communications

+ Two wire transmit or receive (half duplex)
+ Three wire transmit and receive (full duplex)

Software configurable as master or slave
+ C28x provides clock signal in master mode

Data length programmable from 1-16 bits
125 different programmable baud rates

11-10
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Serial Communications Interface (SCI)

The SCI module is a serial 1/0O port that permits Asynchronous communication between the C28x
and other peripheral devices. The SCI transmit and receive registers are both double-buffered to
prevent data collisions and allow for efficient CPU usage. In addition, the C28x SCl is a full
duplex interface which provides for simultaneous data transmit and receive. Parity checking and

data formatting is also designed to be done by the port hardware, further reducing software
overhead.

SCI Pin Connections

(Full Duplex Shown)

TX FIFO_0

TX FIFO_15

Transmitter-data
buffer register

TX FIFO_0

TXFIFO_15

Transmitter-data
buffer register

Transmitter SCITXD SCITXD Transmitter
shift register shift register
Receiver SCIRXD SCIRXD Receiver
shift register shift register

Receiver-data Receiver-data
buffer register buffer register
RX FIFO_0 RX FIFO_0
RX FIFO_15 RX FIFO_15
SCI Device #1 SCI Device #2

C28x - Communications
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Serial Communications Interface (SCI)

SCI-A Programmable Data Format

NRZ (non-return to zero) format

Addr/
Data

This bit present only in Address-bit mode A

Communications Control Register (SCICCR) — 0x007050
7 6 5 4 3 2 1 0

STOP EVEN/ODD| PARITY [LOOP BACK ADDR/IDLE] SCI SCI SCI
BITS PARITY ENABLE | ENABLE MODE CHAR2 CHARL1 CHARO

0 =1 Stop bit 0 = Disabled 0 = Idle-line mode  # of data bits = (binary + 1)
1 =2 Stop bits 1= Enabled 1= Addr-bit mode e.g. 110b gives 7 data bits
0=0dd 0 = Disabled
1=Even 1= Enabled

T T
Parity| Stop 1 Stop 2

Start| LSB 2 3 4 5 6 7 | MSB

[SCI-B Communications Control Register (SCICCR) — 0x007750]

The basic unit of data is called a character and is 1 to 8 bits in length. Each character of data is
formatted with a start bit, 1 or 2 stop bits, an optional parity bit, and an optional address/data bit.
A character of data along with its formatting bits is called a frame. Frames are organized into
groups called blocks. If more than two serial ports exist on the SCI bus, a block of data will
usually begin with an address frame which specifies the destination port of the data as determined
by the user’s protocol.

The start bit is a low bit at the beginning of each frame which marks the beginning of a frame.
The SCI uses a NRZ (Non-Return-to-Zero) format which means that in an inactive state the
SCIRX and SCITX lines will be held high. Peripherals are expected to pull the SCIRX and
SCITX lines to a high level when they are not receiving or transmitting on their respective lines.

When configuring the SCICCR, the SCI port should first be held in an inactive state. This
is done using the SW RESET bit of the SCI Control Register 1 (SCICTL1.5). Writing a 0 to this
bit initializes and holds the SCI state machines and operating flags at their reset condition. The
SCICCR can then be configured. Afterwards, re-enable the SCI port by writing a 1 to the SW
RESET bit. At system reset, the SW RESET bit equals 0.
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Asynchronous Communication Format

« Start bit valid if 4 consecutive SCICLK periods of zero bits after falling edge
e Majority vote taken on 4th, 5th, and 6th SCICLK cycles

Majority

\ Vote /

12 3 45 6 7 8 1 2 3 45 6 7 8 1 2

bhbd b |

Start Bit LSB of Data

SCICLK
(Internal)

SCIRXD _|

' Falling Edge Detected

Note: 8 SCICLK periods per data bit

SCI-A Baud Rate

_LSPCLK  BRR=11065535
(BRR+1)x8
SCI baud rate =
LSPCLK R
16

Baud-Select MSbyte Register (SCIHBAUD) — 0x007052

7 6 5 4 3 2 1 0
BAUDIS | gayp14 | BAUD13 | BAUDI2 | BAUDLL | BAUD10 | BAUDY | BAUDS
(MSB)
Baud-Select LShyte Register (SCILBAUD) — 0x007053
7 6 5 4 3 2 1 0

BAUD7 | BAUD6 | BAUD5 | BAUD4 | BAUD3 | BAUD2 | BAUD1 E‘(ﬁgg)o

[SCI-B Baud-Select MSbyte Register (SCIHBAUD) — 0x007752]
[SCI-B Baud-Select LSbyte Register (SCILBAUD) - 0x007753]

C28x - Communications
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Serial Communications Interface (SCI)

Baud Rate Determination: The values in the baud-select registers (SCIHBAUD and SCILBAUD)
concatenate to form a 16 bit number that specifies the baud rate for the SCI.

e For BRR =1 to 65535: SCI Baud Rate = % bits/sec
(BRR+1)x8
e ForBRR=0: SCI Baud Rate = % bits/sec

Max data rate = 9.3 Mbps @ 150 MHz

Note that the CLKOUT for the SCI module is one-half the CPU clock rate.

Multiprocessor Wake-Up Modes

Multiprocessor Wake-Up Modes

¢ Allows numerous processors to be hooked
up to the bus, but transmission occurs
between only two of them

¢ Idle-line or Address-bit modes

¢ Sequence of Operation

1. Potential receivers set SLEEP = 1, which disables RXINT
except when an address frame is received

2. All transmissions begin with an address frame

3. Incoming address frame temporarily wakes up all SCls on bus
4. CPUs compare incoming SCI address to their SCI address

5. Process following data frames only if address matches
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Idle-Line Wake-Up Mode

¢ Idle time separates blocks of frames

¢ Receiver wakes up when SCIRXD high for 10 or
more bit periods

¢ Two transmit address methods
+ deliberate software delay of 10 or more bits

+ set TXWAKE bit to automatically leave exactly
11 idle bits

Idle periods
of less than Block of Frames
10 bits R
gg:_'?;(g/ TV LastData. - Addr | sp|sT[ Data |sp|ST[ LestData | SP iSTP Addr _ispi
Idled Address frame 1st data frame Idled
Period  follows 10 bit Perio
10 bits or greater idle 10 bits
or greater 9 or greater

Address-Bit Wake-Up Mode

¢ All frames contain an extra address bit
¢ Receiver wakes up when address bit detected

¢ Automatic setting of Addr/Data bit in frame by
setting TXWAKE =1 prior to writing address to

Block of Frames
SCIRXD/ "7 st Datat 0 s |sT| Addr | 1]sp|sT| _ Data | 0] sP| ST| Last Datd] 0] 5Pt STE Addr +11sPi
SCITXD  ~======"-~ T """""" !
>/_/ First frame within  1st data frame no addiitional
Idle Period block is Address. idle bits needed
length of no ADDR/DATA beyond stop bits
significance bit set to 1
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The SCI interrupt logic generates interrupt flags when it receives or transmits a complete
character as determined by the SCI character length. This provides a convenient and efficient
way of timing and controlling the operation of the SCI transmitter and receiver. The interrupt
flag for the transmitter is TXRDY (SCICTL2.7), and for the receiver RXRDY (SCIRXST.6).
TXRDY is set when a character is transferred to TXSHF and SCITXBUF is ready to receive the
next character. In addition, when both the SCIBUF and TXSHF registers are empty, the TX
EMPTY flag (SCICTL2.6) is set. When a new character has been received and shifted into
SCIRXBUF, the RXRDY flag is set. In addition, the BRKDT flag is set if a break condition
occurs. A break condition is where the SCIRXD line remains continuously low for at least ten
bits, beginning after a missing stop bit. Each of the above flags can be polled by the CPU to
control SCI operations, or interrupts associated with the flags can be enabled by setting the
RX/BK INT ENA (SCICTL2.1) and/or the TX INT ENA (SCICTL2.0) bits active high.

Additional flag and interrupt capability exists for other receiver errors. The RX ERROR flag is
the logical OR of the break detect (BRKDT), framing error (FE), receiver overrun (OE), and
parity error (PE) bits. RX ERROR high indicates that at least one of these four errors has
occurred during transmission. This will also send an interrupt request to the CPU if the RX ERR
INT ENA (SCICTLL1.6) bit is set.

SCI Summary

L 2

Asynchronous communications format
65,000+ different programmable baud rates

¢ Two wake-up multiprocessor modes
« lIdle-line wake-up & Address-bit wake-up

¢ Programmable data word format
+ 1to 8 bit dataword length

« 1or 2stop bits
+ even/odd/no parity

Error Detection Flags
+ Parity error; Framing error; Overrun error; Break detection

Double-buffered transmit and receive
Individual interrupts for transmit and receive

L 2

L 2R 2
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Multi-Channel Buffered Serial Port (McBSP)

Multi-Channel Buffered Serial Port (McBSP)

McBSP Block Diagram
TX FIFO_15 TX FIFO_15
FSX
TX FIFO_0 TX FIFO_0 e—> CLKX
DXR2 TX Buffer DXR1 TX Buffer
XSR2 XSR1 ey DX
RSR2 f— RSR1 [t DR
RBR2 Register | RBR1 Register |
DRR2 RX Buffer DRR1 RX Buffer +—— CLKR
RX FIFO_15 RX FIFO_15
FSR
RX FIFO_0 RX FIFO_0

Definition: Bit and Word

JERRERERNARRRRNREEN

¢ “Bit” - one data bit per SP clock period

¢ “Word” or “channel” contains
number of bits (8, 12, 16, 20, 24, 32)

[ E

C28x - Communications
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Multi-Channel Buffered Serial Port (McBSP)

Definition: Word and Frame
FS | - I
D (w6 Xw7 >‘ ‘ (w0 Y wl w2 ‘ ‘ w4 Y W5 X W6 : :
> 4 Frame _>
Word ‘ * *
¢ “Frame” - contains one or multiple words
¢ Number of words per frame: 1-128
Multi-Channel Selection
. Cho-0
Frame TDM Bit Stream Multichannel Cho-1
M Transmit
(o) h31|-| Ch h
¢ 0 —{Ch31| |c1|co|—»(B: R&. :|,> —
DH1 h e h h ecelve _
E _|C 31| | chi | cho I_' S | only selected Chsd
C P Channels Ch27-0
ch27-1
¢ Allows multiple channels (words) to be independently selected for transmit

and receive (e.g. only enable ChO, 5, 27 for receive, then process via CPU)

The McBSP keeps time sync with all channels, but only “listens” or “talks”

if the specific channel is enabled (reduces processing/bus overhead)

Multi-channel Control Reg

Rec/Xmt Channel Enable Regs

Multi-channel mode controlled primarily via two registers:

MCR |

RIXCER (A-H)

(enables Mc-mode)

(enable/disable channels)

Up to 128 channels can be enabled/disabled

11-18
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Multi-Channel Buffered Serial Port (McBSP)

McBSP Summary

¢ Direct Interface to codecs and other serial
devices

Full-duplex communication

Independent clocking and framing for
transmit and receive

Internal or external clock and frame sync
Data size of 8, 12, 16, 20, 24, or 32 bits
16 level 32-bit FIFO for transmit data

16 level 32-bit FIFO for receive data

TDM mode - up to 128 channels

SPI mode

¢ o

® 6 O 6 0 o

(Note: 1/O pin buffer speed is limited to 20 MHz maximum on the *C/F281x devices)
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Enhanced Controller Area Network (eCAN)

Enhanced Controller Area Network (eCAN)
Controller Area Network (CAN)

A Multi-Master Serial Bus System

¢ CAN 2.0B Standard

¢ High speed (up to 1 Mbps)

¢ Add anode without disturbing the bus (number of nodes not
limited by protocol)

¢ Less wires (lower cost, less maintenance, and more reliable)

¢ Redundant error checking (high reliability)

¢ No node addressing (message identifiers)

& Broadcast based signaling

CAN does not use physical addresses to address stations. Each message is sent with an identifier
that is recognized by the different nodes. The identifier has two functions — it is used for message
filtering and for message priority. The identifier determines if a transmitted message will be
received by CAN modules and determines the priority of the message when two or more nodes
want to transmit at the same time.
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Enhanced Controller Area Network (eCAN)

CAN Bus and Node

CAN
NODE A

CAN Bus

CAN
NODE B

CAN _H

¢ Two wire differential bus (usually twisted pair)

¢ Max. bus length depend on transmission rate
+ 40 meters @ 1 Mbps

1200

g B

CAN L

120Q

The DSP communicates to the CAN Bus using a transceiver. The CAN bus is a twisted pair wire,

and the transmission rate depends on the bus length. If the bus is less than 40 meters the

transmission rate is capable up to 1 Mbit/second.

CAN_H

CAN Node

Wired-AND Bus Connection

120Q[:]

M

CAN L

[:] 120Q2

5V

CAN Transceiver
(e.g. TI SN65HVD23x)

X

RX

CAN Controller
(e.g. TMS320F2812)

C28x - Communications
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Enhanced Controller Area Network (eCAN)

Principles of Operation

Principles of Operation

& Data messages transmitted are identifier based,
not address based

¢ Content of message is labeled by an identifier that
is unigue throughout the networ

« (e.g.rpm, temperature, position, pressure, etc.)

¢ All nodes on network receive the message and
each performs an acceptance test on the identifier

¢ If message is relevant, it is processed (received);
otherwise it is ignored

¢ Unique identifier also determines the priority of the
message

+ (lower the numerical value of the identifier, the higher the
priority)
¢ When two or more nodes attempt to transmit at the
same time, a non-destructive arbitration technique
guarantees messages are sent in order of priority
and no messages are lost

Non-Destructive Bitwise Arbitration

& Bus arbitration resolved via arbitration with
wired-AND bus connections

+ Dominate state (logic 0, bus is high)
+ Recessive state (logic 1, bus is low)

Bit
Node A ........... |__| ,_ Node AWinS
___________ - =
Node B |
NodeC — L L
Jj

CANBus ~— LT

Node B |0395_j k Node C loses

arbitration arbitration
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Enhanced Controller Area Network (eCAN)

Message Format and Block Diagram

CAN Message Format

¢ Datais transmitted and received using Message Frames
¢ 8 byte data payload per message
¢ Standard and Extended identifier formats

& Standard Frame: 11-bit Identifier (CAN v2.0A)

Arbitration Control
Field Field Data Field
S| 11bit [RI E
O | 1dentifier] T|D|rQ DLC| 0...8 Bytes Data | CRC[ACK| O
F RIE F

¢ Extended Frame: 29-bit Identifier (CAN v2.0B)

Control
Arbitration Field Field Data Field
S < | S| . |R E
11-bit 18-bit
(F) Identifier E E Identifier; rl{rQ DLC| 0...8 Bytes Data | CRC [ ACK ('3

The DSP CAN module is a full CAN Controller. It contains a message handler for transmission
and reception management, and frame storage. The specification is CAN 2.0B Active — that is,

the module can send and accept standard (11-bit identifier) and extended frames (29-bit
identifier).

eCAN Block Diagram

Address
T eCANOINT TeCANlINT |_| Data

| i

el S Memory Management :’|> eCAN Memory
(512 bytes) (512 bytes)

CPU Interface, ;
32 Mailboxs @ Receive Control Unit <§> Register and Message

(4 x 32-bit words) Timer Management Unit Object Control

A message mailbox
Identifier - MID
Control - MCF

Data low — MDL Receive Buffer
Data high - MDH Transmit Buffer
Control Buffer

Status Buffer

SN65HVD23x
3.3-V CAN Transceiver

1]

CAN Bus
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Enhanced Controller Area Network (eCAN)

The CAN controller module contains 32 mailboxes for objects of 0 to 8-byte data lengths:
e configurable transmit/receive mailboxes
e configurable with standard or extended indentifier

The CAN module mailboxes are divided into several parts:
o MID - contains the identifier of the mailbox

o MCF (Message Control Field) — contains the length of the message (to transmit or
receive) and the RTR bit (Remote Transmission Request — used to send remote
frames)

¢ MDL and MDH - contains the data

The CAN module contains registers which are divided into five groups. These registers are
located in data memory from 0x006000 to 0x0061FF. The five register groups are:

e Control & Status Registers

o Local Acceptance Masks

e Message Object Time Stamps
o Message Object Timeout

e Mailboxes

eCAN Summary

¢ Fully CAN protocol compliant, version 2.0B
¢ Supports data rates up to 1 Mbps

¢ Thirty-two mailboxes
+ Configurable as receive or transmit
+ Configurable with standard or extended identifier
+ Programmable receive mask
+ Uses 32-bit time stamp on messages
+ Programmable interrupt scheme (two levels)
+ Programmable alarm time-out

¢ Programmable wake-up on bus activity
¢ Self-test mode
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Development Support

Introduction

This module contains various references to support the development process.

Learning Objectives

Learning Objectives

¢ Signal Processing Libraries

¢ Additional Resources
+ Internet

+ Product Information Center
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Module Topics

Module Topics
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Tl Support Resources

Tl Support Resources

C28x Signal Processing Libraries
Signal Processing Libraries Literature #
ACI3 3: Simulated Indirect FOC of ACI Motor SPRCO77
ACI3 4: Real Direct FOC of ACI Motor SPRCO079
ACI3 4: Simulated Direct FOC of ACI Motor SPRCO078
Digital Motor Control Library SPRC080
DSP Fast Fourier Transform (FFT) Library SPRCO081
DSP Filter Library SPRCO082
DSP Fixed-Point Math Library SPRCO085
DSP IQ Math Library SPRCO087
DSP Signal Generator Library SPRCO083
DSP Software Test Bench (STB) Library SPRC084
C281x C/C++ Header Files and Peripheral Examples SPRCO097

Available from TI DSP Website = http://www.dspvillage.ti.com

For More Information . ..

Internet

Website: http://www.ti.com
http://www.dspvillage.com

FAQ: http://www-k.ext.ti.com/sc/technical_support/knowledgebase.htm

¢ Device information ¢ my.ticom
+ Application notes + News and events
+ Technical documentation ¢ Training

Enroll in Technical Training:  http://www.ti.com/sc/training

USA - Product Information Center ( PIC)
Phone: 800-477-8924 or 972-644-5580
Email: support@ti.com

+ Information and support for all TI Semiconductor products/tools
+ Submit suggestions and errata for tools, silicon and documents
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Tl Support Resources

European Product Information Center (EPIC)

Web: http://www-k.ext.ti.com/sc/technical support/pic/euro.htm

Phone: Langquage
Belgium (English)
France
Germany
Israel (English)
Italy
Netherlands (English)
Spain
Sweden (English)
United Kingdom
Finland (English)

Fax: All Languages

Email: epic@ti.com

Number

+32 (0) 27 45 55 32
+33 (0) 1 30 70 11 64
+49 (0) 8161 80 33 11
1800 949 0107 (free phone)
800 79 11 37 (free phone)
+31 (0) 546 87 95 45
+34 902 35 40 28

+46 (0) 8587 555 22
+44 (0) 1604 66 33 99
+358(0) 9 25 17 39 48

+49 (0) 8161 80 2045

+ Literature, Sample Requests and Analog EVM Ordering

+ Information, Technical and Design support for all Catalog Tl
Semiconductor products/tools

+ Submit suggestions and errata for tools, silicon and documents
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Appendix

eZdsp™ F2812

eZdsp™ F2812 Connector / Header and Pin Diagram

O [#lala]elalnlulalalwlalal O
OoooooQQoolQ0 A

FP4/P&/PT

o
L]

&

il

j/

Table 1: eZdsp™ F2812 Connectors

Connector Function
P1 JTAG Interface
P2 Expansion
P3 Parallel Port/JTAG
Controller Interface
PA/P8/P7 I/C Interface
P5/P9 Analog Interface
F6 Power Connector
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P2 — Expansion Interface

P2

na
~

i
=
)
=
o

a 20|22 |24 |26 |28 | 20| a2 | 24 | 36| 3e |40 42 | 44 | 46| 48| 50| 52| 54| 56] 58] 60

1|3 57| ol11|13 |15 |17 |19 |21 23|25 |27 |29 |31 | 23 |as |37 |32 | 41| 43|45 |47 |40 [ 51|53 | 55] 57 | 50

Tabl= 2: P2, Expanzion Interface Connector

Pin# Signal Pin ¥ Signal
i +EY Z +5W
3 A i A K
5 Xz & AR
7 04 B KOG
=] A0 10 FARG
11 *Oe 12 AR
13 XD 14 EARRR
16 Xz 16 X013
17 FANRE 1B X015
19 KAD 20 XA
21 xaz 22 Xh3
23 Xbd 24 KhE
25 KA 26 XaY
27 XAR 2B Xho
28 o an X
i Xz iz X3
33 X4 3 XbAE
i GhD k[ GhD
T XEACHIAND N B XICHMn
ig XREADY a0 10K Pulup
11 ¥En'w 12 10K Pulup
43 WVE 44 XR{n
A& +3.3 b [ ARAMT S
47 XREMR2n 48 Mo canned
45 SO A0 GhD
51 GhD h2 GhD
53 X016 5 xnA7
56 HAAB 56 KHOLDn
57 Y¥HOLDAA 5B Ho cannect
58 Mo conned &0 Mo canned
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P4 /P8 /P7—1/0O Interface

C28x - Appendix A - eZdsp F2812

112 3|14 5 7l 8lof10]11|12|13 |14 |15]|16|17|18[19]|20| P4
214 |6 8101214 |16 18| 20]22 |24 |26 |28]30 |32 |34 |36 |38 |40
113|579 11|13|1|17 19| 21|23 |25]|27|29] 31|33 |35(|37|39 P8
11213]14]| 5 7lela 10| PY
Table 2: PAPE, 'D Connzctors

F‘?:# F4 Signal Pli:'nE# Fé Signal Flli:'nﬂ# F# Signal

1 +E iolis 1 +E Wiokls 2 +E Wiolls

2 MNT2 BDCRCC 3 ECITHON, 4 ECIRH DN,

3 MCLEXA, B KINTIn'XBIOn G CAaF1EF

4 MCLER:S T CAFZOEFZ ] CAPIQEPNH

5 W24, g Fivii 10 P2

L] MF 2R " Fiv IS 12 il

T [ e 13 Fi G 14 PG

A DR 15 T1PWITICKP 16 TZPNT2CMP

a Fa correscl 17 TOIRA, 14 TCLEIHA

10 GRO 149 GhO 20 GHO

11 CAPEIER 21 Mo connect s KINTARMXBEICn

2 CaPaERE 23 SPIEIMC, 24 SPISTM LA

13 TIFWMTACMP 26 SPICLEA i SPIETER

14 TAFWIMTAC P Zr CAMNT 28 (RN By

16 TOIRE pra | XCOLEOUT 3 FivIAT

16 TCLEIRE 3 FivIE i Fiviia

T ¥FHPLLDIS 33 FMAD 3 Faii

18 SCITHOR 35 Fivi2 3 CAFAIEFS

10 2CIRXKDE 37 T1CTRF'POPINTAR 38 TRCTRIFFPODRMTEn

20 GrRIO b GO 40 GHO
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Table 4: P7, I/O Connector

P7
Pin #

P7 Signal

CATRIPn

CZ2TRIPn

C3TRIPn

T2CTRIPN/EVASOCH

CA4TRIPn

C5TRIPN

CeTRIPnN

T4CTRIPR/EVBSOCn

Mo connect

—lolol~w|lalrn]|&=]w]|r]| =

GMND
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Appendix

P5 /P9 — Analog Interface

P5 ANALOG
11213 516|789 ]10
2141686 1012114 |16 | 18] 20
51719 11131511719
P9

Table 5: P5/P9, Analog Interface Connector

Prnﬁ# Signal pli='n9# Signal Prng# Signal
1 ADCINEO 1 GND 2 ADCINAD
2 ADCINE1 3 GND 4 ADCINA1
3 ADCINBZ 5 GND 6 ADCINAZ2
4 ADCINE3 7 GND 8 ADCINAS
5 ADCINB4 9 GND 10 ADCINAA
6 ADCINES 11 GND 12 ADCINAS
7 ADCINEG 13 GND 14 ADCINAB
& ADCINE7 15 GND 16 ADCINA7Y
9 ADCREFM 17 GND 18 VREFLO
10 ADCREFF 19 GND 20 No connect
C28x - Appendix A - eZdsp F2812 A-7
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eZdsp™ F2812 Jumper Diagram

JP2 —
I
I Pk | P
JTNG .-.nui!i!'!'l!l' l el |
—\C; e7 dspl TMS320F 2812 EAPMCETIN pee 00 | ip7
——
go I[II ' L4
52 H'\§§_ = _{ups
~g8 i3 JP11
h‘ﬁ-@-. L= T ol
A : e
. @ e P12
Pa
3:]

JP1 - XMP/MCn Select
Table 6: JP1, XMP/MCn Select

Position Function
1-2 Microprocessor mode
2-3° Microcomputer mode

* as shipped from factory

JP2 — Flash Programming Voltage Select

Table 7: JP2, Flash Programming Voltage Select

Position Function
1-2* Yoltage supplied to DSP
2-3 Woltage not supplied to DSP

* always in this position
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Appendix

JP7/JP8/JP11/JP12 — Boot Mode Select

Table 8: JP7, JP8, JP11, JP12, Boot Mode Select

JP7, BOOT3 | JP8, BOOT2 | JP11, BOOT1 | JP12, BOOTO MODE
SCITXDA MD XA SPISTEA SPICLKA
1 X X X FLASH
0 1 X X SPI
0 0 1 1 SCI
0 0 1 0 HO*
0 0 0 1 OTP
0 0 0 0 PARALLEL

" factory default

JP9 — PLL Disable

Table 9: JP9, PLL Disable

Position Function
1-2* FLL Enabled
2-3 FLL disabled

* as shipped from the factory

DS1/DS2 - LEDs

Table 10: LEDs

LED # | Color | Controlling Signal

Green +5 Volts

Grean XF bit (XF high = on]

2
[N ]

o
(%]
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TP1/TP2 — Test Points

Table 11: Test Points

Test Point Signal
TP1 Ground
TPZ Analog Ground
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Appendix B — Addressing Modes

Introduction

Appendix B will describe the data addressing modes on the C28x. Immediate addressing allows
for constant expressions which are especially useful in the initialization process. Indirect
addressing uses auxiliary registers as pointers for accessing organized data in arrays. Direct
addressing is used to access general purpose memory. Techniques for managing data pages,
relevant to direct addressing will be covered as well. Finally, register addressing allows for
interchange between CPU registers.

Learning Objectives

Learning Objectives

¢ Explain .sect and .usect assembly directives
¢ Explain assembly addressing modes
¢ Understand instruction formats

& Describe options for each addressing mode
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Module Topics

Module Topics

AppendixX B — ADAresSing MOAES .........ooiiiiiiiiiie et ettt bbb b b B-1
T LU T=N I o ot PSSP B-2
Labels, Mnemonics and ASSEMDIY DIFECHIVES ........viuviviieieiee et B-3
AQATESSING MOGES ...ttt b bbb bbbt bbb e b e bbbt bbb B-4
INSEFUCTION FOIMALS ....o.viiieieiciieic ettt st ettt e r e s et e st sbesbesbesbesteaneeneeeenees B-5
REGISTET AGUIESSING ...ttt sttt ettt bbbt ae bt e b se e b e bt bt e b e he e b e e e et e neeebesbeebe et e e st eneenneneas B-6
IMMEAIALE AGATESSING ... ettt bttt b et bt bbbt e e e b e b sb e besbeebesbeabeeree e ennas B-7
D] = Tot N (o LTSt [ ol OO TR B-8
oo LT =T Y (o 1T 1o SRR B-10
REVIBW ...ttt etttk ettt bbbkt st b b s b e Rt R e e R e R R Rt b e e e R e R e e e R e Rt beebe e ebe et e ebenrn B-13

EXEICISE Bttt bbbt bbb R bbbt be bbb r et B-14
=T oI Yo [0 ST oo TS B-15
OPTIONAL Lab B-C: Array Initialization iN C.......cccooeiiiiieriseseeeesee e se e B-17
RS0 L1 T 1SS B-18
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Labels, Mnemonics and Assembly Directives

Labels, Mnemonics and Assembly Directives

Labels and Mnemonics

eLabels Jef st
_ .sect vectors
> Optional for all assembly :make reset vector address 'start’
instructions and most reset: .long start
assembler directives
> Must begin in column 1 def Sieut
o count .set 9
> The " : " is not treated as ;create an array x of 10 words
part of the label name X .usect  “mydata”, 10
> Used as pointers to I
memory or INStructions —— . qia:  C280BJ ;operate in C28x mode
. MOV  ACC#1l
+Mnemonics nextt MOVL XARL#x
> Lines of instructions _ ___{—-——=> MOV  AR2#count
. *
» Use upper or lower case usg: I\B/Iﬁ?ltllz Ié)ﬁig;’_AL
> Become components of bump: ADD ACé,#l
program memory SB next UNC

Assembly Directives

+ Begin with a period (.) and are

lower case ref start
. U USRS > -Sect “vectors”
> Uscelzd bydtfcliet“”_k?r to '00_??3 | ‘make reset vector address 'start
code and data Into speciiie reset; .long  start
sections
# Directives allow you to: > ef start
> Define a label as global——"" | count .set 9
. ; create an array x of 10 words
> Reserve space in memory X__» Usect  “mydata”, 10

for un-initialized variables —— F=-=------------o
L — — > .sect “code”

> Initialized memory —==~" start:  C280BJ ;operate in C28x mode
:-------- Dlrectlves sssEmEEmm MOV ACC #1
next: MOVL XAR1#x

MOV  AR2#count

loop: MOV  *XARI1++AL

initialized section
used for code or constants  *® BANZ  loop,AR2--
X

.sect “name” |

uninitialized section bump: ADD  ACC#1
SB next,UNC

label .usect “name",5|
used for variables
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Addressing Modes

Addressing Modes

(register)
(constant)

(paged)

(pointer)

Addressing Modes

Mode Symbol | Purpose

Register Operate between Registers
Immediate| # Constants and Initialization

Direct @ General-purpose access to data
Indirect * Support for pointers — access arrays,

lists, tables

Four main categories of addressing modes are available on the C28x. Register addressing mode
allows interchange between all CPU registers, convenient for solving intricate equations.
Immediate addressing is helpful for expressing constants easily. Direct addressing mode allows
information in memory to be accessed. Indirect addressing allows pointer support via dedicated
‘auxiliary registers’, and includes the ability to index, or increment through a structure. The C28x
supports a true software stack, desirable for supporting the needs of the C language and other
structured programming environments, and presents a stack-relative addressing mode for
efficiently accessing elements from the stack. Paged direct addressing offers general-purpose
single cycle memory access, but restricts the user to working in any single desired block of

memory at one time.
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Instruction Formats

Instruction Formats

Instruction Formats

INSTR dst ,src Example

INSTR REG NEG AL

INSTR REG,#imm MOV ACC,#1
INSTR REG,mem ADD AL, @x

INSTR mem,REG SUB AL,®@ARO
INSTR mem,#imm MOV *XARO++,#25

€ What is a“REG"?
¢ 16-bit Access = ARO through AR7, AH, AL, PH, PL, T and SP
& 32-bit Access = XARO through XAR7, ACC, P, XT

€ What is an “#imm" ?
¢ an immediate constant stored in the instruction
€ What is a “mem”?
& A directly or indirectly addressed operand from data memory
& Or, one of the registers from “REG"!
& locl6 or loc32 (for 16-bit or 32-bit data access)

The C28x follows a convention that uses instruction, destination, then source operand order
(INSTR dst, src). Several general formats exist to allow modification of memory or registers
based on constants, memory, or register inputs. Different modes are identifiable by their leading
characters (# for immediate, * for indirect, and @ for direct). Note that registers or data memory
can be selected as a ‘mem’ value.
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Register Addressing

Register Addressing

Register Addressing

32-bit Registers
[XARO—XAR7 ACC P XT|

16-bit Registers
/ARO—AR7 AH AL PH PL T TL DP SP|

¢ Allows for efficient register to register
operation

16-bit and 32-bit Register Address modes

¢ Reduces code overhead, memory
accesses, and memory overhead

*

Register addressing allows the exchange of values between registers, and with certain instructions
can be used in conjunction with other addressing modes, yielding a more efficient instruction set.
Remember that any ‘mem’ field allows the use of a register as the operand, and that no special
character (such as @, *, or #) need be used to specify the register mode.

Register Addressing — Example

Format —{ MOV Ax, loc16| |[MOVL loc32,ACC
Instruction——| MOV AH, @AL MOVL @XT,ACC

Format—| MOV loc16 ,AX, COND
Instrucion—| MOV @AR1,AL,GT

User Guide & Dis-assembler
use @ for second register
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Immediate Addressing

Immediate Addressing

Immediate Addressing — “#"

one word instruction
[ oPcODE  [8-bit OPERAND|

two word instruction
OPCODE
16-bit OPERAND

¢ Fixed value part of program memory
instruction

¢ Supports short (8-bit) and long (16-bit)
immediate constants

Long immediate can include a shift

¢ Used to initialize registers, and operate
with constants

2

Immediate addressing allows the user to specify a constant within an instruction mnemonic. Short
immediate are single word, and execute in a single cycle. Long (16-bit) immediate allow full
sized values, which become two-word instructions - yet execute in a single instruction cycle.

Immediate Addressing — Example

¢ Short Immediate, 1 Word (ANDB) ¢ Long Immediate, 2 Words (AND)

ANDB Ax,#8Bit AND locl6,#16Bit
[ anDB[Ax| #8Bit | AND loc16
#16Bit
AND automatically replaced by :
ANDB if IMM value is 8 bits or less AND  Ax, locl6,#16Bit
AND | Ax | locie
#16Bit

AND ACC,#16Bit,<<0-16

AND | ACC | shift
#16Bit
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Direct Addressing

Direct Addressing
Direct addressing allows for access to the full 4-Meg words space in 64 word “page” groups. As
such, a 16-bit Data Page register is used to extend the 6-bit local address in the instruction word.
Programmers should note that poor DP management is a key source of programming errors.
Paged direct addressing is fast and reliable if the above considerations are followed. The watch
operation, recommended for use whenever debugging, extracts the data page and displays it as the

base address currently in use for direct addressing.

*

Direct Addressing —“@”

Data Page Offset Data Memory
00 0000 0000 0000 00|00 0000

. . . Page 0: 00 0000 — 00 003F
00 0000 000000000011 1111
00 0000 0000 0000 01|00 0000

* ° . Page 1: 00 0040 — 00 007F
000000 000000000111 1111
00 0000 0000 0000 10|00 0000

. . . Page 2: 00 0080 — 00 00BF
00 0000 0000 00001011 1111

L] L] L] L] L]

[ [ [ [ e
1111111111 1111 11 {00 0000

° . . Page 65,535: 3F FFCO — 3F FFFF
1111111111111111)11 1111

Data memory space divided into 65,536 pages with
64 words on each page

Data page pointer (DP) used to select active page

16-bit DP is concatenated with a 6-bit offset from the
instruction to generate an absolute 22-bit address

Access data on a given page in any order
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Direct Addressing

Direct Addressing — Example

Q 0 0 1 F =
Z=X+Y 0000 |0000(0000(0001 (1121|1111
' DP offset

Data Memory

ZQElSECE) Sanpiss address | data
-sect  “code A Page7[00]  [0001C0|0001
MOVW  DP,#x 64 ...
MOV AL,@x Page7[3D] x:| 0001FD 1000
ADD  AL,Q@y l Page7[3E] y:| 0001FE (0500
MOV @z, AL Page7[3F] z:| 0001FF | 1500

DP=0007 Accumulator
variations: mMov AL,@x|O O O 0|1 0 O O
> MOVW DP,#imm ;2W, 16-bit (4 Meg) ADD AL,@y|0 O O O|1 5 O O
> MOVZ DP,#imm ;1W, 10-bit (64K)
> MOV DP#imm ;DP(15:10) unchanged MOV @2, AL <t

(X and Y not on the same page)

Direct Addressing — Caveats

Data Memory

address | data
DP offset Page7[00] |[0001CO|0001
0000|0000 |0000|0001 (1211|1121 |--»
' . Page7[3F] x:[0001FF [1000
0000 | 0000 | 0000|0010 (0000|0000 |~..  -feR2= 2T A VUS| LUUY
: X pageg[00] Y:[{000200 (0500
DP=0007 Accumulator
0007 R B X .usect “samp”,3
0007 00002000 .sect “code”
0007 0000|1001 MOVW DP,#x
T MOV  AL,@x
expecting 1500 | ___ ADD AL, @y
MOV @z, AL

Solution: Group and block variables in ASM file:

-usect “samp”,q,l ;Force all locations to same data

X
y .set x+1 ;page (1st hole, else 1
z .set x+2 ;Assign vars within block

inker error)
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Indirect Addressing

Indirect Addressing

Indirect Addressing — “»”

Data Memory

XARO
XAR1
XAR2 )
XAR3
XAR4
XARS
XAR6
XAR7

¢ Auxiliary Registers (XARn) used to access full
data memory space

¢ Address Register Arithmetic Unit (ARAU) used
to modify the XARN

¢ Access data from arrays anywhere in data
memory in an orderly tashion

Any of eight hardware pointers (ARs) may be employed to access values from the first 64K of
data memory. Auto-increment or decrement is supported at no additional cycle cost. XAR register
formats offer larger 32-bit widths, allowing them to access across the full 4-Giga words data
space.

Indirect Addressing Modes

¢ Auto-increment / decrement: *XARn++, *--XARN
+ Post-increment or Pre-decrement
¢ Offset: *+XARN[ARO or AR1], *+XARN[3bit]
+ Offset by 16-bit ARO or AR1, or 3-bit constant
& Stack Relative: *-SP[6bit]
« Index by 6-bit offset (optimal for C)
¢ Immediate Direct: *(0:16bit)
« Access low 64K
¢ Circular: *AR6%++
+ AR1(7:0) is buffer size
+« XARG6 is current address

B-10 C28x - Appendix B - Addressing Modes



Indirect Addressing

Indirect Addressing — Example
Autoincrement

4
y=> X,

n=0

ADD  ACC,*XAR2++
ADD  ACC,*XAR2++ | «(:16bit) - 16 bit label
MOV *(0:y),AL

X -usect ‘“‘samp”’,6 Data
VoooessiE G ) x | x0 |<—XAR2
.sect “code” <1 |2
MOVL XAR2,#x w2 |
MOV~ ACC,*XAR2++ x3 |2
ADD  ACC,*XAR2++ x4 |2
ADD  ACC,*XAR2++ y

- must be in lower 64K

- 2 word instruction

Fast, efficient access to arrays, lists, tables, etc.

Indexed addressing offers the ability to select operands from within an array without modification
to the base pointer. Stack-based operations are handled with a 16-bit Stack Pointer register, which
operates over the base 64K of data memory. It offers 6-bit non-destructive indexing to access
larger stack-based arrays efficiently.

Indirect Addressing — Example

X

.sect “.code”
MOVL XAR2,#x

MoV
MOV
MoV
ADD
MOV

Offset
Data
_ XAR2—> x| X0
x[2] = x[1] + x[3] o
[.] %2
t--->| X3
x4
.usect “.samp”,5
X .usect *“.samp”,5
ARO.#1 .sect “.code
AR1,#3 MOVL XAR2, #x
ACC, *+XAR2[ARO] MOV ACC,*+XAR2[1]
ACC,*+XAR2[AR1] ADD ACC,*+XAR2[3]
*
PRA ] o MOV *+XAR2[2],AL

16 bit offset
Allows offset into arrays with fixed base pointer

3 bit offset
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Indirect Addressing

X2 =x1+ x3

.sect “.code”
MOV  AL,*-SP[1]
ADD  AL,*-SP[3]
MOV  *-SP[2],AL

Indirect Addressing — Example
Stack Relative

Data Memory
012 0[x3
0 3 2 0|x2
020 0(x1

| -SP - || empty

nst.1/0 0 0 0/0 2 0 0|
ns.2/0 0 0 0]0 3 2 0}

Useful for stack based operations

empty

Instr. 3

Accumulator

start of buffer

Indirect Addressing — Example

Circular

| AAAA .. AAAA |AAAA AAAA |oooo oooo|—>

Buffer Size N

(align on 256 word boundary)
access pointer XARG6 (32)

| AAAA .. AAAA |AAAA AAAA|xxxx xxx><i—>

AR1 Low (16)

end of buffer | ———————— |

N-1

Element 0 o
circular
buffer
range
Element N-1

(AR1 Low is set to buffer size — 1)

MAC P,*AR6%++,*XAR7++

LINKER.CMD

SECTIONS

}

{ Buf_Mem: align(256) { } > RAM PACGE 1
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Review

Review

Addressing Range Review

0x000000

0x00003F

|

OXO0OFFFF

OX3FFFFF

Stack
Addressing
Direct
SP Addressing
AL Sl
XARN
4G

OXFFFFFFFF

Data memory can be accessed in numerous ways:
e Stack Addressing: allows a range to 64K

o Direct Addressing: Offers a 16-bit DP plus a 6-bit offset, allowing a 4M range
e Indirect Addressing: Offers the full 4G range
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Review

Exercise B
Exercise B: Addressing
Given: DP = 4000 DP = 4004 DP = 4006
Address/Data (hex) 100030 |0025 100100 (0105 100180 [0100
Fill in the 100031 0120 100101 {0060 100181 |0030
table below 100032 100102 (0020 100182 [0040
Src Mode Program ACC DP XAR1 [ XAR2

MOVW DP,#4000h
MOVL XAR1,#100100h
MOVL XAR2,#100180h

MoV
ADD
SUB

AL,@31h
AL, *XAR1++
AL, @30h

ADD

AL, *XAR1++

MOVW DP,#4006h

ADD

AL, @1

SUB
ADD
SUB

AL, *XAR1
AL, *XAR2
AL, *+XAR2[1]

ADD
SUB
MoV

AL, #32
AL,*+XAR2[2]
@32h,AL

Reg: Register;

Imm: Immediate;

Dir: Direct;
Idr: Indirect

In the table above, fill in the values for each of the registers for each of the instructions. Three
areas of data memory are displayed at the top of the diagram, showing both their addresses and
contents in hexadecimal. Watch out for surprises along the way. First, you should answer the
addressing mode for the source operand. Then, fill in the change values as the result of the in-

struction operation.
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Lab B: Addressing

Lab B: Addressing
» Objective

The objective of this lab is to practice and verify the mechanics of addressing. In this process we
will expand upon the ASM file from the previous lab to include new functions. Additionally, we
learn how to run and observe the operation of code using Code Composer Studio.

In this lab, we will initialize the “vars’ arrays allocated in the previous lab with the contents of
the “const” table. How is this best accomplished? Consider the process of loading the first
“const’ value into the accumulator and then storing this value to the first “vars’ location,
and repeating this process for each of the succeeding values.

o What forms of addressing could be used for this purpose?
o Which addressing mode would be best in this case? Why?
e What problems could arise with using another mode?

> Procedure

Copy Files, Create Project File

1. Create a new project called LabB.pjt in C:\C28x\Labs\Appendix\LabB and add
LabB.asm, and LabB.cmd to it. Check your file list to make sure all the files are there.
Be sure to setup the Build Options by clicking: Project - Build Options onthe
menu bar. Select the Linker tab. In the middle of the screen select ““No
Autoinitialization” under “Autoinit Model:”. Create a map file by typing
-\Debug\LabB.map inthe Map Filename [-m] field. Enter start inthe
“Code Entry Point (-e):” field. Next, select the Compiler tab. Note that “Ful I
Symbolic Debug (-g)” under “Generate Debug Info:” isselected. Then
select OK to save the Build Options.

Initialize Allocated RAM Array from ROM Initialization Table

2. Edit LabB.asm and modify it to copy table[9] to data[9] using indirect addressing. (Note:
data[9] consists of the allocated arrays of data, coeff, and result). Initialize the allocated
RAM array from the ROM initialization table:

o Delete the NOP operations from the *““code’” section.

Initialize pointers to the beginning of the “const’ and ““vars arrays.

Transfer the first value from ““const” to the ““vars” array.

o Repeat the process for all values to be initialized.

To perform the copy, consider using a load/store method via the accumulator. Which part of an
accumulator (low or high) should be used? Use the following when writing your copy routine:
- use AR1 to hold the address of table
- use AR2 to hold the address of data

3. Itis good practice to trap the end of the program (i.e. use either “end: B end,UNC” or
“end: B start,UNC”). Save your work.
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Lab B: Addressing

Build and Load

4.

Click the ““Rebui Id A1’ button and watch the tools run in the build window. Debug as
necessary. To open up more space, close any open files or windows that you do not need.

Load the output file onto the target. Click:
File - Load Program..

If you wish, right click on the LabB_asm source window and select Mixed Mode to
debug using both source and assembly.

Note: Code Composer Studio can automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the ““Program Load
Options™ tab, check “Load Program After Build”,then click OK.

6.

Single-step your routine. While single-stepping, it is helpful to see the values located in
table[9] and data[9] at the same time. Open two memory windows by using the “View
Memory’’ button on the vertical toolbar and using the address labels table and data.

Setting the properties filed to “Hex — T1 style” will give you more viewable data in the
window. Additionally, it is useful to watch the CPU core (and status) registers. Open the
CPU core (and status) registers by using the “View -> CPU Registers”. Deselect
“Allow Docking’ and move/resize the window as needed. Check to see if the program is
working as expected.

You might want to use your workspace from the previous lab. Look under File - Recent
Workspaces on the menu bar to select your saved workspace quickly. If needed, reload your
project.

End of Exercise
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UOPTIONALU Lab B-C: Array Initialization in C

OPTIONAL Lab B-C: Array Initialization in C
» Objective

The objective of this lab is to practice and verify the mechanics of initialization using C.
Additionally, we learn how to run and observe the operation of C code using Code Composer
Studio. In this lab, we will initialize the ““vars’ arrays with the contents of the ““const”’ table.

» Procedure

Create Project File

1. In Code Composer Studio create a new project called LabB-C.pjtin
C:\C28x\Labs\Appendix\LabB\LabB-C and add LabB-C.c, LabB-C.cmd and
C:\ti1\c2000\cgtools\1ib\rts2800_ml.libtoit. Check your file list to make
sure all the files are there. Do not setup any Build Options. The default values will be used.
In Appendix Lab D exercise, we will experiment and explore the various build options when
working with C.

Initialize Allocated RAM Array from ROM Initialization Table

2. Edit LabB-C. c and modify the “main” routine to copy table[9] to the allocated arrays of
data[4], coeff[4], and result[1]. (Note: data[9] consists of the allocated arrays of data, coeff,
and result).

Build and Load

3. Click the ““Rebuild Al I’ button and watch the tools run in the build window. Debug as
necessary.

Note: Have Code Composer Studio automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the ““Program Load Options”
tab, check “Load Program After Build”, then click OK.

4. Under Debug on the menu bar click ““Go Main”. Single-step your routine. While single-
stepping, it is helpful to see the values located in table[9] and data[9] at the same time. Open
two memory windows by using the “View Memory” button on the vertical toolbar and
using the address labels table and data. Setting the properties filed to “Hex — T1 style”
will give you more viewable data in the window. Additionally, you can watch the CPU (and
Status) registers. Open the CPU core and status registers by using the “View -> CPU
Registers™. Deselect “Allow Docking’ and move/resize the window as needed.
Check to see if the program is working as expected.

End of Exercise
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Solutions

Solutions
Exercise B: Addressing - Solution
Given: DP = 4000 DP = 4004 DP = 4006
Address/Data (hex) 100030 [0025 100100 [0105 100180 [0200
Fill in the 100031 0120 100101 {0060 100181 |0030
table below 100032 100102 (0020 100182 |0040
Src Mode Program ACC DP XAR1 [ XAR2
Imm MOVW DP,#4000h 4000
Imm MOVL XAR1,#100100h 100100
Imm | MOVL XAR2,#100180h 100180
Dir | MOV AL,@31h 120
Idr ADD AL,*XAR1++ 225 100101
Dir | SUB AL,@30h 200
Idr | ADD AL,*XAR1++ 260 100102
Imm MOVW DP,#4006h 4006
Dir | ADD AL,@1 290
Idr | SUB AL,*XAR1 270
Idr | ADD AL,*XAR2 370
Idr | SUB AL,*+XAR2[1] 340 100180
Imm | ADD AL,#32 360
ldr | SUB AL,*+XAR2[2] 320 100180
Dir | MOV @32h,AL 1001B2 {0320
Imm: Immediate;  Dir: Direct;
Reg: Register; Idr: Indirect
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Appendix C — Assembly Programming

Introduction

Appendix C discusses the details of programming in assembly. It shows you how to use
different instructions that further utilize the advantage of the architecture data paths. It gives
you the ability to analyze the instruction set and pick the best instruction for the application.

Learning Objectives

Learning Objectives

¢ Perform simple program control using
branch and conditional codes

¢ Write C28x code to perform basic
arithmetic

¢ Use the multiplier to implement
sum-of-products equations

¢ Use the RPT instruction (repeat) to
optimize loops

¢ Use MAC for long sum-of-products

¢ Efficiently transfer the contents of one
area of memory to another

¢ Examine read-modify-write operations
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Module Topics

Module Topics
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Program Control

Program Control

The program control logic and program address generation logic work together to provide proper
program flow. Normally, the flow of a program is sequential: the CPU executes instructions at
consecutive program memory addresses. At times, a discontinuity is required; that is, a program
must branch to a nonsequential address and then execute instructions sequentially at that new
location. For this purpose, the C28x supports interrupts, branches, calls, returns, and repeats.
Proper program flow also requires smooth flow at the instruction level. To meet this need, the
C28x has a protected pipeline and an instruction-fetch mechanism that attempts to keep the

pipeline full.
Branches
Branch Types and Range
> 3 Branch Types
0x000000
A T Long
Short Branch Branch B H
ranc
Program| ©ffset +127 qtreer +1-32k
0 1128d 5 q absolute 4M
Memor -wor ~ 2-worc
Y instruction instruction ingt-:’/\llj?:?ijon
R
~<—PC
Ox3FFFFF

The PC can access the entire 4M words (8M bytes) range. Some branching operations offer 8-
and 16-bit relative jumps, while long branches, calls, and returns provide a full 22-bit absolute
address. Dynamic branching allows a run-time calculated destination. The C28x provides the fa-
miliar arithmetic results status bits (Zero, oVerflow, Negative, Carry) plus a Test Control bit
which holds the result of a binary test. The states of these bits in various combinations allow a
range of signed, unsigned, and binary branching conditions offered.
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Program Control

Program Control Instructions

Program Control - Branches

Function Instruction Cycles T/F|Size
Short Branch SB 8bit,cond 7/4 1
Fast Short Branch SBF 8bit,EQINEQ]JTC|NTC 4/4 1
Fast Relative Branch| B 16bit,cond /4 2
Fast Branch BF 16bit,cond 4/4 2
Absolute Branch LB 22bit 4 2
Dynamic Branch LB *XAR7 4 1
Branch on AR BANZ 16bit,ARn-- 4/2 2
Branch on compare | BAR 16bit,ARn,ARn,EQ|NEQ 4/2 2

Condition Code

NEQ LT LO(NC) NTC 4 Condition flags are set on
EQ LEQ LOS TC the prior use of the ALU
GT HI NOV UNC - oo
@ The assembler will optimize
GE HIS (C oV . .
© ©) NBIO B to SB if possible

Program Control - Call/Return
Function Call Code Cycles | Return code | Cycles

Call LCR 22bit 4 LRETR 4
Dynamic Call LCR *XARn 4 LRETR 4
Interrupt Return IRET 8

+ More Call variations LCR Func Stack

in the user guide are LRETR Local

for code backward Var

compatibility RPC| Old RPC [e=——= [22-bit old
New RPC ---------2 > | Ret Addr J RPC
o [ Func ¥
Ret Addr
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Program Control

BANZ Loop Control Example

€ Auxliary register used as loop counter
€ Branch if Auxilary Register not zero
@ Test performed on lower 16-bits of XARx only

4
y= Z Xn len .set 5
0 Data X -usect ‘“‘samp”,6
X x0 |<— xAR2 | Y -set (x+len)
i; % .sect “code”
3 ) MOVL XAR2 , #Xx
o MoV AR3,#len-2
, MOV AL, *XAR2++
sum: ADD AL, *XAR2++
BANZ sum,AR3--
AR3 :
e
e MOV (0:y),AL

C28x - Appendix C - Assembly Programming C-5



ALU and Accumulator Operations

ALU and Accumulator Operations

ALU and Accumulator

16/32 data mem,
> Product (32) 16/32 bit registers

A

Y

MUX | 826 imm |

> ALU and Barrel Shifter

Y
ACC

AH (31-16) AL (15-0)
AH.MSB | AH.LSB | AL.MSB | AL.LSB

One of the major components in the execution unit is the Arithmetic-Logical-Unit (ALU). To
support the traditional Digital Signal Processing (DSP) operation, the ALU also has the zero
cycle barrel shifter and the Accumulator. The enhancement that the C28x has is the additional
data paths added form the ALU to all internal CPU registers and data memory. The connection to
all internal registers helps the compiler to generate efficient C code. The data path to memory
allows the C28x performs single atomic instructions read-modify-write to the memory.

The following slides introduce you to various instructions that use the ALU hardware. Word,
byte, and long word 32-bit operation are supported.
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ALU and Accumulator Operations

Simple Math & Shift

Accumulator - Basic Math Instructions
E XXX Ax, #16b ;word XXX = instruction: MOV, ADD, SUB, ...
- Ax = AH, or AL
o) XxXB - AX, #8b zbyte Assembler will automatically convert to 1
L | xxxL  ACC, #32b ;long | word instruction
x |ADD ACC, #01234h<<4 Two word instructions with shift option
W | ADDB AL, #34h One word instruction, no shift
Ax = AH or AL Operations
ACC Operations MOV~ Ax, locl6
- | mov ACC, loc16<<shift ADD  Ax, loclé
n SUB Ax, locl6
© | ADD } from memory (left shift 2
T | suB optional) AND  Ax, locil6
= - OR AX locl6
m << ’
> Xg\é }ACC’#lsb shift XOR  Ax, locl6
16-bit constant (left shift
SUB optional) AND Ax,locl6,#16b
NOT AX
MOV locl6,ACC <<shift ;AL| | NEG  Ax
MOVH locl6,ACC <<shift ;AH MOV locl16,Ax

Shift the Accumulator

Shift full ACC 3. 0
LSL  ACC <sshift| o c ACC o |5t
SFR  ACC >>shift
LSL  ACC <<T (0-15) ... 0
SFR  ACC >>T SXM—| ACC |—cC |SFR
15 ......... 0
B | o |
LSL AX <<shift
LSR  AX <<shift 15......... 0
ASR  AX >>shift SXM—~ Ax |—C|ASR
LSL  AX <<T
LSR  AX <<T 15 ..., 0
ASR  AX >>T 0+ Ax |—c|LSR
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ALU and Accumulator Operations

32 Bit Shift Operations [ACC]

3. 0
C ACC [«—0
- Examples:
Logical Shift Left — Long: LSLL LSLL ACC, T
i 5 LSRL ACC, T
0 ACC |—c ASRL ACC, T
Logical Shift Right — Long: LSRL Note: T(4:0) are used;
other bits are ignored
31......... 0
Oor1l ACC |—C
based on SXM

Arithmetic Shift Right — Long: ASRL
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Multiplier

Multiplier
Multiply Unit
XT Register < (I)Draé%gﬁg} J
T Register A
32x32 Multiply Unit
SRR <_ g
Immed (8,16

Y
P Register (32)

P

Shift (PM)
Y

ACC (32)

Y

Digital signal processors require many multiply and add math intensive operations. The single
cycle multiplier is the second major component in the execution unit. The C28x has the
traditional 16-bit-by-16-bit multiplier as previous Tl DSP families. In-addition, the C28x has a
single cycle 32-bit-by-32-bit multiplier to perform extended precision math operations. The large
multiplier allows the C28x to support higher performance control systems requirement while
maintaining small or reduce code.

The following slides introduce instructions that use the 16-bit-by-16-bit multiplier and multiply
and add (MAC) operations. The 32-bit-by-32-bit multiplication will be covered in the appendix.
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Multiplier

Basic Multiplier

Multiplier Instructions

Instruction Execution Purpose
MoV T,locl6 T = loclé Get first operand
MPY ACC,T,locl6|ACC = T*locl6l For single or first product
MPY P,T,locl6 |P = T*locl6 For n" product
MPYB  ACC,T,#8bu |ACC = T*8bu Using 8-bit unsigned const
MPYB P,T,#8bu P = T*8bu Using 8-bit unsigned const
MOV ACC,P ACC =P Move 15t product<<PM to ACC
ADD ACC,P ACC += P Add nt" product<<PM to ACC
SUB ACC,P ACC -= P Sub nt" product<<PM fr. ACC
Instruction Execution
MOVP T, locl6 ACC =P<<PM T = locl6
MOVA T, locl6 ACC += P<<PM T = loc16
MOVS T, locl6 ACC - = P<<PM T = locl6
MPYA P, T, #16b ACC += P<<PM then P =T*#16b
MPYA P, T, locl6 ACC += P<<PM then P =T*locl6
MPYS P, T, locl6 ACC - = P<<PM then P =T*locl6

Su

Y = A*X1 + B*X2 + C*X3 + D*X4

ZAPA ;ACC = P =0VC =0

MOV T,@Xx1 ;T = X1

MPY P,T,Q0A ;P = A*X1

MOVA T,@X2 ;T = X2 ;ACC = A*X1

MPY P,T,@B ;P = B*X2

MOVA T,@X3 ;T = X3 ;ACC = A*X1 + B*X2

MPY P,T,@C ;P = C*X3

MOVA T,@X4 ;T = X4;ACC = A*X1 + B*X2 + C*X3
MPY P,T,@D ;P = D*X4

ADDL ACC,P<<PM ;ACC =Y

MOVL @y,ACC

m-of-Products
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Multiplier

32x32 Long Multiplication

_Integer long multiplication
u(long) = u(long) * u(long)

Fraction long multiplication:
| (long) = (long) * (long)

| z3 | z2 | 71 | 20 |<---(long)64 = (long) 32 * (long) 32
I

P-register |

[ Y1 » xa

| Accumulator

IMPYAL  P,XT,loc32 P = u(XT)*u(loc32)
QMPYAL  ACC,XT,loc32| ACC = (XT)*(loc32)

IMACL P,l10oc32,*XAR7 | ACC +=P; P =u(loc32)*u(loc32)
QMACL P,loc32,*XAR7 | ACC +=P; P = (loc32)*(loc32)

Repeat Instruction

Repeat Next: RPT

¢ Options:
> RPT #8bit up to 256 iterations
> RPT locl6 location “loc16” holds count value
& Features: Example :
» Next instruction iterated N+1 times int x[5]={0,0,0,0,0};
» Saves code space - 1 word
» Low overhead - 1 cycle 2 SWEEEE TR
MOV  AR1,#x
> Easy to use
Non-int tibl RPT  #4
> on—|_n erruptible _ [| MOV  *XAR1++,#0
» Requires use of || before next line

» May be nested within BANZ loops
Instruction |Cycles

RPT 1
BANZ 4N

Refer to User Guide for more repeatable instructions
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Multiplier

Single repeat instruction (RPT) is used to reduce code size and speed up many operations in the
DSP application. Some of the most popular operations that use the RPT instruction to perform
multiple taps digital filters or perform block of data transfer.

MAC Instruction
Sum-of- Products RPT / MAC

-usect “sample”,20
19 y .usect “result”,2
y — z X a .sect “coefficient"
= a0: .word 0x0101
n=0 .word 0x0202

XAR1++ X0 .word 0x2020

X1 .sect “code”
SOP: SPM 0
MOVW  DP,#y
MOVL XAR1 , #x

MOVL  XAR7,#a0
ZAPA <« ZeroACC & P

XART7++ A0 RPT  #19 < Repeat single
Second operand ] MAC P,*XAR1++,*XAR7++ # Dual operand
Al 0 » p
must use XAR7 ADDL  ACC,P<<PM<—— last ADD
MOVL  @y,ACC
AL9 B SOP,UNC

X19

MOV T,Ioc16} MOVA T,loc16 incd | s
ADD ACC,P MPY P,T,locl6 P=T*(*ARn++)
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Data Move

Data Move

Data Move Instructions

DATA & DATA (4G © 64K) DATA & PGM (4G & 4M)
MOV  locl6, *(0:16bit) PREAD locl16 ,*XAIi?
MOV :(O:leit), IOC]‘6‘ PWRITE /4 *XAR7, I0016\\

\

-~ ~
-

~ /
16-bit address concatenated 32-bit address memory pointer with a 22-bit
with 16 leading zeros location program memory address

.sect “.code”
START: MOVL XARS5 , #x

MOVL  XAR7,#TBL

RPT #len-1

11 PREAD *XAR5++,*XAR7

X .usect “.samp”,4
.sect “.coeff”

TBL: .word 1,2,3.,4

len .set $-TBL

¢ Optimal with RPT (speed and code size) & Faster than Load / Store, avoids

& In RPT, non-mem address is auto- accumulator
incremented in PC & Allows access to program memory

Conditional Moves

Instruction Execution (if COND is met)
MOV locl6,AX,COND [locl6] = AX

MOVB l1ocl6,#8bit,COND | [locl6] = 8bit
Instruction Execution (if COND is met)
MOVL loc32,ACC,COND [loc32] = AX

Example
If A<B, Then B=A
Accumulator
A .usect “var”,2,1 loooo0jo12o0|
B _.set A+1
-sect code Data Memory Data Memory
MOVW DP, #A
MOV AL. @A 0120A 0120A
CMP AL. 0B 0320|B 0120B
MOV @B, AL, LT Before After

The conditional move instruction is an excellent way to avoid a discontinuity (branch or call)
based upon a condition code set prior to the instruction. In the above example, the 1% step is to
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Data Move

place the contents of A into the accumulator. Once the Ax content is tested, by using the CMP
instruction, the conditional move can be executed.

If the specified condition being tested is true, then the location pointed to by the “loc16” address-
ing mode or the 8-hit zero extended constant will be loaded with the contents of the specified AX
register (AH or AL): if (COND ==true) [loc16] = AX or 0:8bit;

Note: Addressing modes are not conditionally executed. Hence, if an addressing mode performs a
pre or post modification, it will execute regardless if the condition is true or not. This instruction
is not repeatable. If this instruction follows the RPT instruction, it resets the repeat counter
(RPTC) and executes only once.

Flags and Modes

N - If the condition is true, then after the move, AX is tested for a negative condition. The nega-
tive flag bit is set if bit 15 of AX is 1, otherwise it is cleared.

Z - If the condition then after the move, AX is tested for a zero condition. The zero flag bit is set
if AX =0, otherwise it is cleared.

V - If the V flag is tested by the condition, then V is cleared.

C-Example
;if (VarA>20)
:VarA =0;

CMP @VarA #20 ; Set flags on (VarA - 20)
MOVB @VarA#0,GT ; Zero VarA if greater then
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Logical Operations

Logical Operations

Byte Operations and Addressing

Byte Operations

MOVB AX.LSB,loc16

MOVB AX.MSB,loc16

MOVB locl6, AX.LSB

MOVB locl16, AX.MSB

0000 0000 Byte
Byte No change

No change Byte

No change Byte

Byte = 1. Low byte for register addressing
2. Low byte for direct addressing
3. Selected byte for offset indirect addressing

AX

AX

locl16

loc16

For loc16 = *+XARN[Offset] Odd Offset | Even Offset locl6
Byte Addressing
AH.MSB AH.LSB AL.MSB AL.LSB
12|34|56|78|
LlG bit memory
78 | 00 Je]AR2 |
83> 56
> 34 | 04
67> 12

Example of Byte Un-Packing

Example of Byte Packing

MOVL
MOVB
MOVB
MOVB
MOVB

XAR2, #MemA
*+XAR2[1], AL.LSB
*+XAR2[2], AL.MSB
*+XAR2[5], AH.LSB
*+XAR2[6], AH.MSB

MOVL XAR?2, #MemA
MOVB AL.LSB,*+XAR2[1]
MOVB AL.MSB,*+XAR2[2]
MOVB AH.LSB,*+XAR2[4]
MOVB AH.MSB,*+XAR2[7]
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Logical Operations

Test and Change Memory Instructions

The compare (CMPXx) and test (TxxXx) instructions allow the ability to test values in memory. The
results of these operations can then trigger subsequent conditional branches. The CMPX instruc-
tion allows comparison of memory with respect to a specified constant value, while the Txxx in-
structions allow any single bit to be extracted to the test control (TC) field of status register 0.
The contents of the accumulator can also be non-destructively analyzed to establish branching
conditions, as seen below.

Test and Change Memory

Instruction Execution Affects
TBIT Bocl6,#(0-15) | STO(TC) = loc16(bit_no) TC
TSET  locl6,#(0-15) | Test (locl6(bit)) then set bit TC
TCLR locl6,#(0-15) | Test (loc16(bit)) then clr bit TC

CMPB AX, #8bit Test (AX - 8bit unsigned) CN,Z
CMP AX, locl6 Test (AX —loc16) C.N,Z
CMP locl6,#16b Test (loc16 - #16bit signed) CN,z
CMPL  ACC, @P Test (ACC - P << PM) CN,Z
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Logical Operations

Min/Max Operations

MIN/MAX Operations

Instruction Execution
MAX ACC, locl6 ACC < locl6, ACC = locl6
ACC >= locl6, do nothing
ACC > locl6, ACC = locl6
ACC <= locl6, do nothing
ACC < loc32, ACC = loc32
ACC >= loc32, do nothing
ACC > loc32, ACC = loc32
ACC <= loc32, do nothing
P < loc32, P = loc32
P >= loc32, do nothing
P > loc32, P = loc32
P <= loc32, do nothing

MIN ACC, locl6

MAXL ACC, loc32

MINL ACC, loc32

MAXCUL P, loc32
(for 64 bit math)
MINCUL P,loc32
(for 64 bit math)

= =h|=h =h[=h =h|=h =h[=h = [ =

Find the maximum 32-bit number in a table:
MOVL ACC#0
MOVL XARL #table
RPT #(table_length — 1)
[I MAXL ACC,*XAR1++
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Read Modify Write Operations

Read Modify Write Operations

The accumulator (ACC) is the main working register for the C28x. It is the destination of all
ALU operations except those, which operate directly on memory or registers. The accumulator
supports single-cycle move, add, subtract and compare operations from 32-bit-wide data memory.
It can also accept the 32-bit result of a multiplication operation. These one or two cycle
operations are referred to as read-modify-write operations, or as atomic instructions.

Read-Modify-Write Instructions

€ Work directly on memory — bypass ACC
€ Atomic Operations — protected from interrupts

AND locl16,AX K3 AND locl6,#16b

OR  locl6,AX OR  locl6,#16b

XOR loc16,AX AH XOR locl6,#16b 16- bit
AL’ constant

ADD locl6,AX ADD locl6,#16b

SUB - Hocl6, AX SUBR loc16,#16b
SUBR loci1i6,AX | |  }lb——""—-—— ‘"=

INC 1locl6 TSET locl6,#bit
DEC locl6 TCLR locl6,#bit

C28x - Appendix C - Assembly Programming



Read Modify Write Operations

Read-Modify-Write Examples

update with a mem update with a constant update by 1

VarA +=VarB | VarA +=100 VarA +=1

SETC INTM SETC INTM SETC INTM

MOV AL, @varB MOV AL, @VarA MOV AL, @VarA
ADD AL, @VvarA ADD AL, #100 ADD AL, #1
MOV @VarA, AL MOV @VarA, AL MOV @VarA, AL
CLRC INTM CLRC INTM CLRC INTM

MOV AL, @varB ADD @varA,#100 INC @varA
ADD @VarA, AL

—

Benefits of Read-Modify-Write Instructions
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Lab C: Assembly Programming

Lab C: Assembly Programming
» Objective

The objective of this lab is to practice and verify the mechanics of performing assembly language
programming arithmetic on the TMS320C28x. In this process we will expand upon the - asm file
from the previous lab to include new functions. Code will be to added to obtain the sum of the
products of the values from each array.

Perform the sum of products using a MAC-based implementation. In a real system application,
the coeff array may well be constant (values do not change), therefore one can modify the
initialization routine to skip the transfer of this arrays, thus reducing the amount of data RAM and
cycles required for initialization. Also, there is no need to copy the zero to clear the result
location. The initialization routine from the previous lab using the load/store operation will be
replaced with a looped BANZ implementation.

As in previous lab, consider which addressing modes are optimal for the tasks to be performed.
You may perform the lab based on this information alone, or may refer to the following
procedure.

> Procedure

Copy Files, Create Project File

1. Create a new project called LabC.pjt in C:\C28x\Labs\Appendix\LabC and
add LabC.asm, and LabC.cmd to it. Check your file list to make sure all the files are
there. Be sure to setup the Build Options by clicking: Project -> Build
Options onthe menu bar. Select the Linker tab. In the middle of the screen select
“No Autoinitialization” under “Autoinit Model:". Create a map file by
typing -\Debug\LabC.map inthe Map Filename [-m] field. Enter start
in the “Code Entry Point (-e):” field. Next, select the Compiler tab. Note that
“Full Symbolic Debug (-g)” under “Generate Debug Info:”is
selected. Then select OK to save the Build Options.

Initialization Routine using BANZ

2. Edit LabC.asm and modify it by replacing the initialization routine using the load/store
operation with a BANZ process. Remember, it is only necessary to copy the first four
values (i.e. initialize the data array). Do you still need the coeff array in the vars section?

3. Save your work. If you would like, you can use Code Composer Studio to verify the
correct operation of the block initialization before moving to the next step.
Sum of Products using a RPT/MAC-based Implementation

4. Edit LabC.asmto add a RPT/MAC-based implementation to multiply the coeff array by
the data array and storing the final sum-of-product value to result.
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Build and Load

5. Click the “Rebui ld Al button and watch the tools run in the build window. Debug

as necessary. To open up more space, close any open files or windows that you do not
need.

6. Ifthe “Load program after build” option was not selected in Code Composer
Studio, load the output file onto the target. Click: File > Load Progranm..

If you wish, right click on the source window and select Mixed Mode to debug using
both source and assembly.

7 . Single-step your routine. While single-stepping, open memory windows to see the values
located in table [9] and data [9] . Open the CPU Registers. Check to see if the program is
working as expected. Debug and modify, if needed.

Optional Exercise

After completing the above, edit LabC.asm and modify it to perform the initialization
process using a RTP/PREAD rather than a load/store/BANZ.

End of Exercise
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OPTIONAL Lab C-C: Sum-of-Products in C

» Objective

The objective of this lab is to practice and verify the mechanics of performing C programming
arithmetic on the TMS320C28x. The objective will be to add the code necessary to obtain the
sum of the products of the n-th values from each array.

» Procedure

Create Project File

1. In Code Composer Studio create a new project called LabC-C_pjtin
C:\C28x\Labs\Appendix\LabC\LabC-C and add LabC-C.c, LabC-C.cmd
and C:\ti1\c2000\cgtools\1ib\rts2800_ml.libtoit. Check your file list to
make sure all the files are there. Do not setup any Build Options. The default values will
be used. In Appendix Lab D exercise, we will experiement and explore the various build
options when working with C.

Sum of Products using a MAC-based Implementation

2. Edit LabC-C.c and modify the “main” routine to perform a MAC-based
implementation in C. Since the MAC operation requires one array to be in program
memory, the initialization routine can skip the transfer of one of the arrays, thus reducing
the amount of data RAM and cycles required for initialization.

Build and Load

3. Click the ““Rebui ld All’" button and watch the tools run in the build window. Debug
as necessary.

Note: Have Code Composer Studio automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the “Program Load Options”
tab, check “Load Program After Build”, then click OK.

4 . Under Debug on the menu bar click ““Go Main”. Single-step your routine. While
single-stepping, open memory windows to see the values located in table [9] and data
[9] . (Note: data[9] consists of the allocated arrays of data, coeff, and result). Open the
CPU Registers. Check to see if the program is working as expected. Debug and modify,
if needed.

End of Exercise
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Appendix D — C Programming

Introduction

The C28x architecture, hardware, and compiler has been designed to efficiently support C code

programming.

Appendix D will focus on how to program in C for an embedded system. Issues related to
programming in C and how C behaves in the C28x environment will be discussed. Also, the C

compiler optimization features will be explained.

Learning Objectives

*

® 6 o o

Learning Objectives

Learn the basic C environment for
the C28x family

How to control the C environment
How to use the C-compiler optimizer
Discuss the importance of volatile
Explain optimization tips

C28x — C Programming
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Module Topics

Module Topics
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Linking Boot code from RTS2800.lib

Linking Boot code from RTS2800.lib
Boot.ASM - Invoked With ““-C”

| Reset : PC <- *Ox3F FFCO |

vectors.asm ¢

.ref _c_int00
Reset:

-long c_int00

c_int0o0 *

- Allocate stack

Init SP to top of stack

Initialize status bits

Copy .cinit to .bss (skip if “-cr”)
Call “_main”

obhwN R

The boot routine is used to establish the environment for C before launching main. The boot
routine begins with the label _c_int00 and the reset vector should contain a ".long" to this address
to make boot.asm the reset routine. The contents of the boot routine have been extracted and
copied on the following page so they may be inspected. Note the various functions performed by
the boot routine, including the allocation and setup of the stack, setting of various C-requisite
statuses, the initialization of global and static variables, and the call to main. Note that if the link
was performed using the "—cr* option instead of the "—c" option that the global/static variable
initialization is not performed. This is useful on RAM-based C28x systems that were initialized
during reset by some external host processor, making transfer of initialization values unnecessary.
Later on in this chapter, there is an example on how to do the vectors in C code rather than
assembly.
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Set up the Stack

Set up the Stack

The Stack
Data Memory
The C/C++ compiler uses a
stack to:
¢ Allocate local variables
SP — 0x400| caller’s
(reset) Ve s ¢ Pass arguments to
Arguments functions
passed on & Save the processor status
Return & Save the function return
address stack address
Function
return addr ¢ Save temporary results
Temp results The compiler uses the hardware
stack pointer (SP) to

64K manage the stack.
SP defaults to 0x400 at reset.
4AM The run-time stack grows from

low addresses to higher
addresses.

The C28x has a 16-bit stack pointer (SP) allowing accesses to the base 64K of memory. The stack
grows from low to high memory and always points to the first unused location. The compiler
uses the hardware stack pointer (SP) to manage the stack. The stack size is set by the linker.

Setting Up the Stack

Boot.asm sets up SP to
point at .stack

Linker command file: ¢ The .stack section has to

SECTIONS { be linked into the low 64k
.stack :> RAM align=2 of data memory. The SPis
3} a 16-bit register and cannot
access addresses beyond
64K.

& Stack sizeis set by the
linker. The linker creates a

Note: The compiler provides no
means to check for stack
overflow during compilation or at
runtime. A stack overflow
disrupts the run-time
environment, causing your
program to fail. Be sure to allow
enough space for the stack to
grow.

global symbol,
--STACK-SIZE, and assigns
it a value equal to the size
of the stack in bytes.
(default 1K words)

¢ You can change stack size
at link time by using the
-stack linker command
option.

In order to allocate the stack the linker command file needs to have “align = 2.”
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C28x Data Types

C28x Data Types

C28x C-Language Data Types

Type Bit Value Range

char 16 Usually 0 .. 255, but can hold 16 bits
int (natural size CPU word) 16 -32K .. 32K, 16 bits signed
unsigned int 16 0..64K, 16 bits unsigned
short (same as int or smaller) 16 same as int

unsigned short 16 same as unsigned int
long (same as int or larger) 32 -2M .. 2M, 32 bits signed
unsigned long 32 0..4M, 32 bits unsigned
float 32 |IEEE single precision
double 64 |IEEE double precision
long double 64 |EEE double precision

Suggestion: Group all longs together, group all pointers together

Data which is 32-bits wide, such as longs, must begin on even word-addresses (i.e. 0x0,
0x2, etc). This can result in “holes” in structures allocated on the stack.
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Accessing Interrupts / Status Register
Accessing Interrupts / Status Register

Initialize via C :
extern cregister volatile unsigned int IFR;
extern cregister volatile unsigned int IER;

IER &= ~Mask; //clear desired bits
IER |= Mask; //set desired bits
IFR = 0x0000; //clear prior interrupts

¢ Interrupt Enable & Interrupt Flag Registers (IER, IFR) are not
memory mapped

¢ Only limited instructions can access IER & IFR (more in interrupt
chapter)

& The compiler provides extern variables for accessing the IER & IFR
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Using Embedded Assembly

Using Embedded Assembly

Embedding Assembly in C

¢ Allows direct access to assembly language from C
¢ Useful for operating on components not used by C, ex:

asm (“CLRC INTM ;enable global interrupt™);

#define EINT asm (“ CLRC INTM”)

¢ Note: first column after leading quote is label field - if no label,
should be blank space.

¢ Avoid modifying registers used by C

¢ Lengthy code should be written in ASM and called from C
» main C file retains portability
> yields more easily maintained structures

» eliminates risk of interfering with registers in use by C

The assembly function allows for C files to contain 28x assembly code. Care should be taken not
to modify registers in use by C, and to consider the label field with the assembly function. Also,
any significant amounts of assembly code should be written in an assembly file and called from
C.

There are two examples in this slide — the first one shows how to embed a single assembly
language instruction into the C code flow. The second example shows how to define a C term that
will invoke the assembly language instruction.
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Using Pragma

Using Pragma

Pragma is a preprocessor directive that provides directions to the compiler about how to treat a
particular statement. The following example shows how the DATA_SECTION pragma is used
to put a specific buffer into a different section of RAM than other buffers.

The example shows two buffers, bufferA and bufferB. The first buffer, bufferA is treated
normally by the C compiler by placing the buffer (512 words) into the ".bss" section. The second,
bufferB is specifically directed to go into the “my_sect” portion of data memory. Global
variables, normally ".bss", can be redirected as desired.

When using CODE_SECTION, code that is normally linked as ".text", can be identified
otherwise by using the code section pragma (like .sect in assembly).

Pragma Examples

& User defined sections from C :

#pragma CODE_SECTION (func, section name’)
#pragma DATA SECTION (symbol, “section name’)

¢ Example - using the DATA_SECTION Pragma
¢ Csourcefile

char bufferA[512];
#pragma DATA_SECTION(bufferB, “my_sect”)
char bufferB[512];

¢ Resulting assembly file
.global _bufferA, _bufferB
.bss _bufferA,512
_bufferB: .usect “my_sect”,512

More #pragma are defined in the C compiler UG
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Optimization Levels

Optimization Levels

Optimization Scope

-02

FUNCTION
across
blocks

FILE1.C
. -00, -0l
SESE
} LOCAL
single block
{ _______________________
} SESE: Single Entry, Single Exit
! l
{
}
FILE2.C
{
}

-03

FILE
across
functions

-pm -03

PROGRAM
across files

Optimizations fall into 4 categories. This is also a methodology that should be used to invoke the
optimizations. It is recommended that optimization be invoked in steps, and that code be verified
before advancing to the next step. Intermediate steps offer the gradual transition from fully sym-
bolic to fully optimized compilation. Compiler switched may be invoked in a variety of ways.

Here are 4 steps that could be
1% use —g

considered:

By starting out with —g, you do no optimization at all and keep symbols for debug.

2" use —-g —03

The option —03 might be too big a jump, but it adds the optimizer and keeps symbols.

3": use -g —03 -mn

This is a full optimization, but keeps some symbols

4™ use —03
Full optimization, symbol

s are not kept.
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Optimization Levels

LOCAL

\4

FUNCTION

PROGRAM
v

Optimization Performance

-00 Performs control-flow-graph simplification
Allocates variables to registers
Performs loop rotation
Eliminates unused code
Simplifies expressions and statements
Expands calls to functions declared inline
—01  Performs local copy/constant propagation
Removes unused assignments
Eliminates local common expressions
—02  Default (-0)
Performs loop optimizations
Eliminates global common sub-expressions
Eliminates global unused assignments
—03  Removes all functions that are never called
Simplifies functions with return values that are never used
Inlines calls to small functions
Identifies file-level variable characteristics
-03 —pm

Optimizer levels zero through three, offer an increasing array of actions, as seen above. Higher
levels include all the functions of the lower ones. Increasing optimizer levels also increase the
scope of optimization, from considering the elements of single entry, single-exit functions only,
through all the elements in a file. The “-pm” option directs the optimizer to view numerous input
files as one large single file, so that optimization can be performed across the whole system.

D- 10

C28x — C Programming



Optimization Levels

Volatile Usage

Optimization Issue: “Volatile” Variables

Problem: The compiler does not know that this pointer may refer to a
hardware register that may change outside the scope of the C program.
Hence it may be eliminated (optimized out of existence!)

Wrong: Wait loop for a hardware signal Optimizer removes
unsigned int *CTRL empty loop_

while (*CTRL 1=1); e
/
empt
Solution: ( |0gpy
volatile unsigned int *CTRL hN

while (*CTRL !=1);

¢ When using optimization, it is important to declare variables as
volatile when:

» The memory location may be modifed by something other than the
compiler (e.g. it’s a memory-mapped peripheral register).

» The order of operations should not be rearranged by the compiler
¢ Define the pointer as “volatile” to prevent the optimizer from optimizing
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Compiler Advanced Options

To get to these options, go to Project - Build Options in Code Composer Studio.

In the category, pick Advanced.

The first thing to notice under advanced options is the Auto Inlining Threshold.

- Used with —03 option

- Functions > size are not auto inlined

Note: To prevent code size increases when using —03, disable auto inlining with -0i0

The next point we will cover is the Normal Optimization with Debug (-mn).

- Re-enables optimizations disabled by “~g” option (symbolic debug)

- Used for maximum optimization

Note: Some symbolic debug labels will be lost when —mn option is used.

Optimizer should be invoked incrementally:

-g test Symbols kept for debug

-g -03 test Add optimizer, keep symbols

-g -03 -mn test More optimize, some symbols

-03 test Final rev: Full optimize, no symbols

[-mf] : Optimize for speed instead of the default optimization for code size

[-mi] : Avoid RPT instruction. Prevent compiler from generating RPT instruction. RPT instruc-
tion is not interruptible

[-mt] : Unified memory model. Use this switch with the unified memory map of the 2810 &
2812. Allows compiler to generate the following:
-RPT PREAD for memory copy routines or structure assignments

-MAC instructions
-Improves efficiency of switch tables
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Optimization Levels

Optimization Tips Summary

Summary: Optimization Tips

¢ Within C functions :
Use const with variables for parameter constants
Minimize mixing signed & unsigned ops : SXM changes
Keep frames <= 64 (locals + parameters + PC) : *-SP[6bit]
Use structures <= 8 words : use 3 bit index mode
Declare longs first, then declare ints : minimize stack holes
Avoid: long = (int * int) : yields unpredictable results
¢ Optimizing : Use -00, -01, -02, -03 when compiling
Inline short/key functions
Pass inlines between files : static inlines in header files
Invoke automatic inlining : -03 -oi

> Give compiler project visibility : use -pm and -03
¢ Tune memory map via linker command file
¢ Re-write key code segments to use intrinsics or in assembly

App notes 3rd Parties

YV V V V V VY

YV V VY

The list above documents the steps that can be taken to achieve increasingly higher coding effi-
ciency. It is recommended that users first get their code to work with no optimization, and then
add optimizations until the required performance is obtained.
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Lab D: C Optimization

Lab D: C Optimization
» Objective

The objective of this lab is to practice and verify the mechanics of optimizing C programs. Using
Code Composer Studio profile capabilities, different routines in a project will be benchmarked.
This will allow you to analyze the performance of different functions. This lab will highlight the
profiler and the clock tools in CCS.

Procedure

Create Project File

1.

Create a new project in C:\C28x\Labs\Appendix\LabD called LabD.pjt and
add LabD.c, LabD.cmd, and sop-c.c to it. (Note that sop-asm.asm will be used
in the next part of the lab, and should not be added now). Also, add the compiler run-
time support library to the project

(C:\ti\c2000\cgtools\lib\rts2800 _ml.1ib).

Setup the Build Options. Select the Linker tab and in the middle of the screen select
“Run-time Autoinitialization” under “Autoinit Model:”. Create a
map file by typing .\Debug\LabD.map inthe Map Filename [-m] field. Do
not enter anything in the ““Code Entry Point (-e):” field (leave it blank). Set
the stack size to 0x400. Next, select the Compiler tab. Note that “Full Symbolic
Debug (-g)” under “Generate Debug Info:” in the Basic Category is
selected. On the Feedback Category pull down the interlisting options and select ““C
and ASM (-ss)”. On the Assembly Category check the Keep generated .asm
Files (-k), Keep Labels as Symbols(-as) and Generate Assembly
Listing Files (-al). The-aswill allow you to see symbols in the memory
window and the —al will generate an assembly listing file (.Ist file). The listing file has
limited uses, but is sometime helpful to view opcode values and instruction sizes. (The
st file can be viewed with the editor). Both of these options will help with debugging.
Then select OK to save the Build Options.

Build and Load
3. Click the ““Rebui Id Al button and watch the tools run in the build window. Be

sure the “Load program after build” option is selected in Code Composer
Studio. The output file should automatically load. The Program Counter should be
pointing to _c_int00 in the Disassembly Window.

Set Up the Profile Session

4.

Restart the DSP (debug - restart) andthen “Go Main’. This will run
through the C initialization routine in Boot . asm and stop at the main routine in
LabD.c.

Set a breakpoint on the NOP in the while(1) loop at the end of main() in LabD.c.

D- 14
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6. Set up the profile session by selecting Profiller - Start New Session.
Enter a session name of your choice (i.e. LabD).

7. In the profiler window, hover the mouse over the icons on the left region of the window
and select the icon for Profille AlIl Functions. Click onthe “+” to expand the
functions. Record the “Code Size” of the function sop C code in the table at the end of
this lab. Note: If you do not see a “+” beside the .out file, press “Profile All Functions”
on the horizontal tool bar. (You can close the build window to make the profiler window
easier to view by right clicking on the build window and selecting “hide”’).

8. Select F5 orthe runicon. Observe the values present in the profiling window. What do
the numbers mean? Click on each tab to determine what each displays.

Benchmarking Code

9. Let’s benchmark (i.e.count the cycles need by) only a portion of the code. This requires
you to set a breakpoint pair on the starting and ending points of the benchmark. Open the
file sop-c.c and set a breakpoint on the “for”” statement and the “return”
statement.

10. In CCS, select profFiler > enable clock (mustbe checked). Then select
profiler > view clock.

11. Now “Restart’ the program and then ““Run’” the program. The program should be
stopped at the first breakpoint in sop. Double click on the clock window to set the clock
to zero. Now you are ready to benchmark the code. “Run” to the second breakpoint.
The number of cycles are displayed in the clock window. Record this value in the table
at the end of the lab under “C Code - Cycles”.

C Optimization

12. To optimize C code to the highest level, we must set up new Build Options for our
Project. Select the Compiler tab. In the Basic Category Panel, under ““Opt Level”
select File (-03). Thenselect OK to save the Build Options.

13. Now “Rebui 1d”’ the program and then ““Run’” the program. The program should be
stopped at the first breakpoint in sop. Double click on the clock window to set the clock
to zero. Now you are ready to benchmark the code. “Run” to the second breakpoint.
The number of cycles are displayed in the clock window. Record this value in the table
at the end of the lab under “Optimized C (-03) - Cycles”.

14. Look in your profile window at the code size of sop. Record this value in the table at the
end of this lab.

Benchmarking Assembly Code

15. Remove sop-c.c from your project and replace it with sop-asm.asm. Rebuild and
set breakpoints at the beginning and end of the assembly code (MOVL & LRETR).

16. Start a new profile session and set it to profile all functions. Run to the first breakpoint
and study the profiler window. Record the code size of the assembly code in the table.
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17. Double Click on the clock to reset it. Run to the last breakpoint. Record the number of

cycles the assembly code ran.

18. How does assembly, C code, and oprimized C code compare on the C28x?

C Code

Optimized C Code (-03)

Assembly Code

Code Size

Cycles

End of Exercise
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OPTIONAL Lab D2: C Callable Assembly

» Objective

The objective of this lab is to practice and verify the mechanics of implementing a C callable
assembly programming. In this lab, a C file will be used to call the sum-of-products (from the
previous Appendix LabC exercise) by the “main” routine. Additionally, we will learn how to use
Code Composer Studio to configure the C build options and add the run-time support library to
the project. As in previous labs, you may perform the lab based on this information alone, or may
refer to the following procedure.

> Procedure

Copy Files, Create Project File

1. Create a new project in C:\C28x\Labs\Appendix\LabD2 called LabD2 .pjt and
add LabD2.c, LabD2.cmd, and sop-c.c to it. Also, add the compiler run-time
support library to the project (C:\ti\c2000\cgtools\lib\rts2800_ml_lib).

2. Do not add LabC.asm to the project (copy of file from Appendix Lab C). Itis only
placed here for easy access. Parts of this file will be used later during this lab exercise.

3. Setup the Build Options. Select the Linker tab and in the middle of the screen select
“Run-time Autoinitialization” under “Autoinit Model:”. Create a
map file by typing .\Debug\LabD2.map inthe Map Filename [-m] field.
Do not enter anything in the ““Code Entry Point (-e):” field (leave it blank).
Set the stack size to 0x400. Next, select the Compiler tab. Note that “Full
Symbolic Debug (-g)” under “Generate Debug Info:’ inthe Basic
Category is selected. On the Feedback Category pull down the interlisting options and
select ““C and ASM (-ss)”. On the Assembly Category check the Keep
generated .asm Files (-k), Keep Labels as Symbols(-as) and
Generate Assembly Listing Files (-al). The -as will allow you to see
symbols in the memory window and the —al will generate an assembly listing file (.Ist
file). The listing file has limited uses, but is sometime helpful to view opcode values and
instruction sizes. (The .Ist file can be viewed with the editor). Both of these options will
help with debugging. Then select OK to save the Build Options.

Build and Load

4 _ Click the ““Rebui ld Al button and watch the tools run in the build window. Be
sure the “Load program after build” option is selected in Code Composer
Studio. The output file should automatically load. The Program Counter should be
pointing to _c_int00 in the Disassembly Window.

5. Under Debug on the menu bar click ““Go Main’. This will run through the C
initialization routine in Boot . asm and stop at the main routine in LabD2 . c.
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Verify C Sum of Products Routine

6. Debug using both source and assembly (by right clicking on the window and select
Mixed Mode orusing View — Mixed Source/ASM).

7. Open a memory window to view result and data.

8. Single-step through the C code to verify that the C sum-of-products routine produces the
results as your assembly version.

Viewing Interlisted Files and Creating Assembly File

9. UsingFile — Open view the LabD2.asm and sop-c.asm generated files. The
compiler adds many items to the generated assembly file, most are not needed in the C-
callable assembly file. Some of the unneeded items are .func / .endfunc. .sym, and .line.

10. Look for the _sop function that is generated by the compiler. This code is the basis for
the C-callable assembly routine that is developed in this lab. Notice the comments
generated by the compiler on which registers are used for passing parameters. Also,
notice the C code is kept as comments in the interlisted file.

11. Create a new file (File — New, or clicking on the left most button on the horizontal
toolbar “New”) and save it as an assembly source file with the name sop-asm.asm.
Next copy ONLY the sum of products function from LabC.asm into this file. Add a
_sop label to the function and make it visible to the linker (. de¥). Also, be sure to add a
.sect directive to place this code in the “code” section. Finally, add the following
instruction to the end:

LRETR ; return statement

12. Next, we need to add code to initialize the sum-of-products parameters properly, based
on the passed parameters. Add the following code to the first few lines after entering the
_sop routine: (Note that the two pointers are passed in AR4 and AR5, but one needs to
be placed in AR7. The loop counter is the third argument, and it is passed in the
accumulator.)

MOVL XAR7,XAR5 ;XAR7 points to coeff [0]
MOV  AR5,AL ;move n from ACC to AR5 (loop counter)
SUBB XAR5,#1 ;subtract 1 to make loop counter = n-1

Before beginning the MAC loop, add statements to set the sign extension mode, set the
SPM to zero, and a ZAPA instruction. Use the same MAC statement as in Lab 4, but use
XAR4 in place of XAR2. Make the repeat statement use the passed value of n-1 (i.e.
AR5).

RPT AR5 ;repeat next instruction AR5 times
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Now we need to return the result. To return a value to the calling routine you will need to
place your 32-bit value in the ACC. What register is the result currently in? Adjust your
code, if necessary.

13. Save the assembly file as sop-asm.asm. (Do not name it LabD2 . asm because the

compiler has already created with that name from the original LabD2 . c code).

Defining the Function Prototype as External

14. Note in LabD2 . c an “extern” modifier is placed in front of the sum-of-products function
prototype:

extern int sop(int*,int*,int); //sop function prototype

Verify Assembly Sum of Products Routine

15. Remove the sop-c. c file from the project and add the new sop-asm.asm assembly
file to the project.

16. Rebuild and verify that the new assembly sum-of-products routine produces the same
results as the C function.

End of Exercise
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Solutions

Solutions

Lab D Solutions

C Code |Optimized|Assembly
C Code Code
(-03)
Code Size 27 12 11
Cycles 118 32 22
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